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FME Desktop Advanced

FME Desktop Advanced Training Manual
This is the manual for the advanced-level training course for Safe Software’s FME Desktop application.

The training builds upon basic training to cover functionality that is important to all FME users wishing to take their skills to the
next level.

Course Structure
The full course is made up of five sections. These sections are:
Advanced Attribute Handling
Advanced Workspace Design
Advanced Reading/Writing
Advanced Parameter Use
Custom Transformers

Current Status
The current status of this manual is: COMPLETE: this manual can be used for training.
It is valid for FME2019.0
The status of each chapter is:
Chapter 0: Complete content and exercises
Chapter 1: Complete content and exercises
Chapter 2: Complete content and exercises
Chapter 3: Complete content and exercises
Chapter 4: Complete content and exercises
Chapter 5: Complete content and exercises
Chapter 6: Complete content
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Slides: Complete
FMEData: Complete
NB: Even for completed content, Safe Software Inc. assumes no responsibility for any errors in this document or their
consequences, and reserves the right to make improvements and changes to this document without notice. See the full licensing
agreement for further details.

6

About This Document

About This Document
This advanced course is for users with prior experience of FME Desktop.

Look out for the FME Lizard, who will appear in the manual from time-to-time, to give you advice and dispense FME-related
wisdom. In fact, here he is right now...

FME Lizard says...
On behalf of the City of Interopolis, welcome to this training course. Here is the standard legal
information about this training document and the datasets used during the course.
I'm no lawyer, but I suggest you be sure to read it, particularly if you're thinking about re-using or
modifying this content.

Licensing and Warranty
Permission is hereby granted to use, modify and distribute the FME Tutorials and related data and documentation (collectively, the
“Tutorials”), subject to the following restrictions:
1. The origin of the Tutorials and any associated FME® software must not be misrepresented.
2. Redistributions in original or modified form must include Safe Software’s copyright notice and any applicable Data
Source(s) notices.
3. You may not suggest that any modified version of the Tutorials is endorsed or approved by Safe Software Inc.
4. Redistributions in original or modified form must include a disclaimer similar to that below which: (a) states that the
Tutorials are provided “as-is”; (b) disclaims any warranties; and (c) waives any liability claims.
Safe Software Inc. makes no warranty either expressed or implied, including, but not limited to, any implied warranties of
merchantability, non-infringement, or fitness for a particular purpose regarding these Tutorials, and makes such Tutorials available
solely on an “as-is” basis. In no event shall Safe Software Inc. be liable to anyone for direct, indirect, special, collateral,
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incidental, or consequential damages in connection with or arising out of the use, modification or distribution of these Tutorials.
This manual describes the functionality and use of the software at the time of publication. The software described herein, and the
descriptions themselves, are subject to change without notice.

Data Sources
City of Vancouver
Unless otherwise stated, the data used here originates from open data made available by the City of Vancouver, British Columbia.
It contains information licensed under the Open Government License - Vancouver.

Others
Forward Sortation Areas: Statistics Canada, 2011 Census Digital Boundary Files, 2013. Reproduced and distributed on an "as is"
basis with the permission of Statistics Canada. © This data includes information copied with permission from Canada Post
Corporation.
Digital Elevation Model: GeoBase®
Fire Hall Data: Some attribute data adapted from content © 2013 by Wikipedia, used under a Creative Commons AttributionShareAlike license
Stanley Park GPS Trail: Used with kind permission of VancouverTrails.com.
OpenStreetMap Datasets: © OpenStreetMap contributors. See www.openstreetmap.org/copyright.

Copyright
© 2005–2019 Safe Software Inc. All rights are reserved.

Revisions
Every effort has been made to ensure the accuracy of this document. Safe Software Inc. regrets any errors and omissions that may
occur and would appreciate being informed of any errors found. Safe Software Inc. will correct any such errors and omissions in a
subsequent version, as feasible. Please contact us at:
Safe Software Inc.
Phone: 604-501-9985
Fax: 604-501-9965
Email: train@safe.com
Web: www.safe.com
Safe Software Inc. assumes no responsibility for any errors in this document or their consequences and reserves the right to make
improvements and changes to this document without notice.

Trademarks
FME® is a registered trademark of Safe Software Inc. All brand or product names are trademarks or registered trademarks of their
respective companies or organizations.
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Document Information
Document Name: FME Desktop Advanced Training Manual 2019.1

What's New?
A list of changes to this manual and its accompanying datasets can be found on GitHub at
https://github.com/safesoftware/FMETraining/blob/Desktop-Advanced-2019/WhatsNew.md. The file includes a list of general
revisions compared to the previous year's materials. It is designed to help trainers become up-to-speed with new content, and for
students to identify which FME functionality is new for the current release.
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Course Overview
This training course builds upon the basic framework of workspace creation in FME Desktop. The course covers topics that are
commonly used by all workspace authors who wish to take their FME skills to the next level.

Course Structure
The full course is made up of five sections. These sections are:
Advanced Attribute Handling
Advanced Workspace Design
Advanced Reading/Writing
Advanced Parameter Use
Custom Transformers

Course Length
The instructor may choose to cover as many of these sections as they feel are required, or possible in the time permitted. They
may also cover the course content in a different order and will skip or add new content to better customize the course to your
needs.
Therefore the length and content of the course may vary, particularly when delivered online.
Safe Software offers training in various lengths, but usually either two days or five days. Both courses cover the same content.
The two-day course runs over fewer, but longer, days and is more intense. The five-day course runs over more, but shorter, days
and allows a little more time to cover the content from a beginner's perspective.

Prerequisites
This training material is intended for persons with some prior experience of using FME. The content assumes a basic familiarity
with the concepts and practices of FME Desktop; at least to the extent covered by the FME Desktop Basic Training.
In particular, it would be helpful to be familiar with:
FME transformers and basic transformation techniques
See the "Data Transformation" chapter of the Basic Training
Basic workspace design including multiple Readers and Writers
See the "Workspace Design" chapter of the Basic Training
Data filtering and attribute management techniques in FME Workbench, and use of FeatureReader/FeatureWriter
transformers
See the "Practical Transformer Use" chapter of the Basic Training
If in doubt, carry out the exercise at the end of this chapter (titled "Basic FME Skills Review"). If you are able to implement the
exercise without too much difficulty, then you are ready for the rest of this course.

About the Manual
The FME Desktop Advanced Training manual not only forms the basis for advanced FME Desktop training – in-person or online
– but is also useful reference material for future work you may undertake with FME. It is updated for each major release of FME.
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All screenshots in these materials were taken using FME on Windows Server 2016. The fonts used (especially in screenshots of
the log window) may be resized or otherwise changed for improved legibility.
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Course Resources
This course uses a number of sample datasets and workspaces.

On Your Training Computer
The data used in this training course is based on open data from the City of Vancouver, Canada.
Most exercises ask you to assume the role of a city planner at the fictional city of Interopolis and to solve a particular problem
using this data.
Whether it's a local computer or a virtual computer hosted in the cloud, you'll find resources for the examples and exercises in the
manual at the following locations:
Location

Resource

C:\FMEData2019\Data

Datasets used by the City of Interopolis

C:\FMEData2019\Resources

Other resources used in the training

C:\FMEData2019\Workspaces

Workspaces used in the student exercises

C:\FMEData2019\Output

The location in which to write exercise output

<documents>\FME\Workspaces

The default location to save FME workspaces

You should also find FME pre-installed, plus a digital copy of this manual.
Please alert your instructor if any item is missing from your setup.
You can find the latest version of FME Desktop and FME Server for Windows, Mac, and Linux - together with the latest Beta
versions - on the Safe Software web site.

Course Etiquette
For online courses, please consider other students and test your virtual machine connection before training starts. The instructor
cannot help debug connection problems during the course!
For live courses, please respect other students’ needs by keeping noise to a minimum when using a mobile phone or checking email.
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Exercise 1

Basic FME Skills Review

Data

Public Art (Microsoft Excel)
Transit Stations (File Geodatabase)

Overall Goal

Review basic FME skills

Demonstrates

Reading and writing data with basic transformer use

Start Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\FMEReview-Ex1-Complete.fmw

You have been hired by a city GIS department. For your first project, you've been asked to create a map that shows the public art
within a 5-minute walking radius (2-3 street blocks) of each transit station.
Project Requirements:
To carry out this project in FME Workbench you'll need to do the following:
Read all the sheets from an Excel spreadsheet (PublicArt.xlsx) turning the data into spatial features
Reproject the arts data to the UTM83-10 coordinate system
Read the Transit Stations table from a File Geodatabase (CommunityMapping.gdb)
Create a buffer around the transit stations set to approximately 3 blocks (250 meters)
Find artwork features within the station buffer
Style the data and write it to Google KML format

TIP
If you struggle with this exercise, it's a good idea to go back and review the FME Desktop Basic Manual
before taking this advanced course.

1) Create a New Workspace
Open FME Workbench and start with a blank workspace. Add a new reader using the following parameters:
Reader Format:

Microsoft Excel

Reader Dataset:

C:\FMEData2019\Data\Culture\PublicArt.xlsx

Coord. System:

LL84

Workflow Options:

Single Merged Feature Type
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Once the Microsoft Excel reader is added, turn on feature caching (or add an Inspector transformer) and run the workspace.
Inspect the results in the Visual Preview window, by clicking on the cache if necessary. Check especially the coordinate system of
the data.
Note: Don't use the Inspect pop-up button on the reader feature type. You will not see any geometry.

NEW
The Visual Preview window is a new tool for FME2019, that incorporates FME Data Inspector
functionality into FME Workbench.

2) Add Geodatabase Data
Next, add another reader, this time the Transit Stations table from a Geodatabase:
Reader Format:

Esri Geodatabase (File Geodb Open API)

Reader Dataset:

C:\FMEData2019\Data\CommunityMapping\CommunityMap.gdb

Parameters > Table List:

TransitStations

Workflow Options:

Individual Feature Types

Once more, inspect this new dataset paying particular attention to the coordinate system.

3) Reproject PublicArt
The coordinate system for the transit data is UTM83-10, the artwork features are LL84; therefore one of these datasets must be
reprojected to match the other, to test spatial relationships.
Since the requirement is to buffer features in meters, we'll use UTM83-10.
Add a Reprojector transformer to the canvas and connect it to the Public Art feature type (<All>). In the parameters set the
Destination Coordinate System to UTM83-10:
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Inspect both datasets together (with the background maps turned off) to prove that they now inhabit the same coordinate space.

4) Buffer the Transit Stations
To create a 5-minute walking radius for each transit station, which is about 2-3 city blocks, we will need to create a buffer. To do
this, we will use the Bufferer transformer.
Add a Bufferer transformer to the canvas and connect it to the TransitStations feature type. In the parameters set the Buffer
Amount to 250:

Re-run the workspace and inspect the output to ensure that the buffers are correct.

2019.1 UPDATE
A common question with the Bufferer is what units the buffer amount uses. In general it's the coordinate
system (ground) units, but in 2019.1 the Bufferer has a new parameter called Buffer Distance Units:

This parameter allows you to set (for example) units in feet, while retaining the data in its original
coordinate system (maybe latitude/longitude where the units are decimal degrees).
As long as you have FME2019.1.0.1 (build 19610 or greater - there was a minor bug in the 2019.1 release
build) for this exercise the parameter can be either Ground Units or Meters (metres), as meters are both
the ground units and the required buffer amount. If you wish, try changing the units to Feet and setting the
buffer size to 820. The results should be virtually identical.

5) Filter Public Art
Now let's find which of the public art pieces fall within the buffered area.
Add a SpatialFilter transformer to the canvas. Connect the Reprojector:Reprojected output port to the SpatialFilter:Candidate
input port, and the Bufferer:Buffered output port to the SpatialFilter:Filter input port:
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Adjust the workspace as necessary to ensure there are no crossed connections.
Set the SpatialFilter Spatial Predicates to Test parameter to apply both Filter Contains Candidate and Filter Touches Candidate.

Rerun the translation if you wish, and inspect the SpatialFilter:Passed output port (alongside the Bufferer output) to make sure the
results are correct. There should be 52 Passed features.

6) Style Output KML
Add a KMLStyler transformer to the SpatialFilter:Passed output port. This will be used to style the artwork to be written to the
KML output.
In the parameters under Icon > Name, click the ellipsis then select an icon such as A1. Then for Label Style set the Scale to 0 and
the Opacity to 0:
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This will allow the icon to show, but hide their labels.

7) Add Google KML Writer
Finally, we can write out to Google KML. Add a Google KML Writer using the following parameters:
Writer Format:

Google KML

Writer Dataset:

C:\FMEData2019\Output\Training\Artworks.kml

Feature Type Definition

Automatic

Change the name of the newly created feature type to ArtNearTransit. Connect it to the KMLStyler:KMLStyled output port.

Reopen the ArtNearTransit feature type parameters and select the User Attributes tab. Change the Attribute Definition to Manual
and remove the attributes OBJECTID, _predicate, and fme_feature_type:

8) Save and Run Translation
You can now save your workspace then run the translation. Open up the Google KML file in Google Earth to inspect the output.
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Note: Even though we reprojected the data to UTM83-10, Google KML format supports only a Latitude and Longitude coordinate
system. Notice that the writer automatically reprojected our data for us.

CONGRATULATIONS
By completing this exercise you have reviewed the following skills:
Add a reader and modify the reader parameters
Add various transformer and adjust their parameters
Use the Visual Preview window to inspect data
Add a writer and modify the writer output schema
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Advanced Attribute Handling
The handling of attributes is one of the most common operations carried out in FME. Users need to set attributes, edit them, and
use them within most workspaces.

FME Lizard says...
Hello, I'm the FME Lizard! I'm an FME expert and will pop in occasionally to
provide some helpful tips for using FME.
In this chapter, I'll guide you through the technical aspects of attribute handling
in FME. By the time we're complete, you'll have the FME equivalent of a
Master's degree in constructing attribute values!
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Constructing Attributes
Besides constant attribute values, FME also allows you to build values using string manipulation and arithmetic calculations. This
is achieved using the menu opened by clicking on the arrow in the Attribute Value field and using one of the editor options:

This capability is very useful because an attribute is no longer a fixed value: it can be constructed from a mix of existing attributes
and parameters. The two methods are the Text Editor and Arithmetic Editor.
Editor functions are mostly based around standard programming language syntax. The text editor is based around the language
Tcl, while the arithmetic editor around C.

FME Lizard says…
Remember that besides existing to construct attributes, the text and arithmetic editors can be applied on
most FME parameters. You wouldn't, for example, have to use the AttributeManager Arithmetic Editor to
create an attribute to then use in the 3DForcer transformer; you could instead use the arithmetic editor
directly in the 3DForcer itself.

FME Lizard asks...
Q) Do you know which transformers can be used to create attributes? Select all that apply:
AttributeCopier
AttributeCreator
AttributeManager
AttributeRenamer
A) The AttributeCreator is obvious and - hopefully - so is the AttributeManager. Other transformers may
have allowed attribute creation at some point, but those capabilities should no longer be needed.
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Text Editor
The text editor - as you would expect - allows you to construct a text value. It includes all the usual string-handling functionality
you would need, such as concatenation, trimming, padding, and case changing.
The text editor looks like this:

Here the user is constructing a simple address string by concatenating various existing attributes. Notice the menu on the left-hand
side. Existing attributes are listed under the FME Feature Attributes section, and were added to the string by double-clicking them.
The @Value() part is simply an FME function that returns the value of the named attribute.
The text editor also allows typing any item of text. Notice that the country name is added as a fixed piece of text, along with space
characters between attributes.
Also, notice the other menu options. The most important (for a text editor) is the String Functions section:
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These are the functions that can be used to manipulate the strings being used. For example, here the user makes sure to trim the
attributes used to construct a new value, using the @Trim() function.
Other functions allow you to calculate results for various date operations; for example, you can determine the interval between
two dates in a number of units, you can add or subtract time from a date, or you can change a date from one structure to another.

Arithmetic Editor
The arithmetic editor is much the same as the text editor, except that whatever the user enters into the dialog will be evaluated as
an arithmetic expression and a numeric result returned:

Here the user is calculating a resident's tax using a simple equation containing property area and a tax code. As with the text
editor, existing attributes and arithmetic functions were obtained from the menu on the left-hand side.

23

FME Functions

FME Feature Functions
One other item in the menu of both text and arithmetic editors is FME Feature Functions:

These are functions that reach into the very heart of FME's core functionality. They are the building blocks that transformers are
built upon; basic functionality that can return values to the editor.
For example, the @Area() function returns the area of the current feature (assuming it is a polygon). @NumCoords() returns the
number of vertices in the current feature.
Some functions return strings, and others return numeric values; therefore the available functions vary depending on whether the
text or arithmetic editor is being used. In the screenshot above, the text editor functions are on the left and the arithmetic editor
functions on the right.
FME Feature Functions are useful because they allow you to build processing directly into attribute creation, instead of using a
separate transformer.

FME Lizard says…
You might also be wondering why there are math functions inside the text editor and how you can use
them.
Well, sometimes you need to calculate a numeric value as part of a string. If so, you can use the FME
function @Evaluate() inside a text editor to carry out a mathematical calculation. This function
understands all numerical operations, which is why they are included in the text editor dialog.

Replacing Other Transformers
Integrated text and arithmetic editors provide the benefit of multiple attribute-creating functions inside a single transformer.
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For example, the AttributeManager Text Editor can be used as a direct replacement for the StringConcatenator and
ExpressionEvaluator transformers.
The AttributeManager could also replace the StringPadder and AttributeTrimmer transformers, albeit with a little less userfriendliness. If FME Feature Functions are used inside the editor, this transformer could also technically replace transformers such
as the AreaCalculator, LengthCalculator, VertexCounter, DateTimeStamper, and many more.
Integrating peripheral operations into a single transformer makes a workspace more compact and well-defined. However, best
practice is critical to this setup. If an AttributeManager (for example) is not annotated correctly, it is incredibly difficult to
determine what actions it is carrying out from the canvas alone!

FME Lizard says…
Note that incorporating functions into a single transformer is not intended as a way to improve
performance.
For example, replacing twenty (20) transformers with twenty functions inside one AttributeManager
transformer - all carrying out the same task - is unlikely to make the workspace faster overall; plus the
AttributeManager will naturally become slower with each new function that is added to it.
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Exercise 1

Taxation Report Project

Data

Building Footprints (AutoCAD DWG)
Zoning Data (MapInfo TAB)
Tax Report (HTML)

Overall Goal

Create a taxation report for buildings in the city

Demonstrates

Constructing attribute values

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex1-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex1-Complete.fmw

The annual property tax reports are due to be calculated, and it is decided to use FME to carry out the processing. A partial
workspace already exists; you must finish it by calculating tax values for each building (based on size and zoning) and creating a
report of the results.

1) Open Workspace
Open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex1-Begin.fmw. The first section of the
workspace looks like this:

In particular, notice that the AttributeValueMapper is creating a TaxMultiplier value, based on zoning type.
Ensure feature caching is turned on and then run the workspace. Inspect each cache in turn to view the source data and the results
of each transformer:

Also inspect the transformer caches to ensure they are carrying out the action you expect.

FME Lizard says…
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The simplest way to inspect each cache is to use the Visual Preview window. Simply open the preview
window (if it is not already open) and click on each workspace object in turn. The preview window will
update with the results of each object.
To stop this automatic updating of the preview window, you can click the button in the top-left of the
Preview Window. Its tooltip is "Toggle Automatic Inspect on Selection". Once deactivated, you must click
the green cache icon on each object to view its cache.

2) Add AttributeManager
To carry out our tax calculations, we'll use an AttributeManager transformer. So place an AttributeManager and connect it to the
SpatialFilter:Passed output port.
The first task is to create a numeric value for the taxation rate. Create a new attribute called TaxRate. Set it to a fixed value of 0.2
Add a second new attribute, this one called TaxAmount. Instead of setting a fixed value, click the drop-down arrow to the right
and choose the option for Open Arithmetic Editor:

3) Calculate Tax Amount
The calculation for the tax amount is:
Building Footprint x Tax Multiplier x Tax Rate = Tax Amount

...where Building Footprint is the area of the building in square meters, Tax Multiplier is the value relating to the Zone Type, and
Tax Rate is the fixed value we entered previously.
The result should also be rounded off to two decimal places.
So, start out by locating Area under FME Feature Functions and double-clicking it to add the area of the building footprint to the
equation:
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Add a multiplication symbol. It can be found under Math Operators, but it's easier to just type it. Next, locate the TaxMultiplier
attribute and double-click it to add it to the equation:

Add another multiplication symbol. Now locate the TaxRate attribute and double-click it to add it to the equation:

Finally, we need to round the result to two decimal places. Add the round() function to the equation. Like the multiplication sign,
it can be found under the Math Functions section, but is often easier to type manually.
The function should be @round(<Existing Equation>,2), like this:
@round(@Area()*@Value(TaxMultiplier)*@Value(TaxRate),2)

Click OK to close this dialog. Run this transformer if you wish, to ensure the results look correct.

4) Generate Report
The final task is to create a report. The latter section of workspace already contains a partially edited HTMLReportGenerator
transformer and HTML writer, so our task is simply to write a footer for the report.
Connect the AttributeManager to the HTMLReportGenerator's input port. Open the parameters dialog for the
HTMLReportGenerator. Under Page Contents, create a new entry for Custom HTML below the Table entry:
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Click on the right-hand side of the dialog in the Content Settings. Click on the drop-down arrown for the Custom HTML setting
and select Open Text Editor:

Using a combination of manual text entry, FME Feature Functions, and FME Parameters, enter the following text:
<br>Property Taxation Report
<br>Generated: @DateTimeNow()
<br>By: FME Lizard
<br>Using: $(FME_PRODUCT_NAME) build $(FME_BUILD_NUM) on $(FME_OS)

Note: <br> is a HTML tag that represents the HTML equivalent of a newline character.

5) Run Workspace
Run the workspace. Open the HTML file that is created in a web browser. The report should look like this:
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CONGRATULATIONS
By completing this exercise you have learned how to:
Construct numeric values with the arithmetic editor
Construct strings with the text editor
Generate an HTML report and write it to an output file
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Conditional Attribute Values
Conditional Attribute Values are a tool that can be used to replace many existing transformers of the same type.

Transformer-Based Attribute Mapping
Features can be divided within a workspace using transformers in a process called Conditional Filtering, and attributes can be set
or created based on these divisions. Here an author divides data into neighborhoods using a postcode attribute:

However, a large number of AttributeManager transformers like this is not a good idea. It causes the workspace to be bloated;
hard to navigate and harder to edit. It does not scale particularly well either; since each value needs a separate TestFilter port and
AttributeManager combination, it's easy to imagine the difficulties involved with - say - more than 50 values!
One solution is to use a simple AttributeValueMapper transformer. However, that transformer only permits a single, simple
condition, such as X=Y. If a more advanced set of conditions is required, then the preferred solution is Conditional Attribute
Values.

What are Conditional Attribute Values?
Conditional attribute values are when, instead of creating a set of conditions and values as separate objects in a workspace, the
author sets both condition and value inside a single transformer.
The option for conditional attributes is found in the drop-down dialog on most transformer parameters. In the AttributeManager, it
appears like so:
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In the above screenshot, a workspace author is creating a new attribute called NEIGHBORHOOD. The values for
NEIGHBORHOOD are conditional upon other attribute values and - in this example - are set up like this:

FME Lizard says…
To save time and prevent data entry error, you can copy and paste conditions between transformers of a
similar style. For example, the Tester transformer and a Test Condition in the TestFilter transformer.

Like the AttributeValueMapper, a series of conditions (left) map to different values (right). However, in contrast to the
AttributeValueMapper, this dialog allows much more complex conditions than a simple 1:1 mapping. That’s because full test
capabilities are built into this dialog.
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The conditions are defined by double-clicking in the Test Condition field to open up a Tester-style dialog. Both the condition and
the output value can be set within this dialog:

When the conditions are set than the original dialog – in this case, an AttributeManager – looks like this, with the number of
conditions defining the number of possible values:

.1 UPDATE
The Conditional Parameter definitions are constructed in the same dialog that the Tester transformer
uses; therefore - like the Tester - in FME2019 various changes were made. For more information see this
FME blog post.
Additionally, in 2019.1 the logic of conditional parameters can be reviewed or edited using a Composite
Expression field:
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FME Lizard says…
Just like attribute construction, conditional values apply not only to attributes but to most FME
parameters; for example, I can create labels conditional upon certain tests using the Labeller transformer
itself:

So I don't have to create the labels in an AttributeManager and then apply them in the Labeller as a
separate task.

When to use Conditional Attribute Values?
Conditional attribute values are great for when you need to map (or set) an attribute in relation to the value of an existing attribute,
and when the conditions are more complex than can be handled in a simple AttributeValueMapper (or AttributeRangeMapper)
transformer.
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In essence, conditional values are like a combination of TestFilter and AttributeCreators in the range of functionality that they
include.

FME Lizard says…
Additionally, if you’re using the ?: operator in an arithmetic editor, then you can stop being such a showoff and use conditional values instead!

FME Lizard asks...
Q) The output attribute "value" in a conditional setup can be which of these (select all that apply):
A simple value like a string or number
A value constructed from a text or arithmetic editor
No Action (i.e. the value will remain what it was)
A command to FME to cancel the translation
A) Yes, all of these are valid. You can type in a simple value or construct one with an editor, or even set the
value to a user parameter. But the Output Value field also does not need to be a "value" at all! It can be
any action on the usual dropdown menu, including Null, No Action, or Stop Translation.
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Exercise 2

Flood Risk Project

Data

Parks (MapInfo TAB)

Overall Goal

Assess flood risk for addresses based on elevation and distance from shore

Demonstrates

Conditional attribute values

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex2-Complete.fmw

A colleague is working on a workspace to calculate the tsunami flood risk for all addresses in the city. The risk is adjudged to be a
combination of closeness to the shoreline and elevation above sea level. It is on a scale from one to five (1-5) and is calculated
using this table:
Elevation (meters above sea level)

Distance from Shoreline (meters)

0-10m

10-25m

25-60m

100m

1

2

3

200m

2

3

4

300m

3

4

5

Your colleague has created the workspace up until the point at which each address has an elevation and distance from the
shoreline. Now the calculations need to start, and he has asked for your assistance in finishing the project.

1) Start Workbench
Open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw. This is the workspace as your
colleague has created it so far.
Turn on feature caching and run the workspace. Inspect the results at various parts to find what sort of data we are dealing with.
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This colored screenshot shows how the addresses fall within (and are assigned) a zone denoting their distance from the shoreline.
They also possess an elevation value. We must now use this information to assign a flood risk to each address.

FME Lizard says...
As with most FME projects, there are multiple ways to carry out this task. The two basic techniques are
conditional filtering and data mapping.
Conditional filtering means we would separate the data according to the elevation and shoreline zone.
Data mapping means we set an attribute value (flood risk) according to the value of other attributes.
Here is an example of how we might mix filtering data by coastal zone with mapping data by elevation:

However, we can avoid filtering data by using Conditional Values. The filter conditions are incorporated
as the conditions for our Conditional Values.

2) Place AttributeManager
Place an AttributeManager transformer and connect it to the AttributeRenamer.
Inspect the AttributeManager parameters. Ignoring all of the existing attributes, scroll to the bottom of the dialog and in the <Add
New Attribute> field enter FloodRisk.
In the Attribute Value field click the drop-down arrow and choose Conditional Value:
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This opens a new dialog very similar to a Tester/TestFilter transformer. There are fields for Test Condition and Output Value.
Double-click the first Test Condition field and a Tester-like dialog will open:

Let's set this up to map the conditions for where FloodRisk=1 (the highest). According to the table of calculations, this can occur
only when Zone=100 and Elevation<=10. So, set up the conditions to test for Zone = 100 AND Elevation <= 10. Notice that the
logic (AND) is set in the left-hand side Logic column.
Enter 1 into the Attribute Value parameter at the foot of the dialog:
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Now click OK to close this part of the dialog.
The main Conditional Definition dialog now looks like this:

3) Set Second AttributeManager Condition
Now double-click the next Test Condition (Else If) to set up the condition for FloodRisk=2
According to the table, there are two conditions for FloodRisk=2. They are when:
Zone = 200 AND Elevation <= 10
Zone = 100 AND Elevation <= 25
So, enter four clauses (one each for Zone=100, Zone=200, Elevation<=10, Elevation<=25) in the correct order, with the logic
columns to match. Enter 2 into the Attribute Value parameter:
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The order of the clauses is important, compared to the logic. The location of the brackets in the logic column is also important to
get right.
Click OK to close this dialog. The main Conditional Definition dialog now looks like this:

4) Set Remaining TestFilter Conditions
Now repeat the above steps for each of the other flood risk values. There will be five conditions in all (one for each flood risk).
It may seem complicated, but it should be easy to get into a routine. Additionally, make use of the Copy and Paste buttons or
keyboard shortcuts in these dialogs to speed up the process.
The final dialog will look like this:
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It is essential to keep these in the correct order; otherwise, a feature may pass the tests in the wrong order and receive a lesser risk
than expected.
Accept the changes and the main AttributeManager dialog now looks like this:

5) Add Inspector
Inspecting cached data doesn't allow you to separate that data out for easier inspection, unless you use an Inspector transformer.
So place a single Inspector transformer and connect the AttributeManager output to it.
Open the Inspector parameters dialog and under Group-By select the newly created attribute called FloodRisk.
Save and run the workspace. You should see each address colored to match its flood risk. You can adjust the feature symbology to
produce a clearer result, like so:
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You can also turn off each zone, in turn, to see which addresses are most/least at risk.

CONGRATULATIONS
By completing this exercise you have learned how to:
Use Conditional Attributes to map data according to a set of complex conditions

TIP
Best Practice should always play a part in any workspace. In this case there are fewer transformers, but
does this make the workspace better? Is it a more aesthetic (good-looking) workspace? The decision on
which method to use may depend on who will maintain the workspace.
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Adjacent Feature Attributes
Normally a feature in FME is self-contained. It might get processed as a group at some point, but other than that it doesn’t have
any relationship to other features in the workspace.
However, in some cases, the ability for a feature to access the attributes of other features is quite useful.
For example, take a tabular dataset of coordinates recorded as follows:
X

Y

+0.0

+3.0

+3.2

+0.0

-3.2

+0.0

+0.0

+3.4

+4.2

+0.0

In this case each row is not an absolute coordinate; instead, it is an offset from the previous one. Therefore, to calculate the true
coordinates, each feature needs to know the coordinates of the previous feature, so that it can apply the offset.
This sort of scenario is catered for by Adjacent Feature Attributes in FME.

Adjacent Feature Functionality
Adjacent Feature functionality is activated by checking the box labeled Enable Adjacent Feature Attributes in an AttributeCreator
or AttributeManager transformer:

This opens up a section of dialog in which the author can specify how many features preceding the current feature, or how many
features that succeed it, should be made available. In the above screenshot attributes from the previous feature will become
available.

Using Multiple Feature Attributes
The simplest way to make use of the attributes retrieved from prior/subsequent features is through the text or arithmetic editors,
where the list of feature attributes has an expandable section for prior and subsequent features:
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Attributes become available not only for the current feature but also for previous/subsequent features that have been exposed. As
with the current attribute, double-clicking an adjacent attribute adds it to the expression window:

In the above screenshot, the workspace author is finding the time difference between two adjacent records in a business license
dataset.
You can see that prior attribute values can be accessed simply by using feature[-x]. where x is a positive or negative number that
refers to a subsequent or prior feature.

FME Lizard says…
Be aware that extra system resources are used for storage of adjacent features. Therefore translation
performance will take a (fairly minor) hit when using these capabilities, the degree of which depends on
the number of features and the number of attributes being retained.
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Missing Values
The AttributeCreator and AttributeManager also have an option to specify what should happen if the attributes being used in a
string are missing:

When the transformer tries to use a value that is missing (or null or empty) this option lets the user choose a replacement value, or
to carry out no substitution.
Notice that this setting applies to attributes of the current feature, just as much as attributes of adjacent features.

FME Lizard asks...
Q) My AttributeManager sets up NewAttribute = OldAttribute + feature[+1].OldAttribute
There are 100 features in my dataset. Given that feature[101].OldAttribute doesn't exist, what will the
value of NewAttribute be for the 100th feature?
No value at all (empty attribute)
The same as feature[100].OldAttribute
It depends on the Substitute Value parameter
Nothing. FME will crash and explode your computer
A) You as the author get the choice of what happens when a value is missing, using the Substitute Value
parameter, and that includes values that are missing because they are out of range. If you don't set a
substitute value, then the result will be that NewAttribute is <missing> for feature 100.
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Exercise 3

Precipitation Calculations

Data

Precipitation Data (Microsoft Excel)

Overall Goal

Calculate monthly precipitation

Demonstrates

Adjacent feature attributes

Start Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex3-Complete.fmw

You're working on a project mapping monthly precipitation (rainfall) in the city. You have been given a dataset like so:
Month

Precipitation

Jan

168

Feb

273

Mar

387

Apr

476

May

541

Jun

595

Jul

631

Aug

668

Sep

719

Oct

840

Nov

1029

Dec

1191

Unfortunately, the numbers are a cumulative amount, and you wanted to map individual figures for each month.
Rather than reaching into your desk drawer for a calculator, you decide to use FME to do the calculations!

1) Create Workspace
Create a workspace to translate the data as follows:
Reader Format

Microsoft Excel

Reader Dataset

C:\FMEData2019\Data\ElevationModel\Precipitation.xlsx

Writer Format

Microsoft Excel

Writer Dataset

C:\FMEData2019\Output\Training\MonthlyPrecipitation.xlsx

When creating the workspace, check the parameters for the reader to ensure FME recognizes the headers at the top of each
column.

2) Add AttributeManager
To calculate precipitation for any given month, you need to subtract the previous month's cumulative total from the current
month's cumulative total.
With FME you can use the Adjacent Feature Attribute functionality to fetch the previous month's number.
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So, place an AttributeManager transformer between the reader and writer feature types:

3) Set AttributeManager Parameters 1
Inspect the AttributeManager's parameters, either in the parameters dialog or the Parameter Editor window.
Expand the set of advanced attributes and check the box marked Enable Adjacent Feature Attributes. In the fields provided enter 1
for the Number of Prior Features to keep.
Next set the parameter Substitute Missing, Null and Empty by: to Default Value and enter 0 into the Default Value field:

FME Lizard says…
The substitution parameter is important because the first feature to be processed can’t have a prior
feature, and the last feature to be processed can't have a subsequent one. Therefore you always have to be
careful about what you have set here.
In this exercise we’re calculating a numeric value; therefore it makes sense to use 0 (zero) as the default
replacement.

4) Set AttributeManager Parameters 2
Now let's calculate the new precipitation value.
In the Attribute Value field for the precipitation attribute, click the drop-down arrow and open the Arithmetic Editor.
In the arithmetic editor dialog use the menu on the left to select:
The FME Feature Attribute Precipitation
The Math Operator – (minus)
The FME Feature Attribute Precipitation for feature[-1]
All of which should leave you with an expression looking like this:
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@Value(Precipitation)-@Value(feature[-1].Precipitation)

Now you can see why it was so important to set the substitution field because it’s uncertain what result would occur from the
above when feature[-1].Precipitation is missing!
Click OK to close the Arithmetic Editor dialog, and then accept the parameter changes.

5) Save and Run Workspace
Save the workspace and then run it. Inspect the output.
The numbers start out looking correct but quickly become wrong. Not even in Vancouver (I mean, Interopolis) does it rain 623mm
in a single month!
The problem is this: unlike other occasions in FME, here we can’t simply overwrite the attribute we are working with. That’s
because it skews the next calculation. i.e. the calculation for March needs to operate on February's original number, but instead, it
receives the value we've just overwritten it with!
The only way to solve this is by creating a new attribute...

6) Adjust Workspace
Edit the writer schema by renaming the destination attribute Precipitation to MonthlyPrecipitation:

Now return to the AttributeManager and change it to create an entirely new attribute called MonthlyPrecipitation. You can copy
and paste the line to save time; just change the Output Attribute name:
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It's a pain to have to do, but blame me for leading you in the wrong direction at first! You can't even just rename Precipitation to
MonthlyPrecipitation since, whatever you call it, it still fetches an incorrect value. You'll have to reset its Action field to "Do
Nothing" and then create a new attribute.

7) Re-Run Workspace.
Save the workspace.
Before you re-run the workspace, check the writer parameter called "Overwrite Existing File" in the Navigator window.
Set it to Yes – if it isn’t already – so the output overwrites the destination dataset and doesn’t just append this data to the same
spreadsheet.
Also, make sure the file you are writing to is not already open in Excel (or any other editor).
Re-run the workspace.
Inspect the output. This time the numbers should be correct:

FME Lizard says…
If the values in the output are literally "273-168", "387-273", etc., then you've used the string editor and
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not the arithmetic editor! If the values are all zero, then you need to make sure the AttributeManager
action is set to Do Nothing for the Precipitation field, rather than Set Value.

CONGRATULATIONS
By completing this exercise you have learned how to:
Expose adjacent feature attributes
Use adjacent feature attributes
Handle missing values in attribute manipulation
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Null Attributes
Null attributes are a very important part of FME’s attribute handling. Not every dataset has null values, and not every format
supports them; but when they do exist it is important for FME to handle them correctly.

What is a Null Value?
In general, a null attribute value is the equivalent of nothing. However, it’s important to be precise in our terminology because
there are many ways to represent nothing, for example:
An attribute has a particular state that indicates nothingness (null)
An attribute has a particular value that indicates nothingness (for example, -999)
An attribute exists but has no value (empty)
An attribute doesn’t exist (missing)
A numeric attribute is NaN (Not a Number)
A numeric attribute has a value of zero
A raster cell is set to nodata (which is essentially the raster equivalent of null)
In fact, Safe Software’s developers identified fifteen (15) different ways for “nothing” to be represented in spatial and tabular
data!
So when we talk about null, it has a particular meaning. For us, null is a specific state that is deliberately set to signify that the
information does not exist. It tells us that the lack of information is not a mistake, as a missing or empty value might be.
Because there are so many different methods, this section will discuss ways to handle "nothing" attribute values, but with a
particular emphasis on Null values.

FME Lizard says…
FME's three main methods are null, empty, and missing. To clarify with an analogy, let's consider the
kitchen of your house.
Suppose there is no sink, there is no place to put a sink, and there is no plumbing for the sink. The builder
foolishly decided there would be no sink, so the sink is missing.
If there was a place for the sink, and plumbing for the sink, but the sink was not there, then it would be
null. The builder set aside space for the sink, but hasn't added it yet.
If there is a sink, but there is no water in it, then the sink exists, but it is empty.
You can find a more amusing version of this analogy by looking up Null Toilet Roll!

How does FME Represent Nothing?
FME’s internal engine has its own state to represent null. However, when presented to the user, a null value is usually represented
as <null>.
For example, this feature in the Logger has <null> for the ParkName attribute:
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Similarly, the FME Data Inspector will depict nulls as <null>:

Notice how we have a wide range of "nothing" values here. The ParkName is a true <null>, the RefParkId has a value of -9999,
and Washrooms is <missing> (meaning the attribute doesn't exist).

FME Lizard says…
<missing> is an interesting concept. You might be asking, "how do we know when an attribute is
missing"? But a better question is "how do we know that the attribute should exist"?
Using our previous analogy, we know the kitchen sink is missing because the house blueprints specified a
sink. The sink should be there, but it isn't.
In FME we know an attribute should exist because it appears in the reader schema. For example, in the
above screenshot, Washrooms appears in the schema, but for some reason certain features do not have
that attribute. That makes the attribute <missing> from those features.

52

Handling Null Attributes

Handling Nothing
Besides representing all forms of nothing in its interface, FME also allows nothing to be a condition in various tests, lets users set
nothing values, and allows bulk updates from one form of nothing to another.

Recognizing Null Values
Various formats have various ways to represent nothing. However, if they support the concept of null, then FME will read any null
attributes with a <null> value.
For a workspace to check for incoming nulls, the Tester transformer has specific operators to test for null, empty, and missing
values:

Because the Tester interface is incorporated into many facets of FME (such as the TestFilter transformer or Conditional
attributes/parameters), you can test for nulls wherever you find that interface.

FME Lizard says…
The "Attribute Has a Value" test returns true when an attribute is not null, AND is not empty, AND is not
missing - saving you the inconvenience of having to use those three tests separately.

Other Null-Handling Transformers
Many other transformers also allow testing for nulls. For example, the Matcher transformer has options as to whether null values
constitute a match:
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This parameter lets the workspace author decide whether null, empty, and missing values should be treated as different values.
If set to No, then two features can match even if one has an attribute that is <null> and the other has an attribute that is <missing>.
If set to Yes, then two features can only match when their attributes are the same type of nothing; i.e., when <null> one on feature
is matched by <null> on the other.
Another example is the AttributeFilter transformer, which has separate output ports for <Empty>, <Missing>, and <Null>:

Writing Null Values
It's often important to be able to test for and filter null values as part of a data validation process, or when a null value would cause
problems in a calculation.
However, it's also important to be able to filter out null values for writing data. That's because what happens when an attribute set
to null is sent to a writer depends very much upon the data format.
If the format supports <null> then the destination dataset will contain <null> attributes.
If the format doesn’t support <null>, then FME will automatically convert the data to the closest representation that is supported.
For example, MapInfo TAB does not have a concept of <null>; instead text attributes are not written (so FME will read them back
as <missing>) and numeric attributes are written as -9999 (which is a MapInfo equivalent to null).

FME Lizard says…
Be aware that FME only converts "null" values when the format does not support the current
representation. For example, if a feature has an empty attribute value, and the format allows empty
values, then FME will not convert the data to a true <null>.
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Joining with Null Attribute Keys and Values
There are various transformers in FME that join data together in some way; the FeatureMerger, FeatureJoiner, and DatabaseJoiner
are all examples of these.
When joining data, one consideration must be handling null values, particularly null key values in an attribute join.
When FME compares keys, and one key is null, it must consider what action is correct. Should that feature be rejected, or should
that feature be joined to other features that also have a null key?
Similarly, when FME merges attributes and there is a clash, most transformers have a parameter to specify which takes
precedence. But should that action be the same when the attribute with priority has a null value? Should a null overwrite an actual
value?
These are all aspects of data joins to consider. Some transformers - for example, the FeatureMerger - have a specific parameter to
handle nulls. In general, you should always inspect the documentation for each transformer if you suspect that your data contains
null values that need handling.
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Setting Null Values
The usual way to set an attribute value is with the AttributeCreator or AttributeManager, and these have an option in their dropdown menu to set a value to null:

Conditional Attributes functionality also supports setting <null> values:

Bulk Null Updates
The way to handle bulk updates of attributes is with the NullAttributeMapper transformer.
The NullAttributeMapper transformer allows the author to check values for any or all attributes on a feature, and convert them in
bulk to or from null.
For example, here the author is checking for attributes that are either missing or empty and converting them to nulls:
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One reason for this might be that the workspace converts data from a format that does not support nulls, to one that does. It's
necessary to explicitly map the values here because empty/missing values may be permitted in the output and FME will not
automatically map data from empty to null, just because a format supports it.
In this second example, the author is checking attributes for existing null values. If the value is set to null then it gets replaced
with a zero:

Presumably, this must be a numeric field. If it was a text field perhaps the author would set it to an empty string instead. Unlike
before, the author wouldn't need to do this when converting from a format that supports null to a format that doesn't, because FME
will map the values automatically when the current state isn't supported.
A better reason for this mapping is that the author wants to carry out a numeric, calculation where zero is a valid number but
<null> isn't.

FME Lizard asks...
Q) My reader format supports nulls and includes known null values in the data. My writer format is a
simple text format that does not support nulls. What must I do to get my workspace to work correctly?
Delete the attributes with the AttributeRemover
Set the advanced reader parameter "Read Nulls as Empty" to Yes
Use the NullAttributeMapper to convert all <null> values to <empty>
Nothing, the writer will convert the values as necessary
A) You don't need to do anything. If a format doesn't support nulls then the writer will write the data in a
format as close to null as possible for that format. Sometimes it will be an empty value, other formats have
a specific value for null (like -9999).
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Exercise 4

Parks Dataset Sorting

Data

Parks (MapInfo TAB)

Overall Goal

Sort parks into alphabetical order

Demonstrates

Null attribute handling

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex4-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex4-Complete.fmw

In this workspace, a colleague is trying to write out a list of parks to a Geodatabase dataset. It’s important that the parks are in
alphabetical order – according to their name – and that features with no park names are written as null and appear last in the
dataset.
However, the workspace they have does not seem to be doing what they need. The parks are sorted alphabetically, but un-named
parks always appear first.

1) Start Workbench
Open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\Attributes-Ex4-Begin.fmw
Using feature caching, run the workspace and inspect the source dataset as a table. You’ll see that the data is in order of ID, not
name, and that there are <missing> values scattered throughout:

To sort the <missing> data we'll need to set their ParkName attribute to something that appears at the bottom of a sorted list, then
set them back to null afterward.

2) Add NullAttributeMapper
Add a NullAttributeMapper transformer prior to the Sorter transformer. Inspect the parameters.
Ensure “Map” is set to Selected Attributes, and choose the attribute ParkName:

Underneath that is a section of what to map to.
We know the values in here are currently listed as <missing> so set the “If Attribute Value Is” parameter to Missing (Selected
Attributes Only)
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We want to map these to a value that appears at the bottom of an alphabetically sorted list, so change “Map To” to New Value and
enter ZZZ as the new value.

Accept the parameter changes.

3) Add NullAttributeMapper
Now add a second NullAttributeMapper; this time it should be connected after the Sorter.
Open the parameters and, once again, ensure “Map” is set to Selected Attributes and select the ParkName attribute. This time turn
the ZZZ values back to nulls:

Technically we could just turn them back into <missing>; the Geodatabase writer will write them out as nulls. However, assuming
we didn’t know that, null is the safer option and bound to give us what we want.

4) Save and Run Workspace
Save the workspace and then run it. Inspect the output. This time the data should be sorted by ParkName, but with all null values
at the end of the dataset:
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5) Fix RefParkId
Your colleague now asks you to fix the RefParkId field. You'll have noticed that a lot of the values are -9999. That's the MapInfo
equivalent of "nothing", but for Geodatabase it would be better to set these to proper nulls.

FME Lizard says...
That's very simple to do. Take a moment to think about how before you look at the instructions!

To do this open the parameters dialog for the first NullAttributeMapper. Add RefParkId to the list of attributes for processing.
Then add -9999 to the Or If Attribute Value Is field:

Now open the second NullAttributeMapper and add RefParkId to the list of attributes for processing.
Now, these values will get mapped to ZZZ with the missing ParkName values. Then they will be turned into true nulls by the
second NullAttributeMapper.
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Advanced Exercise
If you still have time, you should filter out the null ParkNames and RefParkIDs and write them to a
separate Feature Type (table) in the Geodatabase.

CONGRATULATIONS
By completing this exercise you have learned how to:
Identify null and missing attribute values
Set null and missing attribute values
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Module Review
This chapter looked at advanced techniques for handling attributes in FME.
What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
Attributes can be constructed either with a series of transformers or inside a single transformer using Text and Arithmetic
editors.
Constructing an attribute as a series of transformers is more self-documenting, but a single transformer is more elegant and
reduces canvas clutter.
Conditional Values are when an author constructs an attribute according to a number of test conditions.
Multiple Feature Attributes is a technique where any feature can access the attributes of previous or subsequent features.
Null attributes are those whose state indicates lack of a value.
FME Skills
The ability to construct attributes with either the Text or Arithmetic editors.
The ability to apply conditional attribute values, and the knowledge to know when this is a good approach.
The ability to use Multiple Feature Attributes.
The ability to use test for null values, and change values to or from null.

Further Reading
For further reading take a look at articles about Null on our blog, or this article on Adjacent Feature Attributes.
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Advanced Workspace Design
Workspace design is a key factor in optimizing performance. We already know that a badly designed workspace has consequences
for Best Practice, making it harder to maintain and scale. However, such a workspace also performs worse too. This becomes
increasingly true as an author tackles more complex projects and constructs larger and more intricate workspaces. Even a subsecond delay per feature can be significant, when millions of records are being processing.
So this chapter covers how to design a workspace to optimize performance. These techniques can be used for new workspaces, or
to update existing workspaces.

What do we mean by Performance?
According to Wikipedia, performance is a measure of the amount of useful work accomplished relative to the time and resources
used.
In FME terms, good performance is the ability to process spatial and tabular data with the correct results (useful) as fast as
possible (time) and using as little memory and disk space (resources) as possible.

What Can Impair Performance?
There are various factors – you might call them bottlenecks – that can cause FME to run slower than you might hope. Most of the
content of this chapter covers how to overcome or relieve these factors.

Excessive Disk Operations
Physical disk drive throughput is relatively slow compared to other computing processes; therefore the more FME has to read and
write to a physical disk drive, the more performance is impaired. The best performance comes from storing temporary data in
memory, rather than on disk.

Underuse of Resources
Performance can be impaired when an FME translation is not using all of the available system resources. For example, there are
few licensing limits to prevent FME from using all of the CPU cores on a system, and more memory resources are available to 64bit FME than 32-bit.

Excessive Data Amounts
If performance is described as the amount of “useful” work, then nothing is going to impair performance more than unnecessary
processing. The more excess information that gets read, and the further it is carried into the workspace, the less useful the work is,
and the more performance suffers.

FME Lizard says…
Hi, in this chapter I'll help power up your workspaces, and improve their performance through advanced
design and optimization techniques. The first thing we'll do is deconstruct a log file, so that we understand
what it means.
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Log File Interpretation
The FME log file is your best friend for assessing performance. It tells you how long a translation took, where the time went, and
how well FME was able to use the available system resources.

Log Messages
The first thing to notice is that each line of the log is (in most cases) a separate message, for example:
Creating writer for format: Esri Shapefile

However, sometimes the message spans several lines, such as:
-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~
-~

~Feature caches have been recorded at every stage of the translation.

~-

-~

To inspect the recorded features,

~-

-~

click the feature cache icons next to the ports.

~-

-~

~-

-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-~-

Optional Log Message Fields
There are a number of options to adjust the log file and what is displayed. To access these select Tools > FME Options >
Translation:

The most important setting is Log Timestamp Information. This option turns on a number of optional fields in the log messages.
These are:
Absolute Date: The date on which this step took place
Absolute Time: The time at which this step took place
Cumulative Time: The amount of time taken to this step in the current translation
Elapsed Time: The amount of time taken for this step in the current translation
Message Type: The nature of the message
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For example:
2019-04-01 12:13:55|

0.8|

0.0|INFORM|Closing native MapInfo reader

The Message Type field is usually one of the following:
ERROR: An error in the translation that usually requires FME to stop or cancel processing.
WARN: A warning that signifies a problem that is not sufficient to stop or cancel processing.
INFORM: An information message relating a non-error item.
STAT: A message on translation statistics such as the number of features processed.

FME Lizard says…
The log file always contains timestamps, regardless of this setting.

Filtering Log Messages
A common requirement is to filter log messages, so that only messages of a certain type are displayed. For example, it can be
useful to turn off INFORM and STAT messages in order to make it easier to spot ERRORs and WARNs.
There are two ways to achieve this. Firstly log messages can be filtered using options under Tools > FME Options > Translation:

These options turn each type of message on (or off) for all subsequent translation logs. If a message type is unchecked here it will
not appear in a log at all.
The second method of filtering is a set of tools in the log window itself:

These tools are a way to toggle messages on and off in the log window only. They are easier to use and more flexible than using
the FME Options for filtering.

WARNING
The Log Debug option (under FME Options) allows you to turn on debug messages in the log. These are
extra log messages that are usually hidden from the user.
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Debug messages can help during debugging, but are less useful in general FME use. Many messages
(labelled "BADNEWS") are alarming “errors” that FME has trapped and kept to itself (like an end-of-file
message). For this reason it's not recommended that this option is turned on permanently.
Also, note that the Log Debug setting persists in the workspace. If you turn that setting on and pass the
workspace to another user, it retains the setting and shows debug messages when that other user runs the
workspace!

FME Lizard says…
If the log window text is a little small for you, or not stylish enough, use Tools > FME Options >
Appearance > Log Font to change the font size and style.
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Deconstructing the Log File
The following sections examine in more detail each part of an FME log file.

FME Lizard says...
The overall structure of an FME log is approximately four different sections.
Command-line statement
Configuration and setup information
The translation and transformation itself
A summary of the translation

Command Line Statement
At the very top of a log file appears the command line statement. This is the command that FME Workbench is using to run the
translation:
Command-line to run this workspace:
"C:\Program Files\FME2019\fme.exe"
C:\FMEData2019\Workspaces\InstructorUse\DesktopAdv\4.01-FMEParameters.fmw
--SourceDataset_MITAB "C:\FMEData2019\Data\Parks\Parks.tab"
--DestDataset_ESRISHAPE "C:\FMEData2019\Output"

In terms of performance, this section doesn’t tell us much. However, it is useful to confirm which FME instance is running,
particularly when you have several versions installed. Note that the version number in the above log is the folder where FME is
installed; it's not necessarily the version number that's running.
This section also tells us what published parameters are in the workspace and what their values are.
Perhaps the most useful part of this section is that you can copy and paste this statement to run the workspace through a command
line or using a batch file.
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Configuration and Setup Information
Configuration and setup messages in the FME log tell us vital information about FME's version and configuration, the system
resources and how FME intends to use them, and what system paths are being used.
Starting translation...
FME 2019.0.0.0 (20190328 - Build 19238 - WIN64)
FME_HOME is 'C:\Program Files\FME2019\'
FME Desktop Smallworld Edition (floating)
Permanent License.
Machine host name is: Training2019

For example, here you can see which version of FME is being used (FME2019.0.0.0, 64-bit), its license type (floating), and the
machine name (Training2019). If you do have multiple FME versions installed, it’s a second location to check the correct one is
running.
Following further configuration messages (about shared folders) is information about the working and temporary folders:
FME Configuration: Current working folder is
`C:\FMEData2019\Workspaces\InstructorUse\DesktopAdv'
FME Configuration: Temporary folder is `C:\Users\mireland\AppData\Local\Temp\2',
set from environment variable `TEMP'
System Status: 10.42 GB of disk space available in the FME temporary folder
(C:\Users\mireland\AppData\Local\Temp\2)
System Status: 128.00 TB of virtual memory available

This is important because (as we'll see) the temporary folder location has performance implications. Then there is information
about the operating system:
Operating System: Microsoft Windows Server 10 Server 4.0 64-bit

(Build 14393)

FME Platform: WIN64
Locale: en_US
Code Page: 1252

(ANSI - Latin I)

Language and encoding aren't performance indicators, but they can help us diagnose problems with encoding in the output.
Later in the log is important information about the system resources and FME’s memory management:
FME Configuration: Process limit is 8.00 GB of physical memory
FME Configuration: Start freeing memory when process usage exceeds 24.00 GB of
virtual memory
FME Configuration: Stop freeing memory when process usage is below 18.00 GB of
virtual memory

In this case, there is a limit of 8GB memory per process. The following numbers indicate how FME will manage memory
resources. It will use 24GB of virtual memory and then it will start to release memory by caching features to disk. This caching
will stop once virtual memory use is less than 18GB.
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This way FME will perform to its potential automatically, while not taking so much memory that the system may fail or other
processes on the system would suffer.

FME Lizard says…
There can be understandable confusion about terms such as physical memory, virtual memory, address
space, and swap space; so let's take a moment to explain them.
On a 64-bit system, address space (which is where data is actually stored) has an impractically high
maximum (128TB) that has no practical value; other failures would occur long before that number is
breached. So instead of reporting address space, 64-bit FME reports "Virtual Memory". This is a more
realistic number that combines physical memory (the actual chips on your motherboard) with a portion of
disk called Swap Space.

Temporary Folder
For performance tuning one of the most critical parts of the log reports the temporary folder being used. When physical memory
resources become low, FME starts to cache data to disk (the Swap Space) and swap that data in and out of physical memory as
required.
The temporary folder is where it writes data to, so there are two important considerations for that folder.
Firstly it's important to ensure this folder has enough temporary disk space for the translation being carried out. Depending on the
workspace, the transformations being carried out, and other processes happening on the computer; temporary disk space
requirements may be many times greater than the size of the original dataset.
Secondly, it's useful if the disk written to is both fast and unused by any other process. It will not, for example, help performance
to share the temporary disk with the operating system; additionally, a solid-state disk is much faster than a traditional hard drive.

FME Lizard says…
The comparative benefits of RAM vs. SSD vs. HDD are hard to quantify. Do a web search if you don't
believe me; people quote RAM as being 4x as fast, 20x as fast, 100,000x as fast!
In reality, it depends on so many factors. However, in general, use as much memory as you can to avoid
caching, and use SSD so that - where caching/swapping is unavoidable - it runs as fast as possible.
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Translation and Transformation Statements
The main body of the FME log concerns the translation and transformation of data. The contents of this section vary according to
the actions being carried out and the transformers used.
However, there are several key messages common to all translations...

Key Messages
The first key message is simply "Emptying Factory Pipeline":

Emptying factory pipeline

This message signifies that reading of data is at an end, and all readers are closed. Because of how FME processes data, this
message may appear near the beginning of a translation or near the end. It may even appear after transformation and writing has
commenced!
By checking the timestamp for this message, you can get an approximate value for how long the workspace took to read the
source data.

Unexpected Input Remover

This message denotes where features read by a reader are tested against the available feature types (and merge filters) to see if
they are allowed to pass into the workspace.
This message may indicate a performance issue as it highlights potentially unnecessary work, where features are being read but
not used in the translation.

ResourceManager: Optimizing Memory Usage. Please wait...

This message alerts you to the fact that some reorganization of memory usage is going on. For example, maybe the memory
management limits mentioned in the configuration part of the log have been reached, and FME is having to work around the issue.
If you see this message frequently, then it’s time to either redesign your translation or switch to a 64-bit setup. It is a key indicator
that a lack of memory is affecting performance.

FME Lizard asks...
Q) How would you find the Emptying Factory Pipeline setting in the log window?
Looking for the color: it is the only message highlighted in red
Looking for the message type: it is the first message of type STATS
By using the log search tools
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By opening Tools > FME Options to turn off all other messages
A) You would use the log search tool. This is simple to use by pressing Ctrl+F
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Translation Summary
The final part of a log file includes a report of the number of features read and written:
______________________________________________________________________________
Features Read Summary
______________________________________________________________________________
CityParks
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CommunityCentres

10

DrinkingFountains

113

FoodVendors

91

GarbageSchedule

6

Libraries

8

TransitStations

11

______________________________________________________________________________
Total Features Read

308

______________________________________________________________________________
______________________________________________________________________________
Features Written Summary
______________________________________________________________________________
CommunityFacilities

18

Miscellaneous

108

ParkFeatures

182

______________________________________________________________________________
Total Features Written

308

______________________________________________________________________________

More importantly, from a performance point of view, it includes a brief report of the time taken by the translation and the amount
of memory used:
Translation was SUCCESSFUL with 0 warning(s) (308 feature(s) output)
FME Session Duration: 1.1 seconds. (CPU: 0.8s user, 0.3s system)
END - ProcessID: 3984, peak process memory usage: 105448 kB, current process memory
usage: 93964 kB
Translation was SUCCESSFUL

Peak memory usage is an important statistic. It signifies how hard FME is having to work. If this number can be reduced,
performance will often improve.

Written Features
One of the most misinterpreted statistics in an FME log is the number of features written.
What this really means is “the number of features sent to the writer”. It doesn’t always mean the same number of features actually
gets written to the output dataset, or that the output dataset will contain only that number of features.
For example, a feature sent to a writer might be rejected because of invalid geometry. In that case the log reports the feature
written, but an earlier warning might note:
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Rejected 1 output feature

Similarly, a format may have geometry limitations that cause the output dataset to be slightly different to the numbers logged.
For example, MicroStation DGN format has a limit on vertex numbers for each element (feature). If the MicroStation writer
receives a feature with too many vertices, it splits that feature into multiple MicroStation features (elements in MicroStation
speak) to avoid going over the vertex limit.
Thus, the number of features that actually appear in the dataset can be different to the number of features logged as being sent to
the writer!

WARNING
Currently, features read or written by the FeatureReader/FeatureWriter transformers are not included in
the summary at the end of the log. To find this information you would need to examine the feature counts
displayed on the connections in or out of those transformers.
Similarly, Features Read does not include features that were read from a cached source dataset.
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Log Timings
The timestamps in FME logs are invaluable for assessing performance.
Remember, the structure of the log is this:
Absolute DateTime| Cumulative Time| Time for Operation| Message Type| Message
Content

Time for Operation is the amount of time spent on that step of the translation, and Cumulative Time is the sum of those
operations.
Although cumulative time is the amount of time the FME process has spent translating or transforming data, it does NOT include
the amount of time spent waiting for other processes to do their work.
For example, examine this section of log timings:
2019-02-10 14:43:06|

8.5| 0.0|

2019-02-10 14:43:13|

8.8| 0.3|

2019-02-10 14:46:29| 18.0| 9.1|
2019-02-10 14:49:29| 25.8| 7.9|

The difference between the start absolute time (14:43) and the finish absolute time (14:49) is over six minutes. However, FME is
only reporting 25.8 seconds of processing time!
The “lost” time is down to external processes that FME was waiting on.
For example, maybe the message content would look like this:
2019-02-10 14:43:06|

8.5| 0.0| INFORM| Preparing SQL query

2019-02-10 14:43:13|

8.8| 0.3| INFORM| Sending SQL query

2019-02-10 14:46:29| 18.0| 9.1| INFORM| Received initial database response
2019-02-10 14:49:29| 25.8| 7.9| INFORM| Received data from database query

Now we can see that it was a database query that FME was waiting for. The more the query was not well-formed, or the database
not well-structured, the longer the time difference would be.
Similarly, reading/writing data from/to a disk can account for missing time.
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Exercise 1

Public Art in Parks - Feature Caching

Data

City Neighborhoods (Google KML)
Public Art (Microsoft Excel)
Parks (MapInfo Tab)
City Orthophotos (GeoTIFF)

Overall Goal

Examine a workspace that analyzes public art in city parks

Demonstrates

Inspecting a log file

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex1-Begin.fmw

End Workspace

None

The provincial government has given the city a grant to fund new public art in parks. To maximize the use of funds, the city would
like to add art to parks without existing art, or with no art within 100 meters of the park.
A colleague has created a workspace to analyze the amount of art in each city park. The results are written to an Excel spreadsheet
and a series of raster maps (one per neighborhood). Your task is to carry out a code review to ensure that the workspace is efficient
and well-designed.

1) Open and Run Workspace
Start Workbench if necessary and open the starting workspace. It is a relatively large workspace compared to what we have seen
so far:

Firstly check that the log timestamp option is turned on (Tools > FME Options > Translation > Log Settings). Secondly, ensure
Feature Caching is also turned on and then run the workspace. It will take about 20 seconds to complete.
Now we have a log file and a set of caches, and can start to deconstruct the workspace and how it performs.

2) Examine Workspace
The first step is to understand how the workspace operates. Luckily our colleague has made a workspace that appears well
organized and has plenty of bookmarks and annotation.
The Navigator window shows that there are four readers (and two writers):
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So the first bookmarks contains four feature types, each of which must belong to a different reader. The workspace reads Parks
(MapInfo TAB) and a list of public art (Excel spreadsheet), which are obvious requirements. The other readers read orthophotos
(GeoTIFF) from which the output maps are created, and a set of neighborhoods (Google KML) which are used to subdivide the
data.
Inspect each of the source datasets in turn to become familiar with them. Notice that the datasets vary in their coordinate systems,
so you can't view them all together unless you have an active background map.
In general, the workspace is divided into two streams of data, each of which leads to a writer feature type. This is the upper
stream:

This section:
Puts a buffer around the parks (Bufferer) to account for the within 100 meters of a park rule
Turns the art Excel records into points (VertexCreator) and reprojects them (Reprojector)
Overlays the artwork points onto the parks polygons (PointOnAreaOverlayer)
Tests which parks contain artwork and which do not (Tester)
Sorts the data (Sorter), removes duplicates (DuplicateFilter), and removes excess attributes (AttributeManager)
This is the data that gets written to the Excel spreadsheet.
The lower stream looks like this:
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This section:
Turns the artwork points into larger ellipses (2DEllipseReplacer) and styles them (FeatureColorSetter)
Mosaics (dissolves) the orthophoto files into a single image (RasterMosaicker)
Overlays the artwork and park features onto the orthophoto image (VectorOnRasterOverlayer)
Divides the image into neighborhoods (Clipper) using the reprojected (Reprojector) neighborhood boundaries
Selects the bands to process (RasterSelector) and sets a nodata value (RasterBandNodataSetter)
This is the data that gets written to the GeoTIFF map images.
Take your time to examine the cache for each transformer to see the effect it has on the incoming data. When you are thoroughly
familiar with how the workspace operates, we'll turn to the log window...

3) Examine Log Window
We know how the workspace operates; now let's see what the log window reports. The log is nearly 1,000 lines long, so we'll only
lightly touch on some parts of it.
Firstly examine the command line section. This comes at the very start of the log. It tells us which command we would use if the
workspace was to be run in a batch file. It's interesting, but does little for us here, apart from confirm which readers and writers
exist.
Next check the configuration information. It will start off like this:
Starting translation...
FME 2019.0.0.0 (20190328 - Build 19238 - WIN64)
FME_HOME is 'C:\Program Files\FME2019\'
FME Desktop Smallworld Edition (floating)
Permanent License.
Machine host name is: Training2019

This lets us know which version and build of FME we are using. Importantly we are using 64-bit FME, though that is pretty much
the standard version now anyway. The more important part is:
FME Configuration: Process limit is 8.00 GB of physical memory
FME Configuration: Start freeing memory when process usage exceeds 24.00 GB of
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virtual memory
FME Configuration: Stop freeing memory when process usage is below 18.00 GB of
virtual memory

Here we see how our machine will manage memory. If there is a large difference between running the workspace on our machine,
versus running the workspace on our colleague's machine, then this would be important information in determining why that
difference might occur.
If you continue to scan through the workspace, you'll find these messages, in this order (line numbers are approximate as they may
vary per computer):
Creating reader for format: Microsoft Excel (line 67)
VertexCreator (VertexCreatorFactory): Splitting feature table (123)
Reprojector: Using transformation `NAD83_to_WGS84 (126)
Excel Reader: Closing dataset 'C:\FMEData2019\Data\Culture\PublicArt.xlsx'... (155)
Creating reader for format: Google KML (156)
Creating reader for format: MapInfo TAB (MITAB) (190)
Closing native MapInfo reader (203)
Creating reader for format: GeoTIFF (Geo-referenced Tagged Image File Format) (205)
MULTI_READER(GEOTIFF_1): Done reading 40 features from 40 readers (533)
Emptying factory pipeline (535)

These are key messages. They indicate readers being opened and closed. Several interesting things are:
The order in which readers are opened matches the order they are shown in the Navigator window
Transformation (here the VertexCreator/Reprojector) take place while data is being still read
The KML reader appears to have no message when it is closed
Emptying Factory Pipeline denotes that all readers have read their data and are now closed.
Further scanning shows us transformers mentioned in this order:
RasterMosaicker (line 547)
Bufferer (549)
Reprojector_2 (552)
VertexCreator (554)
Reprojector (556)
PointOnAreaOverlayer (568)
Tester (571)
Sorter (578)
DuplicateFilter (622)
AttributeManager (624)
2DEllipseReplacer (625)
FeatureColorSetter (631)
VectorOnRasterOverlayer (634)
Clipper (637)
RasterSelector (665)
RasterBandNodataSetter (669)

So that's all of our transformers. The order is generally correct, but not necessarily to be relied upon. That's because logging is not
always consistent; some messages might get stored in a buffer and not logged immediately, some transformers might not log a
message for the same event, and the inner-workings of FME may be different than depicted in the workspace. Still, it is a good
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start.
More scanning and we see the writers logged:
Creating writer for format: Microsoft Excel (Line 583)
Creating writer for format: GeoTIFF (Geo-referenced Tagged Image File Format) (765)

This too occurs in the order shown in the Navigator window. The interesting part there is that the Excel writer is started as soon as
a feature reaches it from the AttributeManager; it doesn't wait until all transformation is complete. And this also shows how log
messages can be a little odd: the Excel writer is logged as created before the AttributeManager is logged as sending features to it!
The final part of the log mentions the results of our translation. This includes the features read and written, plus a summary of the
translation performance:
Translation was SUCCESSFUL with 9 warning(s) (70 feature(s) output)
FME Session Duration: 19.6 seconds. (CPU: 10.5s user, 4.6s system)
END - ProcessID: 7880, peak process memory usage: 715544 kB, current process memory
usage: 146176 kB

When you ran the workspace you might have seen a pop-up window mention that some features were read but discarded:

...and this message is repeated as the final line of the log. What it means is that a few objects from the KML dataset were ignored.
The Unexpected Input Remover would also show this during the log:
Router and Unexpected Input Remover (RoutingFactory):
Tested 314 input feature(s), wrote 314 output feature(s):
311 matched merge filters, 311 were routed to output, 3 could not be routed.

So that's all explained.

CONGRATULATIONS
By completing this exercise, you have learned how to:
Examine a workspace to determine its function
Deconstruct a workspace log
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Workspace Authoring versus Production Performance
Workspaces are authored in FME Workbench, and quite often they are run in FME Workbench too. However, wherever a
workspace is run, the production version should look quite different to when it was being authored.
That's because when an author builds and tests a workspace, they use a number of features designed to help in those creation and
debugging steps. However, these features often slow the translation, so it's important to avoid them in a production-ready
workspace.
Note that many of these features don't appear to hinder performance during workspace development, because development usually
takes place on a small subset of data. But scaling up to production-levels of data also scales up the impact on performance.
In short, it's important to think of development and production as two entirely different stages, and design workspaces
appropriately for each stage.

FME Lizard says…
There are always exceptions to any rule, and you may disagree with some of the content below. However,
it is definitely true that you should try as much as possible to remove any functionality used for debugging,
before putting a workspace into production.

Logger and Inspector Transformers
Logger and Inspector transformers are commonly used to inspect data during the authoring process.
The Logger writes information to the log file, while the Inspector sends data to the FME Data Inspector. Both should be avoided
in a production workflow for two reasons. Firstly such inspection techniques aren't generally needed in a production workflow,
and secondly both will cause a reduction in performance. The Inspector, in particular, can use a large amount of system resources
in sending data to the Data Inspector.
All Logger and Inspector transformers can be removed in one action by using Tools > Remove... > Inspectors or Loggers in the
menu bar:
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There is a more pressing need to remove these transformers from a workspace run in FME Desktop. When run on FME Server the
Inspector transformers will be ignored, as there is no visualization tool on that platform.

Feature Caching
Running a workspace with Feature Caching enabled takes a huge performance hit because each transformer caches data. It is
again a debugging tool and so best to turn this feature off when authoring and testing is complete, and the workspace is put into
production. This is so important that the log window even records when feature caching is turned on:

If feature caching was used to aid inspection of features, this should not be required on a production workflow. If feature caching
was used for the purpose of a partial run, then only the required section of workspace should be put into production.
As with Inspector transformers, feature caching has no effect on a workspace run on FME Server.

Disabled Sections
In some cases parts of a workspace are disabled - or separated from the main workflow by a disabled connection - in order to test
just specific sections. This is not something that should be maintained in a production workspace.
If the components were disabled for testing only, then they should be activated for production work. If the components are not
needed at this time, consider storing them in a separate workspace or saving a separate workspace version without them.

FME Lizard says…
If there are parts of a workspace that may not be needed, why not use a user parameter to divert data? In
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software development these are called Feature Flags and this blog by an FME user explains how to
implement them in a workspace.
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Assessing Performance
Assessing the performance of a workspace such as this:

...requires a bit of time and attention, but knowing how a workspace performs helps to make informed decisions on how to best
design (or redesign) it.
When testing for performance ensure that there is only one instance of FME running, and all other non-essential programs are
closed. You'll also need to turn off feature caching, as that can have an effect on the results.

Assessing Reader Performance
To be able to improve the efficiency of a reader requires an estimate of how well it is working in the first instance, yet this can be
hard to separate out in a workspace that is also transforming data.
The key message that signifies reading is complete is “Emptying Factory Pipeline”. Here, for example, reading of the data
finished after 26.4 seconds of processing (of course the actual elapsed time might be longer if FME was waiting for a database or
the file system to respond):
2019-03-29 11:48:54|

26.4|

0.0|INFORM|Emptying factory pipeline

However, sometimes that message can be misleading. FME processes the data at the same time it is reading it, so that it won't read
an entire data set before processing. To avoid this confusion, disable all the transformers and simply run readers:

With the transformers disabled, the message now appears much sooner:
2019-03-29 11:49:35|

1.2|

0.0|INFORM|Emptying factory pipeline

So we can tell that reading the data is only taking 1.2 seconds.
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Assessing Writer Performance
As with readers, you can't improve the performance of a writer unless you can first assess how well it is already performing.
However, assessing the speed of writing has the same complexity as reading: FME starts writing data as soon as it becomes
available and doesn’t necessarily wait until processing is done.
So, how can we assess writer performance? Assessing a writer is clearly different to a reader. If you isolate the writers by
disabling everything else, there won't be any data to write!
The easiest way is to disable the writer itself!

If the original result was this:
2019-03-29 11:54:14|

26.5|

0.0|INFORM|Translation was SUCCESSFUL with 19

warning(s) (148 feature(s) output)
2019-03-29 11:54:14|

26.5|

0.0|INFORM|FME Session Duration: 26.7 seconds. (CPU:

22.5s user, 4.0s system)

...and with the writer disabled it is now this:
2019-03-29 11:56:48|

26.6|

0.0|INFORM|Translation was SUCCESSFUL with 19

warning(s) (0 feature(s) output)
2019-03-29 11:56:48|

26.6|

0.0|INFORM|FME Session Duration: 26.6 seconds. (CPU:

22.1s user, 4.4s system)

...then we can easily calculate that the writing process is taking merely 0.1 seconds.

TIP
Another method is a two-step process.
Firstly, add a Recorder as the final transformer, to preserve the data in FFS format at the moment it is
about to be written. Run the workspace.
Secondly, replace the Recorder with a Player transformer, to re-read the preserved FFS data. Disable
everything else up to that point and re-run the workspace.
The data is played back into the workspace and written to the output, giving us a measure of writer
performance.
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Assessing Transformer Performance
Assessing the time taken in transformation requires a two-step process.
First, disable writers and run the translation, taking note of the elapsed time:

Then disable the transformers too and rerun the workspace, to calculate the time taken to read the data only:

The difference in elapsed time between reading the data and reading/transforming the data is the elapsed transformation time.
It's important not to add an Inspector or Logger transformer to see what is happening to the output. This will slow the translation
down and give you a false measure. You must also be sure to disable the actual writer and not just the feature types or connections
to them.
The only writer that is useful in this scenario is the Null format writer. This causes a writer to be present, but it does nothing
except to count features and then discard them. The benefit is improved logging of feature counts, but without any data having to
be written.

WARNING
Naturally, where a FeatureReader or FeatureWriter transformer is used, assessing reading and writing
requires a different procedure:
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It would be necessary to run the workspace twice; once with everything disabled after that point, and once
with everything disabled up to (and including) that point. Then subtract the two run-times to get the
correct result.
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Exercise 2

Public Art in Parks - Feature Caching

Data

City Neighborhoods (Google KML)
Public Art (Microsoft Excel)
Parks (MapInfo Tab)
City Orthophotos (GeoTIFF)

Overall Goal

Examine a workspace that analyzes public art in city parks

Demonstrates

Analyzing Performance

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex2-Begin.fmw

End Workspace

None

As you'll recall, the provincial government has given the city a grant to fund new public art in parks.
A colleague has created a workspace to analyze the amount of art in each city park and we are carrying out a code review to
ensure that the workspace is efficient and well-designed.

1) Open and Run Workspace
Open your workspace from the previous exercise, or the workspace listed above. Previously we ran the workspace with caching
turned on and it took about twenty seconds to run.
Now - to test production performance - turn off feature caching. There are no Inspector or Logger transformers, and no parts are
disabled. So simply re-run the workspace.
You should find that the workspace runs a lot more quickly this time - perhaps in as little as five seconds:
Translation was SUCCESSFUL with 2 warning(s) (70 feature(s) output)
FME Session Duration: 4.8 seconds. (CPU: 3.3s user, 1.2s system)
END - ProcessID: 2524, peak process memory usage: 452260 kB, current process memory
usage: 146324 kB

This clearly shows the performance reduction that caching can cause. This is particularly true in a workspace processing large
raster datasets. Caching shouldn't be required in a production workspace because the authoring and debugging phases of
development should be complete.

2) Assess Relative Performance
Although the workspace now runs very quickly, we could assess the relative performance of each section anyway.
Firstly disable all components after the readers, and run the workspace. Make a note of the time the workspace now takes to run:
Translation was SUCCESSFUL with 1 warning(s) (0 feature(s) output)
FME Session Duration: 1.4 seconds. (CPU: 1.0s user, 0.3s system)
END - ProcessID: 7148, peak process memory usage: 116928 kB, current process memory
usage: 107228 kB

Now enable all transformers, leaving only the writers disabled. Re-run the workspace and make a note of the performance:
Translation was SUCCESSFUL with 2 warning(s) (0 feature(s) output)
FME Session Duration: 1.7 seconds. (CPU: 1.1s user, 0.4s system)
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END - ProcessID: 1436, peak process memory usage: 146044 kB, current process memory
usage: 142124 kB

From this we know that:
Reading data takes 1.4 seconds (the first partial run)
Transforming data takes 0.3 seconds (the second partial run minus the first partial run)
Writing data takes 3.1 seconds (the overall run minus the second partial run)
So writing data takes the longest in this workspace, although the workspace isn't really that slow anyway.
Still, in the next exercise we'll go on and see what we can change in the workspace to make it more efficient.

CONGRATULATIONS
By completing this exercise, you have learned how to:
Discover the performance liabilities of feature caching
Analyze a workspace for relative performance of different sections
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Improving Reader Performance
The most important method to improve reading performance is to minimize the amount of data that is being read. As already
mentioned, reading excess features counts as unnecessary work and is therefore inefficient.

WARNING
It's bad enough to read extra features, but that effect can be multiplied many times when Feature Caching
is turned on. Therefore you need to be extra careful to read no more data than is necessary.

Filtering Input
For example, this workspace reads nearly 14,000 features but immediately discards all except 419 of them (ones where the
owner's name begins with "C"):

In this scenario, if possible, it would be much more efficient to simply just read those approximately 400 features. Not only does it
avoid reading unnecessary data, but it also avoids caching it twice over!
Fortunately, all formats have various sets of parameters that speed up feature reading, by filtering the amount of data being read:
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The first of these – search envelope – defines the data to read as a geographic area. Then only that area of data needs to be read.
These parameters are available on every spatial data reader but have the most effect when the source data is spatially indexed.
Then the query is being carried out at its most efficient.
Similarly, there are a number of parameters designed to let the user define how many features to read. These parameters include
the ability to define a maximum number of features to read, and what features to start with. There is also a parameter that defines
which feature types (layers or tables) should be read.
By using these judiciously, the amount of data being read can be reduced and the translation sped up. For example, if we knew
that the first records in the dataset were the ones beginning with "C", we could set Max Features to Read to 419.
Other formats – particularly databases – have additional clauses that can help reduce the data flow:
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Here, for example, this Geodatabase reader has a ‘WHERE Clause’ parameter that applies the "owner name begins with 'C' test" in
a way that is more efficient than reading the entire contents of a large table and using a Tester transformer.

FME Lizard says…
In short, when you want to filter source data, and can use a specific reader parameter to do so, it is more
efficient than reading all of the source data and then filtering it with a transformer. Caching the reader
does not necessarily help as - in the above workspace - the Tester:Failed port features are still being
cached, causing a performance delay.

Excess Feature Types
Another potential bottleneck - specifically for formats with a table list – is the case where you have more feature types than are
necessary.
Here the user has added two tables to their Geodatabase reader:

However, if you look at the workspace, the PostcodeBoundaries table is not even connected to anything. The unconnected table is
still being read - and cached - but the data is being ignored:

Presumably, the user added the tables for some reason, but then decided they did not need them, In that case, they should delete
the feature type from the FME workspace. Then the table will not be read and performance will improve.
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Remove Unattached
When developing a workspace, it is easy to lose Feature Types that are unused, especially once the workspace grows in size. To
quickly remove these unused Feature Types go to Tools > Remove... > Remove Unattached in the menu bar.

Obviously this tool is less useful when there is just one unattached item, but is more useful in a larger workspace with an unknown
number of unattached objects.
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Improving Writer Performance
There are various ways to speed up writing data. Compared to reading, tuning the underlying systems is a more important
improvement; the number of features is less important as it's much harder to write extra data unintentionally.

File System Improvements
If you are writing to a file system then make sure the disk is fast and responsive – use solid state drives – and that the operating
system is not busy writing other files at the same time, as the latter could cause a significant bottleneck.
Also, check if you are using RAID; some configurations need multiple writes and can slow down a translation.

Database Improvements
If you are writing to a database, then existing indexes and joins can cause the process to be slower than expected. In many cases, it
will be quicker to drop an index, write the data, and then recreate the index.
More information on database performance with FME comes in a later section.

Multiple Writers
Perhaps the most important technique for improving writer performance involves the scenario where a workspace has multiple
writers.
In short, it’s important to get the writers into the optimum order, to ensure that the writer that is to receive the largest amount of
data is written first.
The reasoning behind this is that the first writer in a workspace starts to write data as soon as it is received. Other writers cache
theirs until they are ready to start writing.
Therefore, if the largest amount of data is written immediately, lesser amounts of data have to be written to, and stored in, a cache.
This can improve performance tremendously, particularly when the translation is especially unbalanced; for example, one million
features go to one writer, and only ten features go to another.

FME Lizard says...
Think of it like an airport. It’s more efficient when you load the busiest flights first, because it empties the
terminal waiting areas quicker. For more information see this FME Evangelist article.

Setting Writer Order
There are two ways to affect the order that writing occurs in.
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Firstly each writer is listed in the Navigator window in Workbench and can be re-ordered by moving them up and down in the list
in the Navigator window:

The first writer in the list is the one that is initiated first, therefore it should be the one to receive the most data.
The second method is to use a workspace parameter called Order Writers By:

This parameter can be left to Position in Workbench Navigator in which case the order of writers as defined in the Navigator takes
priority. Alternatively, it can be set to First Feature Written. In that case, the writer that receives the first feature will be the first to
start writing data.

FME Lizard asks...
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Q) Given this screenshot, which should we make the first writer in this workspace?

Writer A
Writer B
Writer C
Don't know!
A) Sorry, but it is impossible to tell from just this screenshot. That's because it's not just the most features
that is important, but the size of those features. There are more features in writer B, but they are just point
features. Writer C is writing features with no geometry, but we don't know how many attributes there are
and of what type. And writer A is writing unknown geometry. If they were park boundaries consisting of
many thousands of vertices, that may be more data in total than the others. In short, you must use your
own judgment and knowledge of the data being processed to make this sort of decision.
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Optimizing Transformation Performance
The key to improving transformer performance is to reduce the amount of memory used, particularly in group-based transformers.
To do this you can either reduce the amount of data entering a group-based transformer, or use parameters that, in the right
conditions, can reduce the need to store data in memory.

Transformer Order and Filtering
Although the order of transformers can sometimes vary without affecting the result, at other times it is important to get the correct
order for performance reasons.
You’ll get better performance when you put the least amount of data into a group-based transformer as possible. One scenario is to
put feature-based filter transformers before the group-based process, not after it:

For example, here the author is filtering data after statistics have been calculated on one set of data. It would be more sensible to
filter the data before calculating the statistics, otherwise processing has been carried out on features that were eventually ignored.
The best way to remember this is: Filter, Remove, Action!
In other words, filter first, then remove attributes, then carry out the action.

Group-By Mode Parameter
A common parameter to most Group-Based transformers is called "Group By Mode" and appears near the Group By parameter in
most transformer dialogs:

When set to Process at End (Blocking) then ALL of the features are stored in memory until they are all available. Then groups are
formed. The transformer is literally blocking data from proceeding.
When the parameter is set to Process When Group Changes (Advanced), then FME processes groups as they become available.
That way less data is stored in memory and processing is more efficient.
The condition for applying this parameter is that the groups of features are pre-sorted into their groups.
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For example, in the above screenshot, the user is using the ZoneCategory attribute as a group-by parameter (i.e. zones are
dissolved together where they are the same category). If the incoming data is already sorted in order of ZoneCategory then the
user can set the Group By Mode parameter and allow FME to process the data more efficiently.

WARNING
When using Input Ordered By Group on a transformer with two (or more) input ports, you need to arrange
data to arrive in group order (Port 1, Group A, Port 2, Group A, Port 1, Group B, Port 2, Group B, etc.)
i.e. it's not just a case of each stream of data being ordered correctly, you need to alternate streams/ports
for each group - and that's very difficult to achieve.

Features First Parameter
Besides the "Group By Mode" parameter, some transformers have their own, unique, parameters for performance improvements.
Many of these specify one type of feature to arrive "first."
For example, the PointOnAreaOverlayer transformer expects two sets of data: Points and Areas. By default, FME requires all
incoming Points and Areas because it needs to be sure it has ALL of the Areas before it can process any Points.
But, if FME knows the Area features will arrive first (i.e. the first Point feature signifies the end of the Areas) then it doesn’t need
all Point features. It can process each one immediately because it knows there are no more Areas that it could match against.
The user specifies that this is true using the parameter Areas First:

But how does a user ensure the Area features arrive first? Well, like writers you can change the order of readers in the Navigator
so that the reader at the top of the list is read first.
Changing the reader order doesn’t improve performance per se, but it does let you apply performance-improving parameters like
the above.

Attributes and Transformation
As mentioned (in Reader Performance) reducing data helps performance because it saves FME from either holding it in memory
or caching it to a disk.
However, this isn’t just helped by reducing the number of features; it is also helped by reducing the size of each individual feature.
One aspect of this is attributes. Carrying attributes through a translation impacts performance, so if the attributes are not required
in the output, it’s best to remove them as early as possible in the translation.
For example, when the reader and writer schemas look like this:
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...it makes sense to remove excess attributes from the translation, as early as possible.
There are two ways to remove attributes. Some reader formats (but not all) have a setting in the reader feature type to avoid
reading excess attributes in the first place:

With that, you can ensure that only attributes exposed are read. The other way to remove attributes is by using a transformer
(AttributeManager, AttributeRemover, or AttributeKeeper) directly after the source feature type:
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This ensures that none of the extra attributes become a drain on resources by being processed by any further transformers.

Lists
One specific type of attribute to beware of is a List. A list in FME is an attribute that can have multiple values. Because of this, it
can be a big drain on resources.
For example, use a Joiner to join a feature to 1,000 records and the list for that feature will have 1,000 sets of records. This is bad
enough, but if the list is exploded and all of the original attributes kept, then there will be 1,000 features each with 1,000 sets of
attributes!
In general, beware of creating lists unnecessarily and of keeping them in a workspace beyond the point at which they are still of
use.

Geometry and Transformation
Like attributes, geometry can be removed from a feature, in this case using the GeometryRemover transformer.
Many FME users create translations that handle tabular – non-spatial – data. If you are reading a spatial dataset and writing it to a
tabular format, be sure to remove the geometry early in the workspace, just as you would an attribute.
Another particular problem is carrying around spatial data as attributes. Spatial database formats - for example, Oracle or
GeoMedia - usually store geometry within a field in the database; for example GEOM. When FME reads the data it converts the
GEOM field into FME geometry and drops the field from the data.
However, if you read a geometry table with a non-geometry reader, the translation could end up with the geometry stored as an
FME attribute. A similar thing could happen when a workspace reads only one geometry column of a multiple geometry tables.
Geometry will create very large and complex attributes, which take up a lot of resources. If you don’t need them, then it’s worth
removing them.

Bulk Mode and Feature Tables
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FME's engine is gradually being updated to use a methodology we call Bulk Mode (also known as Feature Tables).
It's not a tool designed for user control, rather bulk mode is a new way for features to be transported through the workspace. Bulk
mode speeds up a workspace, its translations, and its transformations quite substantially. If you see a log message about Bulk
Mode (or sometimes Feature Tables) then this technology is what it refers to.
As more transformers support bulk mode, expect performance times to improve. However, you will need to upgrade transformers
to get this change. Look for Upgradable Transformers in the Navigator window and use right-click > Show Changes to find out if
the upgrade includes Bulk Mode support:

2019.1 UPDATE
In FME2019.1, the Tester transformer includes Bulk Mode support and can be upgraded to improve
performance.
However, this bulk mode support comes at a price: Feature order is no longer maintained the same way it
was before.
As an example, let's say we have features numbered 1 to 10, in that order. They enter a Tester. The test
clauses are set up so that even numbers pass (emerge from the PASSED port), odd numbers fail (emerge
from the FAILED port).
Without bulk mode, the features would emerge in the order 1 (Failed port), 2 (Passed port), 3 (Failed), 4
(Passed), 5 (Failed) and so on. In other words, they emerge in the same order they entered.
With bulk mode, the output order is less certain. The output of each port will still be in order, but we can't
say that each port will occur in order. For example, the output order might be 1 (Failed), 3 (Failed), 5
(Failed), 7 (Failed), 9 (Failed), 2 (Passed), 4 (Passed) 6 (Passed), and so on.
In other words, with bulk mode, features emerge from each port in the same order, but one port may output
all of its features (or a bulk subset of them) before the next port starts.

FME Lizard asks...
Q) Which of these transformers have group-related parameters for improving performance (pick all that
apply and see if you can get the answers without looking at the transformers)
StatisticsCalculator
SpikeRemover
LineOnLineOverlayer
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FeatureMerger
A)The FeatureMerger has both a Group-By Mode and Suppliers First parameters, to help improve
performance. The LineOnLineOverlayer has the Group-By Mode parameter, but it only has one input port
so it won't have an XXXX-First type of parameter. The StatisticsCalculator has a group-by, but no
parameters to improve performance. The SpikeRemover is feature-based, and so has no group-based
performance enhancements.
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Exercise 3

Public Art in Parks - Feature Caching

Data

City Neighborhoods (Google KML)
Public Art (Microsoft Excel)
Parks (MapInfo Tab)
City Orthophotos (GeoTIFF)

Overall Goal

Examine a workspace that analyzes public art in city parks

Demonstrates

Improving Design and Performance

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex3-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex3-Complete.fmw

As you'll recall, the provincial government has given the city a grant to fund new public art in parks.
A colleague has created a workspace to analyze the amount of art in each city park and we are carrying out a code review to
ensure that the workspace is efficient and well-designed. Previously we inspected the workspace to see what it produced,
deconstructed the log file, and ran the workspace multiple times to assess the relative performance of each component.
Now let's look at some specific changes we can make to improve performance.

1) Open and Run Workspace
Open your workspace from the previous exercise, or the workspace listed above. Turn on feature caching (we're back in authoring
mode now) and re-run the workspace.
First let's first check if the readers are well-designed and don't read any excess data.
Check the Parks source data. We wish to identify parks without artwork, so we need all of these parks features.
Check the Neighborhoods data. Again, we need all of these features.
Check the Public Art data. Again, we need all of these features.
It's important to note that artworks fall in one of six neighborhoods, and there are the same six neighborhoods in that
dataset. There are no artworks outside one of these neighborhoods and no neighborhoods outside where we have
artworks, so there is no excess data being read.
Check the Orthophotos data. We're reading all the image files for the entire city. Are they any files we don't need?
To check the orthophoto coverage, start the FME Data Inspector (it will be easier than the Visual Preview window). Select File >
Open Dataset and set the files to open as follows:
Reader Format

GeoTIFF (Geo-referenced Tagged Image File Format)

Reader Dataset

C:\FMEData2019\Data\Orthophotos\*.tif

Parameters

Feature Type Name(s): From File Name(s)

In other words, select all of the TIF files in the Orthophotos folder. The Feature Type Name(s) parameter makes sure the Data
Inspector lists files by name.
Now select File > Add Dataset and set that dialog up as follows:
Reader Format

Google KML

Reader Dataset

C:\FMEData2019\Data\Boundaries\VancouverNeighborhoods.kml

Now you can check whether any GeoTIFF tiles fall outside the extents of the neighborhoods. If so, there are files being read that
are not necessary.
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2) Switch GeoTIFF Reader to FeatureReader
It appears that there are GeoTIFF files being unnecessarily read. This causes a performance hit, especially when Feature Caching
is turned on. We could just select the files we want to read, but if the neighborhoods dataset changed then this list might not be
correct.
So, instead delete the GeoTIFF format reader from the workspace. Add a FeatureReader transformer in its place. Make the
reprojected Neighborhoods data the Initiator (create a separate connection):

Open the FeatureReader parameters. Set the format to GeoTIFF and select all of the TIF files as the source. Set the Spatial Filter
parameter to Initiator Intersects Result:

Close the dialog and the FeatureReader now has a GeoTIFF output port. Connect this to the RasterMosaicker:
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If we run the workspace now the FeatureReader outputs 48 features. This is more than we had before (40) and occurs because
GeoTIFF tiles that overlap two neighborhoods are being read twice.
So add a Dissolver transformer between Reprojector_2 and FeatureReader. This will consolidate the neighborhoods into a single
feature and ensure each GeoTIFF is only read once. Re-run the workspace:

Now we only read 27 features, which is the correct amount. We are reading less data and so the workspace is performing better.
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3) Check Writer Order
The simplest writer improvement we might make is to change the order of the writers. Currently the Excel spreadsheet is being
written first. This means that GeoTIFF files - which are large in size - are being cached, instead of the smaller Excel file.
So, adjust the order of the writers, so that the GeoTIFF writer comes first in the Navigator:

Re-run the workspace. Although the workspace wasn't really slow to start with, you should notice it now runs slightly faster, using
less memory.

TIP
One other writer feature to consider is whether the Excel dataset is being deleted/recreated, or just
emptied of data. In theory it might be (very marginally) quicker to empty the sheets rather than creating
the whole spreadsheet from scratch.
To try this, change the writer parameter Overwrite Existing File to No, and change the writer feature type
parameter for Truncate Existing Sheet to Yes:

It's unlikely to make a very large performance improvement, but it is these sort of differences that you can
consider when reviewing a workspace for performance. You would especially want to consider this
question when writing to a database table with an index (more on that later).
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4) Upgrade Transformers
Now let's look into transformers. This is where there are a lot of different changes we can make. The first is to check for old
transformer versions. Notice in the Navigator window that two transformers are listed as "Upgradeable":

In turn right-click each entry and choose to Upgrade Transformer. You will be prompted with a warning that you can ignore, and
even choose to skip in future.
A dialog will open to show the changes in GUI to the transformer, and you can click the Show Changes button to get a written list
of changes:
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Upgrading transformers doesn't always make them operate faster - some changes are either functional or cosmetic - and it might
make their results slightly different. Therefore, it's not advisable to upgrade all transformers without first checking what the
upgrade involves.
However, in this case both transformers should be safe to upgrade, and the PointOnAreaOverlayer may even get an improved
performance from the upgrade. So go ahead and upgrade both transformers.

2019.1 UPDATE
As noted in the recent content, the Tester transformer has been updated for 2019.1 and can be upgraded to
use the new Bulk Mode. You'll remember, however, that this might change the order of features emerging
from the transformer.
Do you see any part of the workspace that relies on feature order? If not, you can safely upgrade this
transformer to its newest version, in order to get a performance boost.

5) Check Transformer Order
Look at the bookmark labelled Prepare Data for Excel Writer:

Inspect the transformers and you will see that data is sorted into order for writing first of all; then unnecessary features are filtered
out and unnecessary attributes removed.
This is not the correct order to maximize performance: unnecessary features with unnecessary attributes are being processed by
the sorting action. Remember, the key order is Filter-Remove-Action.
So, move the Sorter transformer after the AttributeManager:

Notice that the Sorter transformer is now flagged as incomplete. Inspect the parameters and you'll notice that the attribute
_overlaps no longer exists; it was renamed by the AttributeManager to ArtWorks.
So simply change the Sorter to sort by ArtWorks and the transformer will work again.
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2019.1 UPDATE
The Sorter has an intriguing update for FME2019.1. Notice that it has Group By and Group By Mode
parameters that didn't exist in FME2019.0. These parameters give us a potential performance benefit.
Can you see how? It's by using one of the sort attributes as a group by instead!
Let's say we are sorting by attributes StreetNumber and StreetName. The features are already in
StreetName order, but not StreetNumber order. We have to sort by both attributes because if we only sorted
by StreeetNumber, then the StreetName order would be disrupted. Are you with me so far?
So what we can do is Group-By StreetName and Sort By StreetNumber only. This is quicker on two counts:
firstly a group by is quicker than a sort. Secondly we can make use of the Group By Mode parameter,
setting it to Process When Group Changes.
So... the question is, does this help here? For example, could we set Group By = Artworks and Sort By =
Park Name? We could, but it wouldn't help. In fact, it would make the output incorrect. The problem is
that the data isn't already in order as it enters the transformer. So, it doesn't help here, but it's a
performance tip worth being aware of.

The other thing to consider is whether data can be filtered or removed earlier in the workspace. The two filtering transformers in
this workspace are the Tester and DuplicateFilter. Can we move these to earlier in the workspace?

FME Lizard asks...
Q) Can the Tester or DuplicateFilter be moved to earlier in the workspace?
The Tester can be moved, but not the DuplicateFilter
The DuplicateFilter can be moved, but not the Tester
Both can be moved
Neither can be moved
A) The Tester is testing a value created by the PointOnAreaOverlayer, so it cannot be moved. The
DuplicateFilter is removing excess records where a park is made up of multiple polygons. That only
applies to the Excel output, so it too should not be moved.

Can the AttributeManager transformer be moved? Well, it can't be moved because its renaming of the _overlaps attribute can only
happen here. However, removing attributes could be carried out much earlier.
The simplest technique is to add an AttributeManager after every reader whose attributes can be removed:
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So add an AttributeManager to each input that can be cleaned, and remove whatever attributes are not necessary to the workspace.
You can tell if you remove a necessary attribute if a transformer (or writer feature type) further on in the stream is flagged as
incomplete.
One transformer that is legitimately incomplete is the original AttributeManager (in the Prepare Data bookmark). This no longer
receives the attributes it expects. Simply open the parameters for that transformer and click the option for Remove All Invalid
'Input Attribute' Rows:
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Now we have removed all unnecessary attributes from the workspace, as soon as possible.

TIP
An alternative solution for database-type formats is to not read the attributes at all. In our workspace the
Excel reader is capable of this. You could open the reader feature type, change the Attributes to Read to
Exposed Attributes, and uncheck Name and Title:

If you do this then any AttributeManager you added could be removed.

6) Check Transformer Performance Parameters
As mentioned, a number of transformers have parameters specifically for performance benefits. These are often labelled as Group
By Mode or <Features First>
Check the transformers in this workspace. The two of particular interest are the Clipper and PointOnAreaOverlayer. Both of them
have a Group By Mode and a Features First parameter:

The Group By Mode parameters don't apply, because neither transformer is using a Group By. However, the Clippers First and
Areas First options are of interest. If we set these options we can get a performance boost, but we do have to confirm that either
Clippers or Areas are the first features to arrive.
In the PointOnAreaOverlayer, change the Areas First parameter to Yes. Re-run the workspace (either turn off caching or use rerun entire workspace). Notice that all Area features exit as <Rejected> features. They are rejected because they are not first!
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One reason might be that the MapInfo park features are being read after the Excel records. So, in the Navigator window move the
Parks reader to the top of the list:

Re-run the workspace. Notice that the park features are now first. This part of the workspace should be working more efficiently
now.
Try the same action on the Clipper transformer, to see if Clipper features are first so that the Clipper Type parameter can be set to
Clippers First.

7) Re-Run Workspace
With Feature Caching off, re-run the entire workspace. Check if the log results show that the workspace is quicker and more
memory efficient than it was before. The code review of your colleague's workspace is complete.

FME Lizard says...
Overall, the difference might be very slight. The workspace may not be hugely faster or more memory
efficient. However, it is better designed than the original workspace. This makes it more scalable, plus it
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will help to teach your colleague techniques that might, elsewhere, have a larger effect.

CONGRATULATIONS
By completing this exercise, you have learned how to:
Reduce the amount of data being read
Adjust the order of writers in a workspace
Reorder transformers to get the best performance
Use performance-related transformer parameters
Adjust the order of readers in a workspace
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Database Optimization
FME can only be as fast as the database it is reading from or writing to. This section will help FME increase its efficiency when
working with databases.

Database Reading
Reading and filtering data (querying) from a database is nearly always faster when you can use the native functionality of the
database. Just as previously mentioned you can use the search envelope and WHERE clauses to narrow down what is being read
from the database into FME.

Database Transformers
Besides readers, transformers can also be used to query database data. The best to use is the SQLExecutor (or SQLCreator) as
these pass their queries to the database using native SQL. If you don’t want to write SQL then you can use the FeatureReader
transformer, but be aware this transformer is more generic and won’t give quite the same performance.
The SQLExecutor is particularly worth being aware of, as it issues a query for each incoming feature. This can be useful where
you need to make multiple queries.
For example, here a query is issued to the database for every Neighborhood feature that enters the SQLExecutor:

Generally, the output from the SQLExecutor is an entirely new feature. If you want to simply retrieve attributes to attach to the
incoming feature, then the DatabaseJoiner transformer is more appropriate.

Database Writing
Whereas the performance of reading from a database is largely dependent on the database setup itself, when writing to a database
there are very many FME parameters that can help to fine-tune the overall performance.
Remember that writing to a database incurs network overheads. There has to be a balance between various factors:
1. The amount of data and number of requests being sent (network traffic)
2. The amount of data stored by FME awaiting transfer to the database (FME performance)
3. The amount of data stored in the database awaiting committal (database performance)
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4. The risk of losing uncommitted data
Each database writer has a set of parameters for handling these components. Not every format supports these, but the two most
common parameters are Features per Transaction and Features per Bulk Write.

Features per Bulk Write
The Features per Bulk Write parameter controls the second factor in the list (the amount of data stored by FME awaiting transfer
to the database).
The parameter is defined by a numeric value. Features sent to an FME database writer get cached in memory until the number of
features specified by this parameter is reached. Only then will they be sent to the database. This is also known as chunk size.
This parameter is a way to balance network traffic with FME performance. A higher number means FME caches more features (so
uses more system resources), but makes fewer requests to the database (and therefore causes less network traffic).
A lower number means FME caches less data, but there are more requests made to the database.
Features per Bulk Write also needs to be considered against the value of Features per Transaction.

Features Per Transaction
Features per Transaction (also sometimes called Transaction Interval) controls the third factor in the list (the amount of data stored
in the database awaiting committal).
This too is defined by a numeric value. Features sent to the database by FME are cached in memory by the database. When the
number of features specified by this parameter is reached, FME sends the command to commit them.
Each commit adds delay to the writing process, so setting this parameter must balance the speed of the translation (set a higher
number) against the risk that a translation may fail and features need to be rolled-back (set a lower number).

Features Per Transaction Examples
If Features Per Transaction is set to a value of 1, then each and every feature is committed individually. If the process fails then
only the last feature will be lost from the database. The cost for this reduced risk is a matching reduction in performance.
If Features Per Transaction is set to a very high value (more than the number of features being written) then only one commit
takes place. If the process fails then all features submitted to the database are lost. The benefit of this increased risk is a matching
increase in performance.

Features Per Transaction and Bulk Writes
There is an interaction between these two parameters that controls where features are cached.
If Features per Transaction is less or equal to Features per Bulk Write, then FME caches a number of features and sends them to
the database where they are immediately committed.
If Features per Transaction is greater than Features per Bulk Write, then FME sends features to the database where they will be
cached until the transaction commit total is reached.

FME Lizard says…
The Transaction and Chunk parameters can differ from format to format, so it’s very important that you
check out the FME Readers and Writers Manual to confirm what parameters are available for your
database, and how exactly they operate.
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Writing and Database Indexing
Whereas indexes can improve performance for reading data, for writing they can cause a great reduction in the speed of
translation.
That’s because the index gets updated by the database automatically with every feature that is written. This occurs on a per-feature
basis, regardless of commit intervals.
To remedy this it’s suggested that indexes are dropped (deleted) before carrying out bulk inserts of data into a database table. This
can be done directly on the database, or using an FME SQLExecutor transformer.

Writing and Table Creation
A writer feature type also has options to truncate or drop tables when writing to them:

As with the above, dropping a table is more efficient than truncating it because the drop action also removes the indexes.
For similar reasons, you may want to turn off networking connectivity when writing data to a Geodatabase geometric network.
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Performance, FME Server, and FME Cloud
FME Server adds an extra dimension to FME performance, that of scalability. In terms of performance, the item most easily
scalable is the number of FME engines.
Increasing the number of engines supports a higher volume of jobs, and the FME Server Core contains a Software Load Balancer
(SLB) to distribute jobs to the FME engines in a balanced way.

FME Lizard says…
FME Server is probably best-known for its web-based abilities; but it has huge potential in processing
large amounts of data in less time by creating multiple jobs on multiple engines.

Using Server for Bulk Translations
By default, utilizing multiple engines is only possible when you have multiple workspaces to run. When you have only a single
workspace and wish to process it more efficiently on FME Server, then you need to divide that workspace into multiple jobs.
To do so, I can create a parent workspace that divides my source data into separate parts and sends each to a different worker job
using the FMEServerJobSubmitter transformer.
For example, I can calculate the bounds of tiles to be created and share the load over multiple server engines by running the
workspace separately for each tile.

FME Cloud
FME Cloud is an installation of FME Server hosted by Safe Software on Amazon Web Services technology and used on a pay-asyou-go basis. The benefit is that you don’t have to purchase FME Server, merely make use of it whenever you have a job that can
take advantage of its power.
The key to automating this for performance benefits are the FME Cloud custom transformers available on the FME Store:
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With the FMECloudInstanceLauncher transformer (or the FMECloudInstanceController), I can run my parent workspace, have it
automatically start an FME Cloud instance and run one or more worker jobs on it.
This way I can start a new instance for each job, or run several jobs on one instance, depending on the type of instance and how
many engines it has running on it.

FME Lizard asks...
Q) How many FME engines does FME Cloud have available?
A choice of two, four, or eight
It depends on the FME license chosen
It depends on the virtual machine specifications
There are unlimited engines
A) FME Cloud allows an unlimited number of engines! Of course you must bear in mind that the
performance of those engines is constrained by your chosen hardware configuration.
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Batch Processing
Batch processing is the action of processing multiple source datasets in the same workspace. By splitting each dataset into a
separate process, performance can be improved. This is achieved with the WorkspaceRunner transformer.

Batch Processing Using the WorkspaceRunner
The WorkspaceRunner is a transformer that runs another FME workspace when used in a translation. One use of it is for chaining
multiple workspaces to run one after another. However, it can be used to run multiple workspaces simultaneously, in a form of
batch processing, and is especially effective used in conjunction with the Directory and File Pathname reader.
For example, we have a workspace that reads in orthophoto tiles and clips them to neighborhood boundaries, writing them using a
combination of tile and neighborhood as the output filename:

Imagine we get new orthophotos each week. Instead of changing the data in the previous workspace each time, we create a
workspace to batch process all the new files. This allows FME to start multiple processes simultaneously so that the data is
processed faster:

To set up the WorkspaceRunner in a workspace (the Parent), the FME Workspace parameter is pointed to the workspace to be
batch processed (the Worker or Helper). The Source File parameter is set to path_windows, an attribute created by the Directory
and File Pathnames Reader:
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The option to Wait for Jobs to Complete ensures one job is completed before starting another. Setting this option prevents multiple
Concurrent FME Processes.
If the job order is unimportant, the parameter Maximum Number of Concurrent FME Processes can be set. This causes multiple
FME processes (up to a maximum of seven) to be launched, and these can be seen in the Details tab of Windows Task Manager:

Notice that the FME Engine processes are completely separate to the FME Workbench and Data Inspector processes. One of the
FME.EXE processes is running the parent workspace, the others are running the helpers.

Batch Processing Using the Batch Deploy Wizard
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Batch deploy is available under the Run menu in FME Workbench. It supports both instant batch processing and the creation of
batch files. This allows you to process a large number of source datasets in the current workspace and produce a separate output
for each:

Batch deploy operates in the form of a Wizard. The user specifies the input and output datasets plus any other relevant settings
such as a suffix for the output file names.
If the process is not carried out right away, a batch .tcl file is created containing the batch process settings, as well as a .bat file
which is used to start the process at a later date.

FME Lizard says…
Batch Processing (on Desktop) can also be done using the command line or an FME Command File.
These techniques are more advanced then we want to get into for this course, but if you are interested in
learning more you can check out the Knowledge Base Article FME Batch Processing Methods
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Exercise 4

Garbage Collection Day Project

Data

Addresses (PostGIS or Esri Geodatabase)
Garbage Zones (Esri Geodatabase)

Overall Goal

Analyze and improve the workspace performance

Demonstrates

Database Optimization

Start
Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-PostGIS-Begin.fmw
C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-Geodatabase-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-PostGIS-Complete.fmw
C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-GeodatabaseComplete.fmw

Members of the public often call the city to ask what day their garbage collection is. To help the city has an internal system hosted
on FME Server. Members of the planning department can lookup an address ID, enter it into a published parameter, and the
system retrieves the garbage pickup information.
The system works but is perhaps slower than it should be. Let’s run this short exercise to discover why.

FME Lizard says...
This exercise uses either a PostGIS database hosted on Amazon RDS or an ESRI Geodatabase. You can
use either one (no extra license is required). Be sure to open the correct workspace and follow the correct
instructions for your chosen format.

1) Create Database Connection (PostGIS Only)
To use a PostGIS database as source requires a connection to it. If you are using Geodatabase instead of PostGIS, you can skip to
step 2.
In a web browser visit http://fme.ly/database - this shows the parameters for a PostGIS database running on Amazon RDS.
Start Workbench and select Tools > FME Options from the menubar
Click on the icon for the Database Connections category, then click the [+] button to create a new connection. In the "Add
Database Connection" dialog enter the connection parameters obtained through the web browser.
Give the connection a name (if you call it FME Training Database Connection it will match the starting workspace) and click
Save.
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NB: Yes, the password is fmedata as well!
Then click OK to close the FME Options dialog.

2) Open and Run Workspace
Open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-PostGIS-Begin.fmw or
WorkspaceDesign-Ex4-Geodatabase-Begin.fmw.
The workspace looks something like this:

Basically, a published parameter accepts an address ID. The postal address database is read and filtered against this ID. The
chosen address is used in a spatial overlay against garbage zones. The result is formatted in HTML and written out with a Text
File writer.
To get a comparison, run the workspace. Use Prompt Mode to be prompted for an address ID. A suitable address ID to use is
127209 (PostGIS) or 6135 (Geodatabase).
The result, in a web browser, is this:
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The performance will read like this:
PostGIS
INFORM|FME Session Duration: 8.0 seconds. (CPU: 1.7s user, 0.2s system)
INFORM|END - ProcessID: 7540, peak process memory usage: 141808 kB, current process
memory usage: 98924 kB

Geodatabase
INFORM|FME Session Duration: 2.2 seconds. (CPU: 1.8s user, 0.3s system)
INFORM|END - ProcessID: 724, peak process memory usage: 136420 kB, current process
memory usage: 93684 kB

The Geodatabase is quicker because it is being read from your own file system, not a remote database.

3) Set Up WHERE Clause
Neither PostGIS or Geodatabase have a WHERE clause for the reader itself, but their feature types do. So inspect the properties
for the PostalAddress reader feature type and in the WHERE Clause parameter enter:
PostGIS
"AddressId" = $(AddressID)

Geodatabase
OBJECTID = $(AddressID)
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For PostGIS, be sure to notice the lower-case "d" in the "Id" part of the field name! Also, note the difference in use of quotes
between the two formats.

4) Delete Tester
Now we have the WHERE clause the Tester transformer is no longer required, so delete it.

TIP
If you collapse the bookmark then delete the bookmark it deletes both the bookmark and the transformer
in one step:

5) Re-Run Workspace
Re-run the workspace. This time only 1 feature is read from the database. The performance improves accordingly:
PostGIS
INFORM|FME Session Duration: 5.3 seconds. (CPU: 0.7s user, 0.3s system)
INFORM|END - ProcessID: 7440, peak process memory usage: 138924 kB, current process
memory usage: 96848 kB

Geodatabase
INFORM|FME Session Duration: 0.9 seconds. (CPU: 0.5s user, 0.3s system)
INFORM|END - ProcessID: 7224, peak process memory usage: 126632 kB, current process
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memory usage: 93180 kB

Memory usage hasn’t improved, but the translation ran faster.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a database connection
Use a SQL WHERE clause to avoid reading all data
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Module Review
This chapter looked at FME Performance and some of the techniques available to improve it

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
Analyzing a log file helps to determine where performance improvements can be made
Performance is the measure of useful work done in a given time. Excess data and caching to disk are two factors that impact
performance
Reading performance is improved by reducing the amount of data being read
Writing performance is improved by ordering the FME Writers correctly
Transformation performance is improved by removing excess attributes and properly managing group-based transformers
Database performance is improved by passing tasks to the database and setting reader/writer parameters correctly
FME Server and FME Cloud process large quantities of data in a scalable environment
Batch processing is a way to make use of the full processing power of a given computer

FME Skills
The ability to analyze and deconstruct an FME log file
The ability to measure workspace performance for each set of components
The ability to use various methods for optimizing reader, writer, and transformer performance
The ability to use database parameters to improve performance
The ability to batch process data with the WorkspaceRunner transformer

Further Reading
For further reading why not browse articles tagged with Performance on our blog?
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Advanced Reading and Writing
Even "basic" FME reading and writing - with the ability to add readers and writers of multiple formats, import feature types, and
set a multitude of parameters - allow an author to construct very powerful data translations in FME.
So, when you master advanced capabilities - like web-based datasets, generic readers and writers, and dynamic translations - you
will be able to handle even the most complex translation and transformation scenarios.

FME Lizard says…
If there is a common theme in advanced reading and writing tools, it is "flexibility". This theme includes:
The flexibility to handle data in any location
The flexibility to handle data in any format
The flexibility to handle data with any schema
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Archive File Handling
Both FME readers and writers are capable of working with compressed, archived files of various formats. As well as a size
reduction, these file types are a convenient way to store datasets that need handling as a single unit; for example, a set of multiple
dataset files contained within a single zip file.

Archive File Reading
The dataset a reader reads is defined by the Source Dataset/Files parameter in the Navigator window:

As in the above screenshot, this dataset parameter can point to an archived file. You simply select the archive file in the source
parameter and FME will extract the data when it is being read.
This technique works regardless of whether the archived dataset is file-based (like a single AutoCAD file) or folder-based (like
the set of files that make up a Shapefile dataset).
The only difficulty in setting this up is to remember that the file browser does not display archive files by default and that the file
extension being viewed must be changed:

NEW
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Previous versions of FME allowed reading (and writing) of Zip-format archives. FME 2019 introduces
support for other archive formats such as 7zip and RAR.

Archive File Writing
Writing data as an archive file is particularly useful for where the output data needs to be post-processed. For example, if you use
a shutdown script to move or copy output data to a new location, it’s more convenient to handle a single archive file than multiple
data files.
The simplest way to create an archived output is to change the file extension in the output dataset field:

You can also specify the filename to be written inside the archive file. In fact, a shortcut button does this for you for Zip format
archives:

Notice the small icon in the dataset field that indicates the zipped status.
When the workspace is run the log file reports the file creation at various points:
MULTI_WRITER: Output will be zipped
Zipping contents of temporary dataset
Finished updating output zip file: `C:\FMEData2019\Output\Parks.zip'

...and the output is, indeed, an archived dataset:
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FME Lizard says…
Some users may want to archive data in order to move or copy it to a different location as a single entity.
A user parameter can be used in a TCL or Python shutdown script to find the name of the file just written,
and the FeatureWriter transformer also provides the name of the dataset as an attribute.
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Web-Based Datasets
There can be no doubt of the trend towards storing data in the cloud, including spatial data. For that reason, FME has
comprehensive tools for reading datasets that are web-based.

Simple URL Selection
The easiest way to read a web-based dataset is to simply paste the URL into the source dataset parameter.

Here the workspace author is adding a reader to read a MapInfo TAB dataset directly from an open data catalogue stored on
Amazon S3.

FME Lizard says…
A folder-based dataset must be compressed to a single zip file for FME to read it from the web like this;
the above is a perfect illustration of that requirement. Datasets can be read from non-zipped datasets, but
only when the dataset consists of a single file (such as an AutoCAD DWG file).

The URL entered into a source dataset field may refer to any resource on a web-based file storage system. For example, here a
user is reading the same MapInfo TAB dataset directly from a Dropbox link:
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The key is to force the web service to provide a direct link to the file, rather than to their own web interface. For example, to cause
Dropbox to render data, you should set the dl query parameter to 1 in the URL, as in the above screenshot, instead of the default
value of 0 (zero).
However, there are better ways to read data from a web service...

FME Lizard says…
If data is read from a website data needing authentication, most readers have parameters to enter such
information:

Web Services
Besides being able to read from a URL, FME can also directly access certain web services to read data. Direct access to a web
service is achieved with functionality inside FME called Web Connections.
Web Connections are created by selecting Tools > FME Options > Web Connections on the FME Workbench menubar and
clicking the plus button in the Web Connections dialog:

.1 UPDATE
Each new release of FME usually introduces new web service support, and 2019.1 is no exception. Added
to the above list are:

• Apache Kafka

• Google Cloud Storage

• Trello

Also be sure to look for new or updated web services on the FME Hub.
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There are a large number of web services to which a connection can be made - and the Manage Services button allows you to
integrate any other web service you require - but the key ones are:
• Amazon S3

• FME Server

• Autodesk A360

• Google Drive

• Box

• HDSF

• Dropbox

• Microsoft OneDrive

These are key types because they are capable of storing data in a way that can be accessed directly from the Add Reader dialogs:

In the above screenshot, an author is adding a MapInfo dataset from Amazon S3. This action opens a dialog in which they can
browse Amazon S3 for the required file:

The reader is then added to the workspace and functions just as any other.
Note that if you wish to use a FeatureReader transformer instead of a reader, then the same "Select File From Web" option is
available.

WARNING
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Usually there is an authentication step that needs to be carried out when adding a new web service
connection into FME, and if the workspace is published to FME Server or simply copied to another FME
Desktop installation, then the same authentication needs to be carried out in (or copied to) the new
location.

Connector Transformers
Besides being able to direct a reader to a web service, various transformers exist that can read files. These are similar to the list
supported by readers:
• AzureBlobStorageConnector

• DropboxConnector

• ProjectWiseWSGConnector

• AzureFileStorageConnector

• FMEServerResourceConnector

• S3Connector

• AutodeskA360Connector

• GoogleDriveConnector

• SalesForceConnector

• BoxConnector

• HDFSConnector

• SlackConnector

• CesiumIonConnector

• OneDriveConnector

These transformers don't read data in the traditional FME sense. Instead, they copy a selected file and either add its contents to an
attribute or download the file to the local filesystem.
Here, for example, an author is using a Creator transformer to trigger the reading of a file from Google Drive:

The contents of the file have been added to an attribute that can then be processed as required. For example, maybe it is a snippet
of XML that can be decoded with an XML transformer.

TIP
Connector transformers can also upload a file, list the contents of a web service, and delete files from that
service.

Given the "Select File From Web" tool on readers, Connector transformers are not generally intended for reading source data;
although they could be used to download a file that is subsequently read using a FeatureReader.
Another use would be to retrieve a list of files that are then read directly using a FeatureReader.
However, perhaps the more likely use is to transfer written data to the web. Writers don't have an equivalent "Select File From
Web" option, so the best alternative is to write data with a FeatureWriter transformer and then use a Connector transformer to
transfer that data to a web service of choice.
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Exercise 1

Snowfall Project: Web-Based Datasets

Data

Roads (AutoCAD DWG)
Snowfall (Microsoft Excel)

Overall Goal

Join snowfall data to roads and upload to an FME Server resources folder

Demonstrates

Reading and writing data via web services

Start Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex1-Complete.fmw

In this exercise we're joining snowfall data to a set of road features, and writing the results to an FME Server Resource folder, for
other users to access. So we'll create a workspace that does a join to an online dataset, processes the data, and writes it back out to
a different web destination.

1) Add Reader
Start FME Workbench and in an empty workspace add a reader with these parameters:
Reader Format

Autodesk AutoCAD DWG/DXF

Reader Dataset

C:\FMEData2019\Data\Transportation\CompleteRoads.dwg

Parameters

Group Entities By: Attribute Schema

Workflow Options

Single Merged Feature Type

The Group Entities parameter is an AutoCAD-specific option. It ensures that we have attributes from the AutoCAD source data
exposed in Workbench.
The Merged Feature Type option means all the road data is treated as a single map layer, which is fine because we aren't too
interested in handling multiple layers separately.

2) Locate Snowfall Dataset
In a web browser, browse to the City of Interopolis Open Data Portal
(https://s3.amazonaws.com/FMEData/Interopolis/interopolis.html).
Locate the dataset for Snowfall Predictions, right-click on where it says Excel Spreadsheet, and choose to copy the URL:
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The exact command will vary according to web browser of choice.

3) Add DatabaseJoiner Transformer
Back in FME Workbench, add a DatabaseJoiner transformer and connect it to the roads feature type. Open the DatabaseJoiner
parameters.
Set the parameters as follows:
Reader Format

Microsoft Excel

Reader Dataset

https://s3.amazonaws.com/FMEData/Interopolis/Snowfall.xlsx

...where, of course, you can paste the URL you copied from the web browser.
Click the parameters button and check that the data is being read correctly. Proof of this is the preview window showing records
with the correct columns.
Back in the main DatabaseJoiner dialog, select Snowfall as the join table and select StreetId as both the Feature Attribute and
Table Field to be joined:
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TIP
If no attributes are available under the Feature Attribute field, then you failed to use the Group Entities
By: Attribute Schema parameter when adding the AutoCAD reader. To resolve this the simplest method is
to delete and re-add the reader, using the correct options this time.

The final parameters to set in the DatabaseJoiner are Fields to Add and Cardinality:

Select the following for Fields to Add:
EstimatedSnowfall
LastTreated
Temperature
WeatherStation
Ensure Cardinality is set to Match First (1:0...1+); then each road feature will be joined to the first matching database record
FME finds. It's the option least likely to lead to error messages in the log.

4) Add KMLStyler Transformer (Optional)
The goal of the project is to write the data to KML format. As a training exercise, we're really only interested in how and where
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we write the data. However, a realistic requirement would be to set the color and style of the spatial data being written (in spatial
terms we sometimes call this symbology).
So, as an optional step, place a KMLStyler transformer, connected to the DatabaseJoiner. Open the parameters dialog and set it up
to give the roadwork features a specific style.
Here the author has used Conditional Values (discussed in chapter one) to illustrate the roads differently according to the amount
of expected snowfall:

However, you can choose to select a fixed color, copy the transformer from the completed workspace, or even ignore this step
completely.

5) Add FeatureWriter Transformer
Now it's time to write the data. It's not as simple to write data directly to a web service, so what we'll do is write it to a zipped,
file-based dataset, and then upload that dataset to a web service.
So, add a FeatureWriter transformer and connect it to the KMLStyler transformer (if you added one) or the DatabaseJoiner
transformer (if you didn't).
Open the parameters and set the writer up as follows:
Writer Format

Google KML

Writer Dataset

C:\FMEData2019\Output\Training\RoadSnowfall.kml

Then click on the dropdown arrow to the right of the Dataset parameter, and choose the option to Zip Output
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This will make the transformer write data directly to a zipped (compressed/archived) file.
As a final step in this transformer, rename the output feature type to SnowfallPredictions:

Now when the workspace is run, a dataset will be written. The FeatureWriter will create an attribute called _dataset to record the
name and path of the dataset. The next step is to upload this file to a web service...

TIP
You can copy the data to any web service to which you have access, you just need to use the appropriate
connector transformer. For example, use the DropboxConnector to copy data to Dropbox, or the
GoogleDriveConnector to copy it to Google Drive.
The rest of this exercise will use FME Server and the FMEServerResourceConnector, using connection
settings that assume FME Server is installed on the same system as FME Desktop, which would be the
case if you are using one of Safe Software's virtual training computers.

6) Add FMEServerResourceConnector Transformer
Add a FMEServerResourceConnector transformer and connect it to the FeatureWriter:Summary output port. The workspace
should now look like this:
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In the parameters dialog ensure that the FME Server Action is set to Upload. For the FME Server Account open the drop-down
menu and click Add Web Connection:

In the FME Server Connection Dialog change the Connection Name, if desired. Then set following parameters and click
Authenticate:
Server URL: http://localhost
Username: author
Password: author

WARNING
When using a Safe Software virtual machine you may get an authentication error:
Retrieval Error : Unable to make the request to FME Server. Ensure your machine
has internet connectivity

In this scenario we recommend restarting your virtual machine. Save your workspace and exit FME
Workbench. Click the Start Button > Power > Restart. The machine will take a minute or two to restart,
and your issue should be resolved. If not, please use the GoToWebinar Questions panel to ask for help or
email train@safe.com.

Ensure the Source Upload parameter is set to File. For File to Upload parameter, click the drop-down icon and select Attribute
Value > _dataset:
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Finally for the FME Server Destination click on the ellipsis next to Folder ID. This will connect to your FME Server Resources
folder. Click on the Data folder to select it and click OK:

The parameter is now set to upload to the FME_SHAREDRESOURCE_DATA/filesys folder. That was the final part of the
FMEServerResourceConnector set up, so click OK to close its parameters dialog.

7) Run Translation
Save the workspace and then run it.
Oops! There are a lot of errors message. The key one is:
FileNotFoundError: [Errno 2] No such file or directory:
'C:\\FMEData2019\\Output\\Training\\RoadSnowfall.zip\\RoadSnowfall.kml'

The problem is that the path only needs to point to the zip file, not the file within it. Let's fix that.
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Add a StringReplacer transformer between the FeatureWriter and FMEServerResourceConnector transformers. Set it up with the
following parameters:
Attributes: _dataset Mode: Replace Regular Expression Text to Replace:

\\[^\\]*$

Leave the Replacement Text field empty. That regular expression will look for the final \ character in the string, and replace
everything after it with the replacement text (which is nothing):

Now when we run our translation the data will write to our local disk but also upload the output file onto FME Server where any
of our colleagues can download it.
Run the translation.

8) Test Upload
Check the results of the translation in the Visual Preview window (or Data Inspector). The output of the
FMEServerResourceConnector will be a single feature with an attribute storing a link to the data on Server.
Copy the contents of the _direct_download_link attribute to the system clipboard. Paste the copied link into the address bar of a
web browser and press the return key.
The uploaded file will be downloaded from FME Server. If prompted for connection parameters, use the username and password
you entered into the FME Server connection.

TIP
An alternative method of testing the result would be to create a second workspace. Place a Creator and
FMEServerResourceConnector combination and - this time - set the Server Action Download. Click the
ellipsis next to FME Server Source Object ID to open a file browser and then browse to the Data folder to
locate the SnowfallPredictions KML dataset.

CONGRATULATIONS
By completing this exercise you have learned how to:
Carry out a data join with a web-based dataset
Write data to a compressed output using the FeatureWriter transformer
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Set up a web connection
Use a regular expression in a StringReplacer transformer
Upload data to FME Server (or another online service)
Download data from FME Server (or another online service)
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Fanouts
Fanouts are one of the most powerful pieces of functionality within FME, capable of producing impressive results with minimal
effort.

What is a Fanout?
A fanout is a tool applied to a writer or writer feature type in FME. They are a way for the workspace author to write data divided
into groups of features.
Groups are defined by either the value of a single attribute or a string constructed from a combination of attributes and fixed
strings. They can be written to separate feature types, or completely separate datasets.
Here an author is “fanning-out” a set of data into multiple outputs depending on a feature’s elevation attribute:

Because a fanout occurs as the data is written, it does not require multiple flows of data inside the workspace. Therefore this
technique makes it easy to create groups with minimal impact on the workspace canvas.
Another significant benefit of a fanout is the high degree of flexibility – and freedom from fixed-layer schemas – in return for
minimal effort.
There are two types of fanout: Feature Type Fanout and Dataset Fanout.
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Feature Type Fanout
A Feature Type Fanout delivers data to multiple feature types (layers/tables) within a single dataset. Taking the elevation example,
here the output is a different feature type for each elevation value:

The result of this fanout is a DXF dataset containing multiple layers of data.

Setting a Feature Type Fanout
A feature type fanout is not a specific setting. Instead it is defined by selecting an attribute for a writer feature type name, like so:

The Feature Type Name then changes to match what is selected:
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In this case, each park record with a different neighborhood gets written to a different sheet of the Excel output spreadsheet. The
Excel file will have a sheet named Downtown, a sheet named Kitsilano, and so on.
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Dataset Fanout
A Dataset Fanout delivers data to the same feature type, but in multiple datasets. Using the elevation example again, here the
output is a different dataset for each elevation value:

The result of this fanout is a series of DXF datasets, each of which has one elevation’s worth of contours on one layer.

Setting a Dataset Fanout
A Dataset Fanout is defined in the Navigator window in Workbench, just below the writer’s dataset parameter:

Double-clicking the Fanout Dataset parameter opens a dialog in which a Fanout checkbox is set. Here you can define the folder to
write to and the Fanout Expression to use. The default values set the Fanout Directory from the destination dataset path, and the
Fanout Expression from the destination dataset file name:
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To achieve a fanout (a different file per attribute value) select an attribute to include in the file name, such as this:

In this case, each different neighborhood produces a separate file of park features.
It's important to note that the Text Editor dialog can be used to add different components to both the Fanout Directory and the
Fanout Expression, including user parameters, functions, and datetimes. Generally, even if the requirement is to use an attribute to
define a sub-folder, it would go into the Fanout Expression, rather than the Fanout Directory.

Combining Dataset Fanout and Zip Files
It's easily possible to both apply a fanout to a writer and zip (compress/archive) the files that are written. In fact there are several
methods of doing so...

Fanout to a Single Zip File
By setting the Destination Fanout Directory as a zip file, it's possible to write multiple, fanned-out datasets, to a single zip file:
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Here the user is fanning out to Shapefile based on the NeighborhoodName attribute. The output directory is set to a zip file
meaning the output is a single zip file with multiple datasets. Because this is Shapefile format, each dataset is a folder containing a
number of files (.shp, .shx, and so on).

Fanout to Multiple Zip Files
By setting the Fanout Expression with a zip file extension, it's possible to write multiple, fanned-out zip files, each containing a
single dataset.
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Here the user is also fanning out to Shapefile based on the NeighborhoodName attribute. The output directory is set to a plain
directory, but the Fanout Expression is given a zip file extension. This leads to multiple zip files, one per dataset.
This sort of fanout is potentially useful when the output format includes multiple files (like Shapefile format) and you wish to
handle the output some way, post-translation. It's also useful for large datasets (such as raster) where a single file can be way
larger than its zipped equivalent.

Fanout to Multiple Zip Files inside a Single Zip File
By using both of the above techniques (in other words giving both the directory and the fanout parameters a zip file extension)
you are able to write multiple zip files containing a single dataset, into a single zip file!

Here the output is a single zip file (Training.zip) containing a series of zipped dataset files!

FME Lizard asks…
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Q) Fanouts are an important part of writing data with FME, so tell me, which of these statements are
true? Pick as many of these answers as you think are correct:
You can have both a Feature Type Fanout and a Dataset Fanout in the same workspace
You can use a Feature Type Fanout with a database format, but not a Dataset Fanout
A fanout expression can be an attribute, or a constructed string, but not a user parameter
A fanout cannot be based on a format attribute such as fme_color
A) It's true you can have both types of fanout in the same workspace, although a database writer won't do
a Dataset Fanout (it can create multiple tables, but not multiple databases). A Fanout Expression can be
any attribute (including FME attribute or format attribute) or string, and it can be a user parameter too!
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The Generic Reader/Writer
The Generic Reader and Generic Writer allow FME workspaces to be freed from format restrictions.
Where all other readers and writers are tied to a specific format of data, the Generic Reader and Generic Writer are not. The
Generic Reader is capable of reading almost any format of data, and the Generic Writer is capable of writing almost any format of
data.
In that way, a single workspace can be used to process different data formats without being specifically set up for that format.

The Generic Reader
A Generic Reader is used in the same way as any other reader; by specifying the format in the Add Reader or Generate Workspace
dialogs, or in Quick Add:

This source dataset is an AutoCAD DWG dataset, but FME does not know that yet. When the workspace is run FME examines
the extension of the file chosen to determine this for itself.
At a later time the end-user might then choose a different file - in a completely different format - to be read, like so:

Again, at runtime FME examines the file extension to identify the format of data and then - having discovered it is MicroStation
DGN - reads it just as if it were a true DGN reader.
That way a single reader can be made to read any format of data.

FME Lizard says…
You're thinking there must be a catch, right? Well, it's true. Firstly this technique only works with filebased formats (it won't work on a database or web format). Secondly, the Generic Reader is not immune
from the Unexpected Input Remover, so switching datasets - regardless of format - only works with a
compatible schema (see below).
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Generic Reader Feature Types
The Unexpected Input Remover is the function in FME that filters incoming data against the list of permitted feature types. If the
incoming data is not defined in the workspace, then it is dropped from the translation.
In the previous example, traffic signals in the AutoCAD dataset were stored on a layer called "TrafficSignals", and the workspace
names the reader feature type so. But, if the MicroStation file stored data on a different layer, then this would be the result:

All 778 records were dropped from the translation. So, although the Generic Reader allows you to read datasets of different
formats, the limitation is that each dataset must have its layers defined as feature types in the workspace.
Of course, an easy way to allow all layers to pass is to set a Merge Feature Type in the Feature Type Properties:

With that setup, any layer of data can be passed into the workspace, regardless of format. Of course, even then you need to be
careful about assuming what attributes will be available!

The Generic Writer
A Generic Writer is used in the same way as any other writer; by specifying the format in the Add Reader (or Generate
Workspace) dialog:

There the destination dataset is specified as a folder. FME does not know the format to be written yet and so will not know
whether it is file-based or folder-based.
The format required to be written can be specified by the author through a parameter when the writer is added:
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Output format can also be set by the author in the Navigator window, or the end-user can specify it at runtime using an
automatically created user parameter:

That way a single writer can be made to write any format of data, the format being chosen by the end-user at runtime.

FME Lizard says…
Generic Readers and Writers by nature only deal with a flexible format, but can also be set up to be
flexible with layers using a Merge Filter or Fanout.
However, each dataset being read must have the same attribute schema. Additionally, each dataset written
receives an identical attribute schema. This part is not flexible.
Flexible attribute schemas require the use of either Automatic Attribute Definitions or a Dynamic
Translation.
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Exercise 2

Community Mapping Data Translation Project

Data

Community Mapping (Esri File Geodatabase)

Overall Goal

Create a workspace to translate Community Mapping data to a format of the end-user's choice and
zip it

Demonstrates

Generic Writer, fanout and writing zip files

Start
Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex2-Complete.fmw

As resident FME expert you are often asked to translate data (particularly the community map) between formats. You realize that
it would be much simpler if you created a workspace to do this - regardless of format - and let the end-users carry out the
translation themselves. In the future, this would make an excellent use for an FME Server Data Download service, but for now,
we'll let the users simply run the workspace in FME Workbench.

1) Start Workbench
Start FME Workbench and begin with an empty canvas. Select Readers > Add Reader from the menubar and add the following:
Reader Format

Esri Geodatabase (File Geodb Open API)

Reader Dataset

C:\FMEData2019\Data\CommunityMapping\CommunityMap.gdb

Workflow Options

Single Merged Feature Type

By selecting the single merged feature type option we will have a workspace that is nice and compact, plus it will allow the user to
select which tables they want to read from the source.
Click OK to close the dialog and add the reader.

2) Add Writer
Select Writers > Add Writer from the menubar and add a Generic Writer:
Writer Format

Generic (Any Format)

Writer Dataset

None

Writer Parameters

Output Format: Esri Shapefile

Add Feature Types

Feature Type Definition: Automatic

You don’t have to select an output location, but will you have to open the parameters dialog and set an original output format; so
do that and select a format like Esri Shapefile.
In the "Add Feature Types" section of the dialog, select Automatic for feature type definitions:
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Click OK, and the Feature Type Properties dialog for the new writer will open automatically. Set the Geometry field to fme_any.
This will allow any data to be written to this feature type:

Click OK to close the dialog and to add the new feature type. Connect it to the source feature type. When you make the
connection the attribute schema will automatically be updated to match the connected reader feature type:
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3) Check User Parameters
Look in the Navigator window at the user parameters that were created automatically with the reader and writer:

The parameter for SourceDataset_FILEGDB is something we won’t ever need (this translation will always use the same dataset)
so delete it.
Another automatically created parameter is called Feature Types to Read. This is very useful because when the user runs the
workspace, they will be prompted to select which tables to read from the source Geodatabase; so keep this parameter.
Similarly, keep the Destination Dataset parameter.
The Output Format parameter is interesting. Double-click on it as if you were going to set a value. Notice that the "More
Formats..." option in the drop-down list opens up the full FME formats list:

It wouldn’t be fair to the end-user to expose so many formats when they don’t really need to see or select most of them. It would
be better to restrict this list. So, delete this user parameter, and we’ll create a new - more restrictive - one.

4) Add User Parameter
Add a new User Parameter by right-clicking on User Parameters and selecting Create User Parameter.
In the dialog that opens set the following:
Type

Choice with Alias

Name

OutputFormat

Published

Yes (checked)

Optional

No (unchecked)

Prompt

Select Output Format:

For the configuration field, click the browse button to open a new dialog. In that dialog, select Import > Writer Formats. Select a
handful of the most common spatial formats such as Esri Shapefile, AutoCAD DWG, GML, and MapInfo TAB; then click OK.
Then click OK twice more until all the dialogs are closed.

5) Link Parameter
Now, in the Navigator window, expand the parameters for the Generic Writer. Locate the Output Format parameter. Right-click it
and choose Link to User Parameter.
Select the newly created OutputFormat parameter and click OK:
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Now when the workspace is run, the choice of output format will be among these few:

6) Set Fanout using a Format Attribute
The other, final, task we can do here is to output the features to their original table. To do this we need to know where they came
from, and that is obtained from a format attribute called fme_feature_type.
Inspect the properties for the writer feature type. Set a fanout by choosing fme_feature_type as the attribute supplying the feature
type name.

7) Save and Run Workspace
Save the workspace and then run it with the prompt option set. When prompted, select some source tables to read (include at least
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the GarbageSchedule plus one other).
Then for Destination Generic (Any Format) Folder, we will create a zipped folder to contain all of our files. Set the location of an
output folder (such as C:\FMEData2019\Output\Training) then at the end type:
\CommunityMapping.zip

This will create a zipped file called CommunityMapping.
Finally, set Esri Shapefile as the format to write:

Click the Run button to run the translation. Examine the output folder. A zipped folder has been created which contains all the
selected tables that have been written back to Shapefile format:

Now you have a solution that almost anyone will be able to open and run for themselves. Also, if you published the workspace to
FME Server it would automatically create a web page that matched the different user parameters.

FME Lizard says…
Did you notice that FME handled the different geometry types and output the files with the geometry as
part of the name? It’s a Shapefile format thing. FME can never – and will never – write more than one
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geometry type to the same Shapefile .shp file.
The one drawback with the output is that each Shapefile has all of the attributes of all of the source tables.
To avoid that you would need to use a dynamic translation, as we shall see shortly...

CONGRATULATIONS
By completing this exercise you have learned how to:
Add a Generic Writer to a workspace
Set the initial format of a Generic Writer
Create a Choice with Alias parameter that prompts for a writer format
Use a Choice with Alias parameter for the Generic Writer output format
Use a feature type fanout on fme_feature_type to return features to their original layer
Use a .zip extension to create zipped output datasets

163

Dynamic Translations

Dynamic Translations
Dynamic Translations are a way to create "schema-less" workspaces.

What are Dynamic Translations?
Most translations - and everything this training has covered so far - involve a schema defined within the workspace. In other
words, the source and destination schema reflect the structure of the source data (what we have) and the structure of the
destination data the user requires (what we want).
The layout of a dynamic translation does not reflect either the source or destination schema. It’s a universal layout that is designed
to handle data regardless of the schema used by the source data.

FME Lizard says…
For this section, it’s useful to think of a schema as comprised of a trio of objects: feature types, attributes,
and geometry type.

Dynamic Readers
On the reader side of things, a dynamic workspace is very similar to using Merge Parameters; feature types are given free entry to
a workspace, regardless of whether they are yet defined in there.
Data is also read regardless of attributes or geometry type.

Dynamic Writers
The writer side of a dynamic workspace mimics the reader part; feature types are written to the destination dataset, regardless of
whether they are defined in the workspace.
Additionally, all attributes and geometries get written, regardless of whether they too have been predefined in a writer feature
type.
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Generic vs Dynamic
It's important to understand the differences between generic and dynamic translations, and when to use each of these tools. This
table is quite useful as a reference guide:
I know the format

I don't know the format

I know the feature types

Static

Generic + Static

I know the attributes

I don't know the feature types

Fanout

Generic + Fanout

I know the attributes

I know the feature types

Dynamic

Generic + Dynamic

I don't know the attributes

I don't know the feature types

Dynamic

Generic + Dynamic

I don't know the attributes

For example, let's assume you operate a data upload web site. The data will be in a known structure (feature types) and with
known attributes. However, you don't know what format it will be. That needs a static schema (because that part is known) but
with a generic reader.
If, on the other hand, the format is always the same, but the attributes are unknown, that will require a dynamic translation.

FME Lizard asks…
Q) Let's see if you understand the concepts. Pick out as many of these statements as you think are true:
A dynamic workspace will read/write any format of data
A dynamic workspace will read/write any feature types in the source data
A dynamic workspace will read/write any attributes in the source data
A dynamic workspace will read/write any geometry in the source data
A) Feature Types, Attributes, and Geometry are the three schema parts handled by dynamic workspaces.
Format is not handled. This is the role of the Generic Reader/Writer. A workspace may be generic, or
dynamic, or both, or neither!
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Creating a Dynamic Translation
When an author creates a translation using the Generate Workspace dialog, there are two options for what is called workflow:
Static Schema and Dynamic Schema.

The Static Schema option is the default for a workspace including schema. Choosing the Dynamic Schema option creates a
schema-less workspace with dynamic readers and writers.
It is, however, possible to also create a workspace where only the readers are dynamic or only the writers...

Dynamic Reader Only
The Add Reader dialog has similar options for static and dynamic; however, in this case, we try to make them more user-friendly
by labeling them Individual Feature Types and Single Merged Feature Type:

In essence, a dynamic reader is similar to just setting the Merge Feature Type option.

Dynamic Writer Only
The Add Writer dialog has options for how feature types and their attributes are defined. The most commonly used ones are
Manual and Automatic. There is also an option that adds a writer in dynamic mode:
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FME Lizard says…
Let's clarify Automatic vs. Dynamic. Automatic attributes take their definition from whatever is connected
to them. If the Source Dataset parameter is changed, that change has no effect.
Dynamic attributes are different. If the Source Dataset parameter is changed, the attribute definition
comes from whatever source data gets read, regardless of what is connected to it.

How Does a Dynamic Translation Look?
Both dynamic readers and dynamic writers each have a single Feature Type, regardless of the schema of the reader datasets:

Notice that there is only a single feature type, regardless of whether the data is made up of several layers or tables.
Also, notice that the sole reader Feature Type is named <All> (which provides a clue to what is happening here) and that the sole
writer Feature Type is named <Dynamic>.
When the workspace is run, all of the source data is read through a single feature type. On the writer side, although there is only
one output type, the data will be dynamically divided back into its component layers, keeping its original attributes and geometry
type.
With this workspace, you can switch the source dataset to anything (in the correct format) and the output is a mirror image. There
is no need to worry about unexpected input or unsupported geometry types. Plus, if you used the Generic Reader/Writer, it could
read any dataset, of any format and create a duplicate output of it!
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Exercise 3

Dynamic Community Mapping Data Translations

Data

Community Mapping (Esri File Geodatabase)
Addresses (Esri File Geodatabase)

Overall Goal

Create a dynamic workspace to translate any Geodatabase dataset to a format of the end-user's
choice

Demonstrates

Dynamic Formats

Start
Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex3-Complete.fmw

In the previous exercise, a workspace was generated to translate a Geodatabase dataset into a number of formats using the Generic
Writer.
However, that workspace had a limitation with the output attributes (every output dataset got all of the source table attributes), and
you also feel it would be useful if that workspace could handle any source Geodatabase, not just the community maps dataset.
So, let’s create a new workspace to handle that scenario.

1) Start Workbench
Start FME Workbench and begin by generating a workspace as follows:
Reader Format

Esri Geodatabase (File Geodb Open API)

Reader Dataset

C:\FMEData2019\Data\CommunityMapping\CommunityMap.gdb

Writer Format

Generic (Any Format)

Writer Dataset

C:\FMEData2019\Output\Training

Writer Parameters

Output Format: Esri Shapefile

Workflow Options

Dynamic Schema

The dynamic schema parameter is important in order to handle all aspects of the source schema for a variety of datasets.

2) Inspect Workspace
Inspect the newly created workspace:

There is one reader feature type and one writer feature type. The reader feature type shows a list of attributes, but the writer
feature type doesn’t. It is, however, labeled <Dynamic>.
Again, there will be a user parameter for the Feature Types to Read and the output format.
If you wish, create a more-limited version of the output format parameter, by following steps 3-5 in the previous exercise;
although this isn’t totally necessary for what we’re doing here.
But don’t delete the Source Dataset user parameter; we’ll need that shortly.
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3) Run Workspace
Run the workspace with the prompt option set.
When prompted, select some source tables and set the output format. The workspace will run to completion. Check the output to
ensure it is all correct.

4) Re-Run Workspace
Now rerun the workspace.
Be sure to use the option to Rerun Entire Workspace (Shift+F5):

...otherwise cached data would be used in preference to the actual source data, which is not what we want.

TIP
Choosing Run Workspace (F5) would be characterized by the lack of source (File Geodatabase)
parameter in the Translation Parameter Values dialog. So if the source parameter is missing from the
prompts, you likely chose Run Workspace instead of Rerun Entire Workspace.

So, when prompted click the browse button for the source Geodatabase and browse to
C:\FMEData2019\Data\Addresses\Addresses.gdb
Choose the feature types to read and this time you will be presented with a list of feature types from the newly selected
Geodatabase. Select one or both of them.
Click Run to rerun the workspace. Inspect the output. Notice that the output feature types are all as listed in the original data.
Also, notice that the attributes are as in the original too!
From this, we can see that a dynamic workspace is capable of handling any source schema and writing it out to a new dataset just
as it was in the source data.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a dynamic workspace
Use the Generic Reader in a dynamic workspace
Choose between Run Workspace and Rerun Entire Workspace
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Schema Handling in Dynamic Translations
Checking the feature type properties for a dynamic translation reveals the checkboxes that turn on this behavior.
For a reader, all that is really happening is the merge feature-type setting is turned on:

Unchecking that box turns off the full behavior, and there are not many parameters to adjust. However, for a writer, the dialog is a
bit more complex:

The three components of schema - 1) feature type, 2) attributes, and 3) geometry - all have different ways in which they can be
set.
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Dynamic Feature Types
There are three main components of a schema:
Feature Type
Attributes
Geometry
This section looks at Feature Types, and how a workspace author can change the feature types that are written in a dynamic
translation.

Defining Feature Type Names
In static writer feature types, the feature type name is usually a fixed value. However, it can also be defined by an attribute (or
string constructed from attributes). We call that a Fanout.
In a dynamic translation, a fanout is set automatically. By default an FME attribute called fme_feature_type is used as the feature
type name:

fme_feature_type is an FME attribute that stores the name of the original feature type on incoming features. It makes sense to
default to this attribute because then all data is written to the same feature type as it came from, and we get an output that is a
duplicate of the input.
However, should you wish, there's no reason why a different attribute couldn't be used, in order to define a different set of output
feature types:

Here, for example, the author is using NeighborhoodName to supply the name of the layers to create. For example, features might
have the value Downtown, West End, or Fairview.
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At runtime, FME looks in each of the Schema Sources to find a table called Downtown. It will use the schema of that table to
define the attributes and geometry allowed in the dynamic writer's output.

Schema Requirements
Of course, be aware that this isn't exactly the same thing as a fanout. A fanout creates layers from a static definition. A dynamic
workspace fetches that definition from somewhere else (the schema source).
Therefore, the feature type names chosen must match a layer that exists in that source schema.
Failure to do so will lead to the data being dropped - instead of written - with a log message reporting the problem. For example, if
the NeighborhoodName attribute had values (like "Downtown" or "Kitsilano") that didn't exist as a table in the schema source,
there would be log messages like this:
___________________________________________________________________________
FileGDB Writer: A feature with feature type `Downtown' could not be written
___________________________________________________________________________
___________________________________________________________________________
FileGDB Writer: A feature with feature type `Kitsilano' could not be written
___________________________________________________________________________

What the author must ensure is that the schema used actually contains these layers. Then the translation will proceed as expected.
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Schema Sources
By default, the writer schema in a dynamic translation is defined not in the workspace, but by the source dataset. So whatever
dataset is chosen as input defines the chosen output structure.
However, the parameters in a writer feature type let us alter how that schema is defined. We can choose to take the structure from
an entirely different dataset to the source. Alternatively, we can individually define each component of our schema (Feature Types,
Attributes, Geometry) in a variety of ways.
The writer feature type has a dynamic parameter labeled Schema Sources:

This parameter defines from where the destination schema is going to be obtained. By default, this parameter is set to whatever
source dataset is being read. That way the output schema is always a duplicate of the input.
However, it can be set to use any reader dataset – in any format – as the source for the outgoing schema.

For example, here the workspace author is converting parks data to an Esri Geodatabase, but has chosen an Excel spreadsheet as
the required structure for the output dataset.
If the data is fanned out (say by NeighborhoodName) then the Excel spreadsheet should have a different sheet for each
neighborhood, and that structure is used as the schema of the output in this workspace.

FME Lizard says…
Let me make it clear if it isn't already. In this scenario the user is not writing to those Excel sheets; the
user is writing to a File Geodatabase. However, the output Geodatabase receives the same schema
(structure) as the matching Excel sheets.
It's called “Dynamic” because the destination schema gets fetched at runtime. For example, if the Excel
sheets were to change in structure and the workspace ran a second time, it will produce Geodatabase
feature types to match the changes. The best part is that the workspace does not need updating to do so.
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Resource Readers
The Schema Source parameter can be set to point to any reader as the source of a dynamic schema. However, in most cases, all we
need from the dataset is the schema, not the data.
This is where Resource Readers can be used.
A Resource Reader is a reader that returns the schema of a dataset, but no data. One is added using Readers > Add Reader as
Resource on the menubar:

Here the user adds an Excel spreadsheet database as a resource, and it appears in the Navigator window:

Once available the resource reader can be used as the source of a schema for a dynamic writer.

Why Use an External Schema?
The main reason for using an external dataset schema is to adhere to a fixed standard. Perhaps the most useful aspect of this is that
if the schema of the dataset changes, then the workspace makes use of it automatically. There's no need to update the workspace
manually because the output requirements have changed.
However, as noted above, the data being written must match that standard or risk being dropped. So there is always likely to be
some data transformation required in the workspace to coax the input data into the required output schema.
The SchemaMapper transformer is useful for reconciling data with the required schema - that's because the SchemaMapper too
can use an external lookup table, meaning that the dynamic workspace can be changed to meet any required output schema
without having to make edits in Workbench!
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WARNING
Geometry is discussed shortly. However, for now be aware that permitted geometry types are (by default)
obtained from the schema source. If the schema source changes, you may not want its geometry type.
Therefore simply set Geometry to "First Feature Defines Geometry Type" to avoid issues.
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Dynamic Attributes
As we know, there are three main components of a schema:
Feature Type
Attributes
Geometry
This section looks at Attributes, and how a workspace author can change the attributes that are written in a dynamic translation.

Defining Attribute Names
This is probably the most complex part of dynamic translations, so let's take the explanation step by step, going back over some
old ground where necessary.
As we've seen, in a dynamic translation each incoming feature has an attribute (either fme_feature_type or another attribute) that
specifies to which feature type the data is to be written.
The Schema Sources parameter defines where those feature types exist and uses them also to define the attributes and geometry
types that are written to the output.

Here, for example, we have a set of parks data being written to Esri Geodatabase. Notice the output feature type (table) name is set
to the NeighborhoodName attribute.
The schema is obtained from an Excel spreadsheet, added as a Resource Reader. If, for a particular feature, NeighborhoodName =
"Strathcona" then the writer looks for a sheet in the Excel spreadsheet file called Strathcona, and writes the feature using the same
attributes as that table.
However... underneath the Schema Source parameter in this dialog is a setting for Schema Definition Name. The Schema
Definition Name overrides attribute definitions:
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Here, for example, the user still specifies NeighborhoodName to provide the feature type to be written, but overrides the attributes
by saying they have to come from a table called Parks.
What's interesting is that the feature type specified by NeighborhoodName no longer needs to exist; i.e. the "Strathcona" sheet
does not have to exist to get a "Strathcona" feature type in the output Geodatabase. It is enough that the Parks sheet does exist.

FME Lizard says…
In the above example, the Schema Definition Name was a fixed value; i.e. all output feature types got the
same attribute definitions. However, the Schema Definition Name can also come from an attribute;
meaning one attribute defines the feature type name, and another attribute defines a feature type from
which the attribute schema is to come!

Adding or Deleting Attributes
Besides specifying which set of attributes to use, sometimes - even in a dynamic translation - you need to add or delete specific
attributes. This is very simple to do.
Adding a New Attribute
Adding a new attribute to all output on a dynamic feature type is just a case of editing the feature type definition to add that
attribute:

In other words, any attribute you add to the feature type definition gets added to all features output through there – regardless of
source or resource schemas.
For example, above the user adds an attribute to store the result of an AreaCalculator transformer in the workspace.
Deleting an Attribute
Deleting an existing attribute is done through the dynamic Schema Definition dialog. At the foot of that dialog is a field for
removing attributes:
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The edit [...] button opens a dialog in which to select or manually enter attributes that are in the source schema but that you don’t
want in the output:

Here the user manually enters Country (an attribute from the external schema) to remove it from the output. They also select
RefParkId not to be output.
The result of all of the above changes is as follows:

The feature gets various attributes from the Excel schema (City had to be set manually because the input had no such attribute),
and adds ParkArea on its own account. Country and RefParkId have either been removed or just chosen to not exist in the output
schema.
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Dynamic Geometry
Of the three main components of a schema:
Feature Type
Attributes
Geometry
...the last of these to investigate is Geometry; in particular how a workspace author can decide which geometries are valid for a
particular feature type.

Schema Geometry Definition
The geometry permitted in an output dataset depends on the format used. Some formats allow any geometry - or mix of
geometries - to exist in a feature type.
However, some formats do not allow a mix of geometries in a single feature type, and that can cause problems.
For example, a standard (static) Geodatabase writer feature type allows you to pick the geometry allowed in that file:

In a dynamic workspace, this changes. The geometry type can be chosen manually, depending on the first feature, or depending on
the chosen schema definition:

In Schema Definition mode, and when the data being read provides the schema, then the permitted geometry is a duplicate of that
source dataset's schema.
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But when the Schema Source parameter is changed to point to another dataset, then the permitted geometry is defined by that
dataset's schema.
If the geometry of the data to be written is different from that schema, and the destination format does not support multiple
geometry types, then features would be dropped instead of written.

Fixed Geometry Definition
Even in a dynamic translation, the workspace author may set the dynamic schema parameter for permitted geometry back to a
fixed value. For example, the author could choose geodb_polygon (for a Geodatabase) or shape_polygon (for a Shapefile).
This will override the geometry defined by the chosen schema source, so that polygon features (but only polygon features) can be
written.

First Feature Geometry Definition
The other option for defining geometry type is First Feature Defines Geometry Type.

Geometry type can be difficult to handle in a dynamic translation because there is a degree of uncertainty about what geometry
types might be in the source data, and how well they will match up to the geometry types specified in the source schema.
However, this same uncertainty makes it difficult to set a fixed geometry definition.
The First Feature Defines Geometry Type option solves this. When selected, the first feature to arrive at the writer gets to set the
geometry type. That way the author does not need to know in advance what geometry is being processed or what geometry the
schema permits.
For example, if the first feature is a polygon, then the geometry type for that feature type is set to polygon only; subsequent
features destined for the same feature type are refused if they do not have the same polygon geometry.

FME Lizard says…
If you've understood everything so far about dynamic translations, without having to read each section at
least twice, then you are doing very well. This is a very advanced topic, and not everyone understands it
the first time.
To summarize, all of these settings allow us to create an output dataset whose schema is defined not by the
source data, but in multiple other ways.
If you can keep that idea in your head when faced with schema handling beyond the usual static
workspace, you'll know what functionality is required and can look it up in this manual or in the FME
Knowledgebase, and be able to figure out what techniques match your particular need.
Also, remember this key table...
I know the
format

I don't know the
format
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I know the feature types

Static

Generic + Static

I know the attributes

I don't know the feature
types

Fanout

Generic + Fanout

I know the attributes

I know the feature types

Dynamic

Generic + Dynamic

I don't know the
attributes

I don't know the feature
types

Dynamic

Generic + Dynamic

I don't know the
attributes
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Exercise 4

Dynamic Community Map Translation (Schema Handling)

Data

Community Mapping (Esri File Geodatabase)

Overall Goal

Create a workspace to generate a new Community Mapping dataset using an existing schema

Demonstrates

Dynamic Schemas

Start Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex4-Complete.fmw

Previous exercises have involved translating the community mapping dataset, used by the planning department for various
community mapping tasks.
However, as time has moved on, this dataset has become out of date. The planning department, therefore, wants to start building a
new community mapping dataset. The dataset will have new data, but use the existing schema where possible. They also – in
order to use an open standard – want a format change to GML.
At the moment two source datasets have been identified as being required in the new community mapping "database". They are
fire halls (source format: GML) and city parks (source format: MapInfo TAB). There was already parks data in the community
mapping, but this new dataset consists of polygon geometry, not point. The FireHalls data is entirely new for community mapping.
So, let's create a new workspace to generate this new dataset.

1) Start Workbench
Start by generating a workspace as follows:
Reader Format

GML (Geography Markup Language)

Reader Dataset

C:\FMEData2019\Data\Emergency\FireHalls.gml

Writer Format

GML (Geography Markup Language)

Writer Dataset

C:\FMEData2019\Output\Training\NewCommunityMap.gml

Workflow Options

Dynamic Schema

The dynamic option is chosen so that we can use a schema other than that of the dataset being translated.

2) Add Reader
So far, so good. Now let’s add a reader for the new parks data by selecting Readers > Add Reader and using the following details:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2019\Data\Parks\Parks.tab

Workflow Options

Single Merged Feature Type

Connect the new reader feature type up to the existing writer feature type, and add annotation for the reader feature types for
easier recognition:
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Ensure caching is on and run the workspace. This will load up the source dataset caches. Inspect the two source datasets in the
Visual Preview window, to become familiar with them.

3) Add Resource Reader
One of the requirements was to use the existing community mapping schema where possible. With the fire halls this isn’t possible
since that data never existed in the original CommunityMapping Geodatabase. However, the parks dataset did exist in that
Geodatabase, so we’ll need to use that schema.
So, select Readers > Add Reader as Resource and, when prompted, enter the following details:
Reader Format

Esri Geodatabase (File Geodb Open API)

Reader Dataset

C:\FMEData2019\Data\CommunityMapping\CommunityMap.gdb

WARNING
If, in this dialog, you see the parameter for "Individual Feature Types/Single Merged Feature Types" then
you chose "Add Reader" not "Add Reader as Resource". Click Cancel and pick the correct menu entry this
time!

Click OK, and the reader is added as a Resource:

4) Adjust Dynamic Parameters
Now we need to make sure that the resource schema is being used.
Inspect the properties for the writer feature type. Click the Schema Sources browse button. Put a checkmark against
CommunityMap. Ensure Parks is NOT checked but that FireHalls is:
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Inspect the other dynamic parameters. Since we are writing both points and polygons, for some formats we might have to change
a Geometry setting. But since GML can cope with both geometry types we won't have to take any action; in fact, there will not
even be a parameter for geometry type! Accept the parameter changes to close the dialog.

5) Save and Run Workspace
Save the workspace and then re-run it (ensuring the entire workspace is re-run).
Inspect the output. There should be two layers: one for fire halls, the other for parks. The parks dataset should have the schema
from the CommunityMapping Geodatabase (not the MapInfo TAB Parks dataset), including attributes for ParkName,
ParkAddress, and ParkURL (even if there is no data to fill some fields yet):

Notice that it also has OBJECTID, which came from the Geodatabase and we don’t really need.

6) Delete Attribute
Revisit the writer feature type parameters. Click the button for Attributes to Remove and type OBJECTID into the first row of the
dialog that opens. You won’t be able to select it from the drop-down list because it comes from a resource reader, not a real reader:
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Click OK to close this dialog, but don't close the feature type dialog yet...

7) Add Attribute
A last-minute request is to add an attribute – LastUpdatedBy – to all tables in the output.
So, click on the User Attributes tab and add this new attribute. Make it a 30 character string.

As you can see, there is no need to change the attribute definition mode - it should stay as dynamic.

9) Re-Run Workspace
Save the workspace and rerun it.
Inspect the output. Notice that OBJECTID will not appear as an attribute. LastUpdatedBy does appear - on both Parks and
Firehalls - albeit that it doesn’t have a value yet.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a dynamic workspace with multiple readers
Add a Resource Reader
Change the source of a dynamic workspace schema
Add and remove hard-coded attributes in a dynamic workspace
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Alternative Dynamic Schema Sources
In general, the schema for a dynamic translation comes from either the source dataset itself or from a different dataset (such as the
database table the data is being written to).
However, there are two other scenarios for providing the output schema:
A schema can come from a lookup table (text file or spreadsheet) in which definitions are stored
A schema can be defined dynamically as a list of attributes in a workspace

Table-Based Schemas
In this scenario, the output schema is stored as some form of a table in a text file or spreadsheet; for example:

Here the author has listed a series of feature types, attributes, and geometry types that define the output schema. In FME they
would use this schema by adding a Resource Reader. The format of the Resource Reader would be Schema (From Table):

In the parameters dialog for this reader there are parameters to specify which fields in the table represent which parts of the
schema:
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Geometry type is optional but used in this example.
Attribute sequence is another optional parameter. It defines a field in the table that records the order that attributes should appear
in.
Then, of course, this reader must be used as the source for the output schema:

As always, the incoming attributes must be mapped to the outgoing schema. The best way here is the SchemaMapper transformer
since it too can use a lookup table to create its mappings.

FME Lizard says…
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A significant advantage of this method is that you don’t need to edit the workspace, or edit a dataset, to
make schema changes. Once you change the output schema in the table, then that is automatically applied
in the FME translation.

Constructed Attribute Schemas
This scenario is a way to construct an attribute schema using lists in FME. The schema is defined by using attributes in the list, for
example:

The writer is told to use this schema in preference to any others by selecting it as the Source Schema:

FME Data Types
Both of the two preceding tools allow the user to define attribute type in an output schema. There are a set of valid datatypes in
FME, which are as follows:
General Field Type

Specific Field Types

Character Fields

fme_varchar(width), fme_char(width), fme_char

Integer Fields

fme_uint8, fme_int16, fme_uint16, fme_int32, fme_uint32, fme_int64,fme_uint64

Numeric Fields

fme_decimal(width,decimal), fme_real32, fme_real64

Date-Time Fields

fme_datetime, fme_time, fme_date

Other Fields

fme_buffer, fme_boolean
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FME Lizard asks…
Q) The ability to construct a dynamic schema from attributes in a workspace has lots of possibilities. In
fact, one of these FME transformers automatically creates dynamic schema attributes specifically so you
can create a new schema. Which is it?
SchemaMapper
AttributePivoter
PythonCaller
Clipper
A) The AttributePivoter creates a whole new series of attributes that are completely different to the source
schema; therefore it also generates a dynamic schema to assist you in writing the data. Check it out and
you will see it creates a whole series of attribute_name{} and attribute_data_type{} list attributes.
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Exercise 5

Dynamic Community Map Translation (Table-Based)

Data

Community Mapping (Esri File Geodatabase)

Overall Goal

Generate a new Community Mapping dataset using a table-based schema

Demonstrates

Table-based schemas for dynamic translations

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex5-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex5-Complete.fmw
C:\FMEData2019\Workspaces\DesktopAdvanced\ReadWrite-Ex5-Complete-Advanced.fmw

In a previous exercise, you created a new community map dataset for the planning department using a dynamic schema. At the
time only two tables were defined, but now another one is required, and the planning department wants you to update the
workspace.
Rather than having to make changes each time they add more datasets, you believe that you can simply create an Excel
spreadsheet containing the schema definition. That way the planning team can edit it themselves and do the same for all future
updates.

1) Inspect Spreadsheet
Open and examine the spreadsheet at C:\FMEData2019\Resources\DesktopAdvanced\CommunityMapSchema.xlsx.
If you don’t have Excel then open it in the FME Data Inspector and switch to Table View.

The table has schema definitions for Firehalls, Parks, and Zones feature types. You can see how each new table has a series of
attributes defined for it (each attribute is a separate row in the spreadsheet) including attribute type and attribute order. Geometry
type only needs to be defined once per table.

2) Start Workbench
Start FME Workbench. Open the workspace from the previous exercise or the begin workspace listed above.
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3) Delete CommunityMap Resource Reader
Because we are using a spreadsheet to define our output schemas, the CommunityMap Resource Reader is no longer needed.
Locate it in the Navigator window, right-click on it, and choose Delete.

When prompted, click Yes to confirm that all references relating to this dataset will also be removed.

4) Add Excel File as Reader Resource
Now select Readers > Add Reader as Resource. In the dialog that opens choose:
Reader Format

Schema (From Table)

Reader Dataset

C:\FMEData2019\Resources\DesktopAdvanced\CommunityMapSchema.xlsx

*NB: Be sure to use the Schema (From Table) format and not the Excel format!*
Click the parameters button (OK will be greyed-out until you do). This dialog is where we can define how the table maps to the
required schema.
Check the reader parameters at the top. They should show the dataset is an Excel format file. Select Sheet1 under the Select Table
parameter:
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The first row should get used as the field names. If this is not the case, then click the parameters button above and set the values
correctly:
Next, select the appropriate fields to match to the required parameters (for example Feature Type = FeatureType):

Click OK to close the dialog and again to add the resource reader.

TIP
The fields in such a lookup table can be given any name you desire. In this example, they have been given
the same name as the parameter to which they are being applied, but only to make the relationship as
obvious as possible. Some of them (Geometry Type and Attribute Sequence) are even optional and don't
have to be part of the schema definition if not needed.

5) Set Dynamic Parameters
Now inspect the feature type parameters for the writer feature type.
Under the User Attributes tab remove the LastUpdatedBy attribute, as we’ve added this to the spreadsheet definition for each type
and no longer need it in here.
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In the Parameters tab click the Schema Sources edit button. Uncheck FireHalls and check CommunityMapSchema
[SCHEMA_FROM_TABLE]:

Accept the changes to these parameters.

6) Add Reader
If you noticed, the schema spreadsheet included an entry for the Zones dataset, so add a reader (not a Resource – we really want
the data this time) as follows:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2019\Data\Zoning\Zones.tab

Once added, connect its reader feature type to the dynamic writer feature type.

7) Save and Run Workspace
Save the workspace and then run it.
Inspect the output. Notice that all three feature types have been written and that their attribute schema matches what was defined
in the Excel spreadsheet; including the LastUpdatedBy field for each one.

Advanced Exercise
Let's do a couple more advanced steps if you have the time.
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8) Update Spreadsheet - 1
The planning team has decided they should rename some attributes, so open the spreadsheet and rename the following attributes
for the FireHalls feature type:
Name to HallName
Address to HallAddress
PhoneNumber to HallPhone

TIP
If you don't have Excel, instead of this step merely change the Resource Reader to use the advanced
schema version of the file,
C:\FMEData2019\Resources\DesktopAdvanced\CommunityMapAdvancedSchema.xlsx

9) Update Spreadsheet - 2
If you run the workspace now, it will run to completion, but there will be no values in the renamed fields of the FireHall table.
That’s because FME had no way to tell how to map the source data to the new schema.
We could just add an AttributeRenamer transformer to handle this change, but the better way is to use the SchemaMapper. That
way it can be made a little more dynamic.
So, in sheet 2 of the spreadsheet, enter:
OldAttrName

NewAttrName

Name

HallName

Address

HallAddress

PhoneNumber

HallPhone

Then save the spreadsheet.

TIP
Again, if you don't have Excel the advanced version of the Excel file has the correct updates already made.

10) Add SchemaMapper
Add a SchemaMapper transformer to the workspace, connected to the output feature type:
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Inspect the SchemaMapper's parameters. It is a wizard, rather than a single dialog. In the format panel select the edited Excel file.
In the next panel select Sheet 2 as the table to use.
In the final panel, select + > Attribute Map:

When prompted, select OldAttrName as the source field and NewAttrName as the Destination field. Check the box to Remove the
original attributes (i.e. this is a renaming, not copying):
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What this does is tell FME to rename attributes with the OldAttrName to attributes with a NewAttrName. Click OK to close this
dialog, then click Finish. Now save and rerun the workspace.
Run the workspace. This time the output will have its attributes properly mapped. So now the planning department can translate
their data, decide on the output schema, and map source to destination attributes dynamically; all by editing this one Excel
spreadsheet. If either the existing source attributes change, they can be handled by editing the same spreadsheet.

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a spreadsheet for use as a dynamic translation schema
Use the Schema (from Table) reader to read a schema from a spreadsheet
Map attributes in a dynamic workspace using a SchemaMapper transformer
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Module Review
This chapter looked at advanced techniques for reading and writing datasets with FME.
What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
Datasets stored on the web can be read either using a simple URL or through an FME Web Connection.
A Fanout is a way to write data divided into a number of layers or a number of datasets, according to the value of a userdefined attribute.
The Generic Reader and Generic Writer allow a workspace to be dynamic in terms of format; it can read any format of data
and write any format of data.
Schema is composed of Feature Types, Attributes, and Geometry. A Dynamic translation is a universal workspace that can
handle any combination of schema.
The Schema in a dynamic workspace does not need to come from the source datasets; it can come from another dataset
entirely, come from a lookup table, or can be constructed as list attributes inside the workspace.
FME Skills
The ability to read and write datasets from and to a zip file
The ability to read data stored on the web or in a web service
The ability to create and use a web connection
The ability to use a Feature Type Fanout and a Dataset Fanout
The ability to use the Generic Reader and Writer
The ability to create a simple Dynamic workspace
The ability to add a Resource Reader
The ability to use a Resource Reader or Lookup Table as the schema source in a dynamic translation.

Further Reading
For further reading why not browse articles tagged with Dynamic Schema or Fanout on our blog?
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Advanced Parameter Use
Parameters are controls that define how FME operates; for example, how a reader reads data, how a transformer transforms it,
and how a writer writes it. Almost every component in FME has parameters of one type or another.

Types of Parameter
When looking at the types of parameter, it’s helpful first to consider the types of people who use FME and their role in the
process.
Workspace authors are the people who design and create a workspace. Authors use FME Workbench and set parameters to
control how the workspace runs.
Workspace users are the people who make use of a workspace, without necessarily having created it first. Users might have very
little knowledge of FME, and may never have used FME Workbench, but they still may need to set parameters to control how the
workspace runs.
In light of these two roles, we can say there are two different types of parameters: FME parameters (for authors to use) and user
parameters (for FME users to use).

FME Lizard says...
The concept of workspace users who have never heard of FME sounds like an oxymoron. However, FME
is an enterprise-level data integration platform. People may use FME at that level without having any
knowledge of FME Desktop. In fact, users on the client side of an FME Server installation might be using
a custom web page or application that triggers a translation on FME. So it's entirely possible to set
workspace parameters without even knowing what a workspace is!
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FME Parameters
FME parameters are those built into the FME Workbench interface. They directly control a translation and can be found in various
places, such as transformer dialogs or feature type dialogs. However, for the most part, you will find all FME parameters in the
Navigator window of FME:

Here, for example, are the FME parameters for a text file writer. They include options to overwrite or append to an existing text
file and the type of character encoding that should be used.
These are parameters the workspace author will use. The user is not expected to set these because they are not assumed to have
enough experience of Workbench to know where to find the parameter or how to set it.
For example, the author might decide that the byte order mark should not be written in this output.

They double-click the parameter to open a dialog in which they can change the parameter value.

FME Lizard says...
In case you were wondering, the Byte Order Mark (aka BOM) is a special character found in the header
of a text file. It denotes whether the text is in a Unicode encoding, which Unicode encoding it is, and what
the endianness of the text is. It helps different applications to read the data correctly.
You want to know what "endianness" means now, don't you?!
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User Parameters
User parameters are those that are created by an FME author, but for an FME user to use. In other words, they are a way for the
end-user of the workspace to provide their input, regardless of where and how the workspace is being used.

Creating a User Parameter
User parameters appear in a particular section of the Navigator window, labeled User Parameters. Here, for example, two user
parameters have been defined:

Each of these user parameters allows the end-user of a workspace to enter information into the translation; whether to process line
features and what color to write them in.
A user parameter is easy to create by right-clicking on the User Parameters label and choosing Create User Parameter:

2019.1 UPDATE
2019.1 introduces a new option to this context menu: Always Show References.
More on what that option does shortly...

A dialog appears in which the author can define the parameter. In this case, they are creating a parameter in which the user can
enter their name:
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You can also copy, paste, and duplicate user parameters. This allows the workspace author to duplicate existing parameters and
make changes, instead of having to build several near identical parameters from scratch:

This includes being able to paste a parameter definition into a different workspace from which it was copied.

Entering Information into a User Parameter
Once a user-parameter is defined, the workspace can be run in Prompt for User Parameters mode:
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With this mode activated in FME Workbench, the user is prompted to supply values through a simple dialog:

In FME Server, the user is prompted through a web page:

Using a User Parameter
Getting input from a user is pointless if it is not used, so it’s also necessary to actually do something with that input.
User parameters can be exploited in a number of places. Firstly they can be tied to an FME parameter (more information on that in
the next section), but they can also be used to provide values to transformers and attributes in a workspace.
For example, here the author is making use of the color and username parameters (in the FeatureColorSetter and
AttributeManager transformers):
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The author set up these transformers to use the parameter input by selecting it in the transformer like so:

Now when the workspace is run, the end user can select the color of features to write, plus enter their name into a text field and
have it entered into the UpdatedBy attribute in the output.

WARNING
A screenshot above shows a workspace being run with both parameter prompts and feature caching.
Be aware that a prompt is only provided for a parameter that is used in the section of workspace being
run. In other words a partial run that fetches data from caches, may prevent a parameter prompt, if that
parameter is not used in that partial run.

FME Lizard asks...
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Q) Here are two questions for you to answer. To start, tell me this: what are our two roles of FME user?
Maker/Consumer
Creator/Inspector
Author/User
Reader/Writer
A) The person who creates a workspace is the author. The person who runs the workspace is the user.
Sometimes they are both the same person, but often not.

Q) Here's another question, only slightly less easy. Look at the ParameterFetcher transformer. What does
it do?
Fetches the name of a user parameter
Fetches the value of a user parameter
Fetches the type of a user parameter
Fetches the user a cup of tea
A) This transformer fetches the value of a user parameter, although you could just as easily use the
AttributeManager transformer to do the same thing. Sadly, making tea is still a manual process!
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Exercise 1

Parameterize a Metadata Writer

Data

Parks (MapInfo TAB)

Overall Goal

Allow user input to metadata fields

Demonstrates

Use of FME parameters.
Creation and use of user parameters

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex1-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex1-Complete.fmw

In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks has a workspace that translates their data from the source MapInfo TAB format to
Google KML. It also writes a file of XML metadata to show who translated the data and when.
At the moment there are a number of problems they face:
The XML output is not particularly well formatted
The date attribute is being rejected by an online XML validator
All of the XML metadata fields are hard-coded in an AttributeCreator transformer. This is quite inconvenient (especially
when they want to run the workspace on FME Server!)
You have been assigned to help solve these problems. At least one of these requires you to create user parameters to take the place
of hard-coded values.

1) Start Workbench
Start Workbench and open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex1-Begin.fmw

The metadata part of the translation consists of the two transformers and an XML writer feature type.
The Sampler transformer ensures that only one record is written to the output metadata, by discarding all but one feature, and the
AttributeCreator creates a set of attributes to write to the metadata.
Check the parameters for each transformer in turn. These are FME parameters, set by the workspace author and not available to
the end-user. Here, for example, are the parameters for the Sampler transformer:
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You can find these parameters in the Parmeter Editor window, the transformers' Parameters Dialog, and under the Transformers
section of the Navigator window.

2) Change XML Writer Parameter
An FME parameter called Pretty Print controls the style of the XML file being written:

To ensure the output is always well-formatted, we should set this parameter to Yes - but we won't create a user parameter from it
because we don't want the end-user to change it.
In the Navigator window locate the XML writer, expand the parameters list, and locate the parameter labeled Pretty Print. Doubleclick it.
In the dialog that opens, change the value to Yes and then click OK to close the dialog.

We have now - as a workspace author - changed an FME parameter.

3) Create User Parameter
The output schema has three variable attributes: username, user company (organization), and user email. We should create a user
parameter for each of these to allow the end-user to enter that information.
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Firstly, locate the User Parameters section of the Navigator window, right-click on it, and choose the option to Create User
Parameter:

In the new dialog, select Text as the type of parameter to create (there is more on parameter types in the next section). Each
parameter needs a name, so call this one UserNameParam. Now enter a prompt, such as "Enter your name."

Click OK to close the dialog and create the parameter, which now appears in the Navigator window.

4) Create Remaining User Parameters
The quickest way to create the other two required parameters (UserMailParam and UserCompanyParam) is to duplicate the
UserNameParam parameter.
So, right-click on the UserNameParam parameter and choose the option to Duplicate:

210

Exercise: Parameterize a Metadata Writer

A settings dialog for the duplicate parameter will open. Call it UserMailParam and set the prompt to “Enter your email address”.
Repeat the duplication process, this time creating a parameter called UserCompanyParam with the prompt "Enter your company
name."
When done the Navigator window looks like this:

5) Use User Parameter – Method 1
Each of the user parameters we've just defined provides values that need to go into attributes in the writer schema. There are a
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number of ways to extract the value for such a purpose, and we’ll use a different way for each parameter, just to illustrate the
different methods.
So, firstly locate the parameters for the AttributeCreator (either the Parameter Editor window or AttributeCreator Parameters
dialog). This transformer is what currently creates the attributes for the output.
Click the Attribute Value field for the AuthorName attribute. Click on the drop-down arrow, then select User Parameter >
UserNameParam.
Once done the value field will change to a special icon and show the parameter that was chosen:

While here, click on the AuthorEmail and AuthorCompany fields, and press the minus button to delete them, so that we can
demonstrate dealing with these a different way.

6) Fix Date Attribute
Looking at the AttributeCreator, we can see that the date field is being entered as a fixed value. Although not a user parameter as
such, it's evident that the user must be setting this manually at runtime.
Additionally, the date structure does not conform to an ISO standard, which is why the output fails XML validation.
Let's fix these issues. First click on the drop-down arrow next to the UpdateDate Attribute Value field, then choose Open Text
Editor:
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In the text editor remove any existing content and replace it with:
@DateTimeFormat(@DateTimeNow(),%Y-%m-%d)

This uses FME Date/Time functions to return today's date in a structure matching the ISO date standard.

FME Lizard says...
An alternative method is to simply set the date value to @DateTimeNow() and using the
DateTimeConverter transformer to convert it to a real date in an ISO date standard:
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7) Use User Parameter – Method 2
A second way to extract the value from a user parameter is with a ParameterFetcher transformer.
Place a ParameterFetcher transformer (after the AttributeCreator is fine). Inspect the parameters.
Select UserEmailParam as the parameter to fetch. Enter AuthorEmail as the name of the target attribute, then select
UserCompanyParam and enter AuthorCompany as the target attribute:

8) Use User Parameter – Method 3
Did you notice that the list of parameters available includes many FME-related system parameters? These are particularly useful
for use with FME Server and for writing metadata, as we are here.
Locate the BuildNumber attribute on the ParksMetadata feature type. Right click on that attribute and select the Edit Value option:

In the dialog that opens, you can enter a fixed (constant) value, but in our case, we’ll click on the drop-down arrow, select User
Parameters, then FME Parameters, and then select FME_BUILD_NUM:
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Click OK to close the dialog, and the feature type will highlight the attribute with a light red rightward-pointing arrow to show it
has an attribute value set before being written.

9) Save and Run Workspace
Save the workspace and then – as if you were the end-user – run it. Be sure to set the Prompt option on the toolbar first:

When prompted enter your details into the fields that have been newly created, notice that the BuildNumber parameter we created
isn't in the prompt. This is because it is an FME-specific private parameter that the user doesn't need to change:
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NEW
Notice that - new for FME2019 - you can choose to save your parameter values both as the default and
also as a set of preset values for later recall and use.

Locate and open the XML file to ensure the contents have been inserted as expected:

CONGRATULATIONS
By completing this exercise you have learned how to:
Set an FME parameter (on the XML writer)
Create a text type user parameter
Duplicate an existing parameter
Use a user parameter in a regular transformer
Use a user parameter in a ParameterFetcher transformer
Use a user parameter in an Edit Value dialog
Use the DateTimeNow and DateTimeFormat functions in a text editor to create an XML-valid date
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Types of User Parameters
There are many different types of user parameters and many different ways to make use of them. The most common parameter
types can be grouped as:
Text Parameters
Numeric Parameters
Choice Parameters

Text Parameters
Text parameters are a simple way to accept plain text values into a workspace. A Text parameter allows a single line of text, while
Text (Multiline) parameters allow the user to enter text broken over a number of lines.

A Text parameter will automatically trim any leading or trailing white space, commas, or other common delimiters. To maintain
any leading or trailing white space or delimiters, use Test (Multiline).
There is no limitation on the characters that can be entered. However, Text (Multiline) is better for large amounts of text spanning
several lines. Additionally, Text (Multiline) is the preferred parameter for entering encoded (not plain ASCII) characters.

FME Lizard says…
It's worth being aware that not every transformer and format in FME handles encoded text. If you are
unsure, then it’s safer to use a Text parameter – that everything will support – rather than a Text
(Multiline) parameter that is not universally supported.

Numeric Parameters
Unlike text, there is just one type of numeric parameter: Number. However, this type of parameter has settings that allow you to
define whether it is a float or integer type number.
Here, for example, the workspace author is creating an integer parameter. The number of decimal places is set to zero:
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When the user is prompted for a value, they are not able to enter a floating point (non-integer) number. Because this is a number
field, FME also stops the user entering text (alphabetic) characters.
This is a good example of how FME parses input to ensure it matches the parameter type, as shown in the following screenshots:

Invalid input: 12.3 is not a valid integer
Invalid input: abcd is not a valid float
Valid input: negative numbers are fine
Invalid input: 123.4567 is a valid float, but has 4 decimal places of precision, when the definition was only 3
Valid input: 123 is a valid integer
Valid input: 123.456 is a valid float with the correct decimal places of precision
The Upper/Lower Limit settings for a numeric parameter also allow FME to parse the input to ensure it matches what is required:

Invalid input: needs to be greater than 3
Invalid input: needs to be less than or equal to 10
Valid input: between 3.001 and 10.000

Choice Parameters
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A choice parameter is when the user is presented with a fixed list of options and selects one of them. Different choice type
parameters allow the user to pick from a list, pick multiple entries from a list, or type in text as an alternative to a list:

Here the user will be asked to enter their name. However, since the names of all users are already known – presumably this is for a
particular company’s staff – a list of them is created:

That way, the user is prompted to select their name from a list. They don’t have to type it in manually:

A Choice with Alias parameter is the same as a Choice parameter in that the end-user gets to pick a value from a list. However, a
lookup table maps the chosen entry to a value that gets provided to FME.
For example, this workspace takes incoming features and matches them to a database using an EmployeeID.
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EmployeeID is provided by the end-user, but they can’t always remember their own ID number. So, the author creates a Choice
with Alias user parameter.
The parameter is configured like so:

Notice that there are two fields in this configuration dialog; the display name and the actual value.
When a user selects their name from the list, then the value provided to the workspace is actually their employee ID. That way
employee ID can be used as a match in the DatabaseJoiner, without the end-user having to remember it!

FME Lizard says…
Choice (Multiple) and Choice with Alias (Multiple) are very similar parameters (to Choice and Choicewith-Alias), but let the end user select multiple values. For example, if a manager wanted to run reports
on several employees, this is what they could use. Multiple values are returned space-delimited.

FME Lizard asks...
Q) Besides the above, there are some more - specialist - parameter types. Which of the following is NOT a
valid user parameter type?
Coordinate System Name
Password
String Encoding
URL
A) String Encoding is not a type of FME user parameter. Technically there is an FME parameter of that
type, but it's not made available as a user parameter.
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Linking Parameters
As we know, there are FME parameters that control FME directly and user parameters that allow input from a user.
Sometimes a workspace author needs the user's input to apply directly to an FME parameter, and this is done by linking the user
parameter to the FME parameter.
For example, an FME author has a workspace that writes to a KML dataset. There is a parameter called "Author Email" that adds
the user's email as metadata.
The workspace author wishes for the end-user to enter their own email address, but doesn't want them to have to search for that
parameter.
So, besides the FME parameter, they create a user parameter:

Their user parameter allows the user to enter a value, but as yet the workspace does not do anything with that value. To do so, the
user parameter must be linked to the FME parameter.
The author does this by right-clicking the FME parameter and choosing Link to User Parameter:
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Then they select their user parameter to link to.

FME Lizard says...
Alternatively, they can do the reverse; right-click the User parameter and choose Apply To [FME
Parameter]. But there are usually more FME parameters than user parameters, so the 'Link' method is
usually easier and quicker.

Because the FME parameter is now linked to the user parameter, whatever value the user sets for that user parameter is applied
directly to the FME Parameter (Author Email):
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FME Lizard says...
If the author changes their mind, there is always an option to unlink the user parameter and return the
FME parameter to direct author control.

Creating Direct Links
In the previous example, a user parameter was created separately and then linked to the FME parameter. However, there is a
shortcut to this, where it is possible to both create and link a parameter simultaneously.
In the Navigator window, simply right-click an existing FME parameter and choose the option to "Create User Parameter":

This opens the Add User Parameter dialog as before, but this time the definition to create a parameter is filled in automatically:

Click OK and the user parameter is created and automatically linked to the FME parameter.

FME Lizard says...
You can do the same one-step action inside a transformer dialog too, like so:
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Here the workspace author is creating a user parameter linked to the Elevation FME parameter in a
3DForcer transformer.

Advantages and Disadvantages of Direct Links
You might be wondering why you would ever link a user parameter separately, or why we showed that process first. It's because
there are advantages and disadvantages to both methods.

Direct Link Advantages
Creating a linked FME parameter directly has an obvious advantage that it is a single-step process. The creation and linking of the
user parameter are done in a single action.
Additionally, a user parameter created from an FME parameter is automatically given the correct data type.

For example, in the 3DForcer, elevation requires a floating point number; any user parameter created from this FME parameter
will automatically be of type float, without the option to change it.

Direct Link Disadvantages
The inability to set data type can, however, be a limitation.
Say, for example, the author wanted to provide a list of permitted elevations for the 3DForcer; 0.0, 10.0, 50.0, etc. This could not
be achieved by creating the user parameter directly because it would create a Float parameter when a Choice is the required
option.
So the author should create a choice user parameter separately and then link it to the FME parameter:
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Of course, the author needs to take care that the values provided by the user parameter were of a type that matched those expected
by the FME parameter. FME isn't able to parse all input from a user parameter (especially Choice parameters) to ensure it matches
the FME parameter it is linked to.
Another disadvantage is one of a persistence of the user parameter.
It's like this: if a user parameter is created directly from an FME parameter on a transformer, then it is forever tied to that
transformer. If the transformer is deleted, then the user parameter will be deleted too.
However, if a user parameter is created separately, and linked manually to a transformer’s FME parameter, then it will remain in
the workspace, even if the transformer is deleted.
This could be seen as either an advantage or disadvantage, depending on whether you would like this behavior or not!
Finally, a user parameter created directly has no control over what is known as Attribute Assignment (more on that later in this
chapter).
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Pre-Linked Parameters
In some scenarios, user parameters are created automatically and linked to an FME parameter, without any manual action by the
workspace author.
For example, any time a reader or writer is added to a workspace, their source/destination dataset parameters are automatically
turned into user parameters.
Here, a Source MapInfo TAB parameter is linked automatically to a user parameter called SourceDataset_MITAB:

There is also a parameter for DestDataset_GML, that maps to the output GML parameter.
Automatic linking occurs for parameters that are important to the end-user, and that appear in nearly all workspaces. This includes
readers and writers, plus (for example) the Feature Types to Read parameter.

FME Lizard asks...
Q) If you – as the workspace author – don’t want or require the end-user to have access to pre-linked
parameters, then what can you do?
Delete the Reader/Writer
Unlink the user parameter
Delete the FME parameter
Delete the user parameter
A) The user parameter does not have an unlink option, and FME parameters cannot be deleted, so you
would delete the user parameter. You could choose unlink on the FME parameter - but that would
automatically delete the user parameter anyway!
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Exercise 2

Code Review a Colleague's Workspace

Data

Community Map (File Geodatabase)

Overall Goal

Simplify a workspace using user parameters

Demonstrates

Creation and use of complex User Parameters

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex2-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex2-Complete.fmw

The Public Safety department at the city has acquired FME and started using it for data translations.
However, having not (yet) taken the FME Desktop training course, they are not confident users and would like some assistance.
You have been tasked to carry out a "code review" on one of their workspaces. At least one of the issues you find is likely to
involve creating user parameters to take the place of hard-coded values.

1) Start Workbench
Start Workbench and open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex2-Begin.fmw
This is the workspace created by your colleagues:

Notice that it converts from an Esri Geodatabase to Esri Shapefile format. Currently, the tables that are to be processed are chosen
by disabling unwanted ones in the workspace. Similarly, they are setting the destination coordinate system and data encoding
using Navigator parameters. This is all very user-intensive.
Also, notice that the only annotations in the workspace are there to help the end user make such edits. There should be no need for
that; published parameters should prompt the user instead, and that is what we will implement here.

2) Clean Up Auto-Created User Parameters
Open up the User Parameters section of the Navigator window. Notice how there are already user parameters for the source and
destination datasets:
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Your public safety colleague tells you that the source data will never change, so that parameter is of no use. So delete the user
parameter labeled “SourceDataset_FILEGDB.”
However, she tells you that the destination location can be set by the user, so keep the parameter for DestDataset_ESRISHAPE.

3) Create Encoding Parameter
The Public Safety team want to make it easier to set the encoding of the output dataset. Currently, users are pointed by a
workspace annotation towards where that writer parameter exists in the Navigator window!

This shows you how difficult it is for them to locate the correct parameter in the Navigator window. Let's solve that with a user
parameter.
Locate the Shapefile (ESRISHAPE) writer in the Navigator window and expand the list of FME parameters. Identify the
Character Encoding parameter, right-click on it and choose Create User Parameter:

Simply click OK on the dialog that opens and a user parameter is created and linked to the FME one. Now there is a user
parameter to make it easy to set that FME parameter.

4) Create Coordinate System Parameter
Another requirement, you are told, is an ability to set the output coordinate system. Again, this is currently done by using an
annotation to point the user towards the Navigator Window.
However, if you simply publish the writer’s coordinate system parameter – try it and see – then there will be a problem. The
parameter will allow the end-user to select ANY coordinate system supported by FME.
This is not necessarily very useful. Since the data is located in Vancouver, BC, it makes little sense for the user to be able to
reproject it to (for example) NZMG (a New Zealand coordinate system).
It would be preferable if the parameter only allowed the end-user to select a coordinate system from a smaller list.
Now create a new user parameter (Right-click User Parameters > Create User Parameter), and set the Type to be Choice with
Alias. Set the Name to be CoordSysParam, and set the prompt to be Select Output Coordinate System:
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Now click the [...] button to the right of the Configuration setting. This opens a dialog in which to configure the parameter.
Normally we would enter values manually in a Choice with Alias parameter, but for coordinate systems (and reader/writer
formats) we have the option to have FME define them for us.
Click on the button labeled Import and choose Coordinate System(s):

This opens a list of coordinate systems that we can import as values in our user parameter.
Locate and put a checkmark in the box for the following coordinate systems:
UTM83-10
BCALB-83
LL83
CANBC-LCC
Then click OK to close this dialog. You will be returned to the configuration dialog and find that names and values have been
automatically entered for these coordinate systems:
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The left-hand side shows what the user is prompted to select, the right-hand side what the value fed to FME will be.
Click OK and then OK again to close the remaining dialogs and create the user parameter.

5) Link Coordinate System Parameter
Now we have the user's selection, but we still have to apply it to the FME parameter. Locate the writer’s coordinate system
parameter, right-click on it, and choose Link to User Parameter:

When prompted, select the newly created CoordSysParam and click OK to accept the selection. Now when the workspace is run
the user is prompted to select a coordinate system, and that system's short name value is passed to FME.

6) Create Tables Parameter
The final task for us here is to create a way to decide which tables are going to be read. If you remember, at the moment the way
your colleagues do this is by disabling various reader feature types. However, there has to be a better method.
This is an interesting task because we want to control the source tables (Libraries, Parks, etc.), but based on the selection of
destination tables (CommunityFacilities, Environment, and Miscellaneous).
For example, we want the user to select output feature types like "Environment", which needs both "Parks" and
"DrinkingFountains" reader feature types.
However, this we can do very easily. Firstly locate the Feature Types to Read parameter in the CommunityMap reader "Features to
Read" parameters (in the Navigator window):
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Right-click on it and choose Create User Parameter. A dialog will open that is already populated with a list of feature types:

Check the box that is labeled Use Alternate Display Name. This provides the ability to give alternative names for each feature
type. What we need to do is use this dialog to group common reader feature types together under a single display name.
Delete the entry for GarbageSchedule, as this data isn’t connected and is not needed.
Then, match the contents of the workspace by editing the Display Names. They should match as follows (the order is not
important):
Display Name
Community Facilities

Feature Type
Libraries
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Community Facilities

CommunityCentres

Environment

Parks

Environment

DrinkingFountains

Miscellaneous

FoodVendors

Miscellaneous

TransitStations

Miscellaneous

AccessibleParking

Underneath that change the prompt to read “Tables to Write” and then click OK to close the dialog.

What we have done here is set up a list of output layers to select from, with a list of input layers that each refers to.

7) Save and Run Workspace
Save the workspace. Then start up the FME Quick Translator application, located on the Start menu under the FME Desktop
Utilities folder. By using this tool, we'll ensure that the user is prompted for parameter values.
In there, select Run from the Getting Started menu:
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Browse to the newly saved workspace, select it, and click Open. You will be presented with a list of published parameters, just as
the end-user would see it:

Pick Unicode 8-bit (utf-8) as the encoding. Select a coordinate system, noting how the user is restricted to those chosen by us.
Select one or two of the tables to write and click OK to run the workspace.
The translation will be carried out. Inspect the data to ensure the results are correct. The CommunityFacilities – for example –
should be made up of both libraries and community centers.

Advanced Exercise
Speaking of Best Practice, don't forget to tidy up the workspace and give it a better style and structure!

CONGRATULATIONS
By completing this exercise you have learned how to:
Remove pre-linked parameters
Create a simple pre-linked parameter
Create a Choice with Alias user parameter
Use a Choice with Alias parameter to define coordinate systems
Manually link a user parameter to an FME parameter
Publish the Feature Types to Read parameter
Set up and use alternative names in the Feature Types to Read parameter
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Shared, Embedded, and Scripted Parameters
Shared and Embedded parameters are not specific types of parameters; instead, they refer to two different ways in which
parameters might be used.
Scripted parameters are a way to include Python or Tcl code in the way a parameter is defined.

Shared Parameters
There is no limit on the number of times a user parameter can be used or linked to an FME parameter. The value obtained from a
user parameter can be used as many times as is required.
When a parameter is used in two or more places, it can be described as a shared parameter.
For example, a workspace has a user parameter called TOLERANCE (here being used inside a Generalizer):

However, the workspace author has decided to apply the same parameter in three places in total; two Generalizers and a Clipper:

The advantage is that the same value can be used without the user having to enter it multiple times.

2019.1 UPDATE
You might be wondering, how can I tell where a user parameter is being used? What FME parameters is it
linked to?
To find out, right click the parameter and choose the option to Show References:
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This applies whether the user parameter is referenced by one FME parameter or many. If you wish to
always show these references, without having to use "Show References", then this is where the new-for2019.1 Always Show References option is used:

Embedded Parameters
Sometimes in FME, parameter values need to be constructed from multiple components. When one parameter is constructed so as
to include the value of another parameter inside it, this is called Embedding Parameters.
For example, here the name of a file is constructed from two user parameters: one is a fixed output path and the other is a user's
name:
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The technique is called embedding because the user parameters - UserName and OutputFolder - are embedded inside the FME
parameter (Target Filename).

Scripted Parameters
Scripted parameters go one step further than an embedded parameter. Instead of simple concatenation, a scripted parameter allows
a full Python or Tcl script to be used to construct a value.
For example, this Tcl script creates a filename from a fixed path and an embedded user parameter. However, in this case, the script
is used to test whether the workspace is being run on a Windows or Unix system, so that it can set the output path accordingly:
set realname ''
if {[string match 'C:*' $FME_MacroValues(FME_HOME)]} {
set realname 'C:\Output\'+$FME_MacroValues(UserFileName)
} else {
set realname '/Output/'++$FME_MacroValues(UserFileName)
}
return realname

Note that the script must include a return statement, to return a value to the parameter. A scripted parameter is purely for use by an
author. The user is not prompted for a value, as it would be absurd to expect them to enter Python code when a workspace runs!

FME Lizard says…
Use the ‘print’ command (in Python) or ‘puts’ command (in TCL) to write from the script to the FME log
file.
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Parameter Settings
When a user parameter is created, two checkbox options exist; one is labelled Published and the other Optional.

Published Parameters
The purpose of this option is to expose or hide the parameter from the end user. If the Published box is checked, then the end user
is able to enter a value. If the box is unchecked, then they will not be prompted to enter a value, and the parameter will be treated
as "private."

Private parameters have two uses.
Firstly, a private parameter is a way for a workspace author to create a shared parameter without having it exposed to the user.
For example, if they want to supply the same tolerance value to several Snapper transformers – but the author, not the user, sets
that value – then a private parameter is used.
The second use of a private parameter is to embed a user's partial input into a larger parameter.
For example, here the workspace author prompts the user to enter a folder in which a file is to be written (1). The full folder path
is then defined by the author as a private parameter (2) as a mix of a fixed path and a job ID:
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Finally (3) the Private Parameter is embedded inside the FME parameter for the destination Shapefile dataset.

FME Lizard says...
You might have noticed that there are a number of FME Server Parameters available to workspace
authors who intend to deploy their creation on an enterprise scale.
In fact, if you look at the above screenshot, you might notice that a Server parameter (FME_JOB_ID) has
been embedded into the FullPath private parameter!

Optional Parameters
The Optional checkbox tells FME whether the user parameter is compulsory or optional.
Here, for example, the DateTimeCalculator is being used to calculate the time a park closes, given its opening time and user input
on how many hours and minutes it is open:
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The MINUTES user parameter has a checkmark in the Optional setting, meaning it is not compulsory. For example, the user can
just enter that the park is open for eight (8) hours and ignore the MINUTES parameter.
Alternatively, a user parameter might provide a tolerance value to a Generalizer transformer. In this case, the author will want to
turn off this checkbox and make the parameter compulsory. A Generalizer that is not given a tolerance value will usually fail, and
making tolerance compulsory is one way to prevent that from happening.

FME Lizard asks...
Q) Tell me, is it possible to have a compulsory, private parameter (i.e. both settings boxes are unchecked)?
Yes
No
Yes, but you need to set a value immediately
Yes, but only for text or numeric parameters
A) Yes, you can have a private, compulsory parameter - but when you uncheck both boxes the default
value field turns red and requires an immediate value.
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Parameters and Attributes
Sometimes an FME parameter is designed to accept either a fixed value or the value of an attribute. We call these parameters
_OR_ATTR parameters because they allow a value OR an attribute.
For workspace authors, it's also possible to define a user parameter to allow this. Specifically, a user parameter can allow either:
A fixed value only
A fixed value or an attribute
An attribute only
The first two of these capabilities are controlled by a setting in the user parameter called Attribute Assignment.

FME Parameters and Attributes
Let's recap: Some FME parameters - but not all - allow an attribute to be used in place of a fixed value. We call this Attribute
Assignment:

When a user parameter is created or linked to one of these FME parameters, then it too picks up that capability:

So, this allows the end user to enter either a fixed value or to select an attribute that supplies the value.

Attribute Assignment and User Parameters

241

User Parameters and Attributes

Attribute assignment is important when an author creates a user parameter and has to decide whether or not to allow the end-user
to select an attribute.
For example, this workspace has an UpdatedBy attribute and an AttributeManager transformer that sets UpdatedBy using a user
parameter where the user is prompted to enter their name:

When prompted, the user can enter their name, but they can also select an attribute:

Obviously, this makes no sense. The author does not want the user to have the ability to select an attribute, only to enter a string.
The setting that lets the author control this is called Attribute Assignment, and is found on the parameter definition dialog:
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By changing this from Default to Off, the user is no longer allowed to select an attribute in the Translation Parameters prompt:

FME Lizard says...
You might now be wondering what "Default" means. You might think that we should just have Yes/No as
the options.
Well - as you saw above - not every FME parameter allows attribute assignment and making it a user
parameter will not change this. For example, the Snapper tolerance is never allowed attribute assignment.
Having a Yes/No option for a user parameter linked to it is pointless, because Yes is never allowed. That's
why we use the term "Default".
Of course, what this means is that where you apply the user parameter is important. Default means, the
default of where it is applied. If linked to an FME parameter that allows attribute assignment, then
Default will let the user pick an attribute. If linked to an FME parameter that doesn't allow attribute
assignment, then Default will not let the user pick an attribute.
And - because I know you are wondering - if it is shared and linked to both an FME parameter that allows
attribute assignment, and one that doesn't, then FME takes the safe option and disallows attribute
selection.

Attribute Name Parameter
So attribute assignment handles the case where you want the user to enter a fixed value, and you may also give the end user the
option to select an attribute.
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However, the reverse case must also be handled: you don't want the user to be able to enter a fixed value, you only want them to
be able to select an attribute.
For example, here an author is adding a label to the data:

The author wants to allow the user to select an attribute to provide the label, but not be able to enter text. In this scenario they
need to create a user parameter with a special type called Attribute Name:

After linking this user parameter to the LabelPointReplacer's FME parameter, when the workspace is run the user is permitted to
select an attribute and ONLY an attribute:

However!
There is a catch to this operation. The user parameter – as the type suggests – is merely returning an attribute name; it does not
return the attribute value.
If the workspace is run in this state then the LabelPointReplacer is supplied with the attribute name (not value) and uses it as the
label, like so:
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What the author must do is embed the user parameter name inside an FME function to fetch the value of the attribute to which it
refers.
To do this, the author finds the LabelPointReplacer parameter and changes it (either directly in the FME parameter, or via the Text
Editor window) to be: @Value($(UserAttrSelection))
The @Value() function replaces the name of the attribute with its actual value:

Now when the workspace is run the output will be correct:
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Exercise 3

Grounds Maintenance Project

Data

Parks (MapInfo TAB)

Overall Goal

Parameterize and implement a translation log

Demonstrates

Creation and use of complex User Parameters

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex3-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex3-Complete.fmw
C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex3-Complete-Advanced.fmw

In a previous project (in the FME Basic Desktop training) you created a project to transform parks data by calculating the size and
average size of each park.
The team who are using this now want to implement it on FME Server. At the same time, they want to improve some of the
functionality and implement a custom translation log.
As you created the original workspace, you are assigned to carry out these upgrades to your former work.
Set the output to write to a folder for that user
Ask whether to filter out dog parks
Ask which attribute to use to create labels
Create a translation log in CSV format

1) Start Workbench
Start Workbench and open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\Parameters-Ex3-Begin.fmw

You can see that the workspace reads some MapInfo parks data, filters out dog parks, calculates park area and average area,
creates labels, and writes out the data back to MapInfo.

2019.1 UPDATE
Notice - if you are using FME2019.1 - that there are three transformers that could be updated. For
practice, why not examine what changes have been made to these transformers and decide if it is worth
upgrading them? Do the changes relate to functionality or performance, and will they help in our
workspace?

There are two existing published parameters - one for the source dataset and one for the destination:
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The source dataset will never change, and we are going to create a new parameter for the destination, so delete these two
parameters.

2) Add User Parameter
If we are going to write the output to a folder specific to the current user, we need to know who that user is.
So, next create a text format user parameter to ask for the user's name:

Ensure that the optional checkbox is unchecked; we want users to have to enter a value in here. Also, make sure Attribute
Assignment is Off because we don't want them to be able to select an attribute.

3) Add User Parameter
There are various ways we can implement the requirements here; we'll do the version that involves sharing user parameters.
So, create a new user parameter of type Folder (Output). Uncheck both of the Published and Optional fields, i.e. it will be a
private parameter for us to use (not the end user), and it will be required.
Set the Name field to something like OutputFolder, and for the Value, browse to C:\FMEData2019\Output\Training.
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Set Attribute Assignment to Off, although it doesn't really matter because this will be a private parameter anyway.

FME Lizard says...
Technically, we could use a text-type parameter. The only benefit of a folder parameter is it lets us browse
to the location. But since it's a private parameter that the user will never see, it doesn't really matter.
Anyway, both methods will meet our requirements.

4) Set Output Location
Now let's use the two parameters we've created.
NB: First ensure you deleted the two existing source/destination user parameters in step 1, else this step won't work!
Locate the FME parameter for Destination MapInfo Folder in the Navigator window and double-click it to open the editing
dialog.
In that dialog manually enter:
$(OutputFolder)\$(Username)

Alternatively, use the text editor where you can add these by double-clicking, to reduce the chance of error.
You've basically concatenated/embedded the two user parameters into the FME parameter.
When you run the workspace, you will be prompted to enter your name, and then the output data will now be written to
C:\FMEData2019\Output\Training\<Username>

FME Lizard says...
There are various ways we could have done this. We could have set the OutputFolder parameter to
C:\FMEData2019\Output\Training\$(Username) and then linked it to the FME Destination MapInfo
parameter. You'll see in a moment why we didn't do that!

5) Add User Parameter
The next task is to check whether dog parks are required in the output. The Tester transformer in the workspace shows that an
attribute (DogParks) has a value of Y or N to denote its status. We need to ask the user and add their decision to the Tester.
Now create a new user parameter. It will be a Choice type parameter that is not optional:
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Set it up to be a simple Yes/No question of whether to include dog parks in the output. Turn off Attribute Assignment because again - we don't want the user to be able to select an attribute.

6) Update Tester
To use the DogParks parameter open up the Tester parameters dialog. Add a second test clause:
$(DogParks) = Yes

Ensure the logic column is set to OR. Now when the workspace runs, if you choose not to keep dog parks they will be filtered out
from the workspace. This concept - of directing features depending on the value of a user parameter - is a very useful one to be
aware of.

7) Add User Parameter
The next task is to allow the user to pick which attribute to use for a label.
As noted in the previous section of training, if we just publish the label parameter in the LabelPointReplacer the user will be able
to enter text as well as select an attribute. We want them to have to select an attribute and not to be able to enter text.
So, create a new user parameter of type Attribute Name. This one can be optional, as the user failing to select an attribute is
equivalent to saying "no labels required":
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FME Lizard says...
Click the run button and see what appears in the list of prompts; you should see a parameter to Select the
Label Attribute. But look! The parameter shows "No Attributes Available". Why is this?
This is because the list of available attributes depends on where the parameter is used. Since we have not
used the parameter yet, no attributes are available!
Similarly, if we used the parameter in a location where we have attributes A and B, and also in a different
location with attributes B and C, the only attribute available to the parameter is B. That's because a
parameter of this type will only show attributes that exist in all places that it is used.

8) Update LabelPointReplacer
To use the LabelAttribute parameter, inspect the LabelPointReplacer parameters.
Remember (again from the previous section) that we can't just apply this user parameter to the Label FME parameter. That would
just return the name of the attribute; we want the attribute value.
So in the Label parameter manually enter (or open the text editor and enter):
@Value($(LabelAttribute))

Now when the workspace runs you are also prompted to select an attribute with which to label the parks. If you choose no
attribute, no labels are created (just point features).

9) Add Log Writer
The final task is to create a CSV format translation log. That is not too difficult to do.
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Use Writer > Add Writer to add a new CSV format writer with the following setup:
Writer Format

CSV (Comma Separated Value)

Writer Dataset

C:\FMEData2019\Output\Training

Writer Parameters

Overwrite Existing File: No
Write Field Names Row: If Writing First Row

Add Feature Type(s)

CSV File Definition: Manual...

When you click OK, the dialog will open for you to define the table schema.
On the General tab set the CSV File Name as TranslationLog:

In the User Attributes tab, define the attributes User and Date:

Click OK to close the dialog.

10) Connect Feature Type
We need a single record to trigger this feature type; but only one feature, else we will get multiple records.
Place a Creator transformer down and connect it to the TranslationLog feature type:
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11) Set Output Folder
We should set the output location for the log to be relative to where the user files are being written.
So, locate the destination dataset parameter for the CSV writer, right-click on it and choose Link to User Parameter:

When prompted select the OutputFolder (private) parameter that we created earlier.

FME Lizard says...
You might be wondering what the point of that last part was. Why did we link the parameter when both
were pointing to the same folder already?
The point is that now the MapInfo and CSV writers share a parameter defining their output folder. If we
wish to change where they are being written to (say when the path changes from FMEData2019 to
FMEData2020), we only need to edit the private parameter to fix both writers. That's why we did what we
did in step #4.
If you don't believe me, try it and find out for yourself!

12) Set User Attribute
The very last step here is to provide values for the User and Date fields of the translation log (CSV writer).
Right-click on the attribute called User on the feature type and choose the option to Edit Value:
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In the dialog that pops up enter $(Username) for the value (you'll be prompted to select it as soon as you start to type):

This is another example of sharing user parameters. This parameter is now used here and in the MapInfo writer name.

13) Set Date Attribute
Now - to provide a value to the Date attribute - repeat the above step for the Date field, but this time entering the DateTimeNow()
function instead of a user parameter:

We are done! Save the workspace and then run it!
You should find your choice of data (with or without labels) written to a folder under your name, and a record of the translation
added to the CSV file in the main folder.

Advanced Exercise
If you have time for one more task, why not add a transformer to round the ParkArea and
AverageParkArea attributes and create a user parameter to control how that rounding occurs? You can
choose any type of parameter you think would be best for allowing the user to select the number of
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decimal places to round to. It could be a Choice parameter, a Choice with Alias parameter, a Number
parameter, or something else.
You could also expand on the information that is written to the CSV log file; for example add the build of
FME used in the translation, which is available as a parameter called $(FME_BUILD_NUM).

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a user parameter that is not optional
Create a private user parameter
Create a Folder type user parameter
Control Attribute Assignment for a user parameter
Embed/Concatenate user parameters inside an FME parameter
Create a choice type user parameter
Use a user parameter in a Tester transformer to redirect features
Create and use an Attribute Name user parameter
Share a user parameter by using it in multiple locations
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Module Review
This chapter looked at user parameters and some of the more advanced techniques involved in their use.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
FME is used by both workspace authors and end-users. In general, authors make use of FME parameters; end-users make
use of user parameters.
User parameters accept user input that can be used within a workspace
User parameters can be linked to FME parameters as an indirect form of control
Many types of user parameters exist to allow the user to enter different types of information in a controlled way
Parameters can be shared to reuse their content in multiple places
Parameters can be embedded or scripted to construct complex values from a simple input
Parameters can be made to accept fixed values, attribute values, or both

FME Skills
The ability to use FME parameters and to create user parameters
The ability to extract information from user parameters and/or link user parameters to FME parameters
The ability to use complex parameter types such as Choice with Alias, or Attribute Name.
The ability to use shared, embedded, and private parameters
The ability to accept fixed values only, or attribute values only

Further Reading
For further reading why not browse articles relating to Published Parameters on our blog?
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Custom Transformers
Custom Transformers are very powerful tools at either a basic or an advanced level.

What is a Custom Transformer?
A custom transformer is a sequence of standard transformers condensed into a single transformer. Any existing sequence of
transformers can be turned into a custom transformer.

Custom transformers can be shared by users. For example, this MeasureInterpolator custom transformer is shared via the FME
Hub.

Custom Transformer Purposes
Among other functions, custom transformers help to:
Reuse Content
A sequence of transformers encapsulated in a single object can be reused throughout a workspace and shared with
colleagues.
Employ Advanced Functionality
Using a Custom Transformer enables additional functionality to be used, such as looping and parallel processing
Tidy Workspaces
By condensing chunks of content, the workspace canvas becomes less cluttered

FME Lizard says…
Welcome to this chapter on Custom Transformers. As you'll see, Custom Transformers are excellent tools
for carrying out Best Practices in FME, both speeding up your projects and reducing clutter in the
Workbench canvas.
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Creating a Custom Transformer
A Custom Transformer can be created from scratch – i.e. you start with an empty custom transformer and add content into it – or
can be created from an existing sequence of transformers.
Custom transformers are created by either selecting Create Custom Transformer from the canvas context (right-click) menu or by
selecting Transformers > Create Custom Transformer from the menubar. The shortcut key for this function is Ctrl+T.

If a number of existing transformers are selected when you issue the Create Custom Transformer command, then they are
automatically added to the new custom transformer; otherwise, the new custom transformer is created empty except for an input
and output port.
Here a user is creating a new custom transformer based on a series of existing ones:

The new custom transformer will be pre-populated with these three transformers.
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Naming a Custom Transformer
All Custom Transformers require a name and (optionally) a category and description. A dialog in which to define these
automatically appears when you create a new custom transformer.
The category can be set to match any existing category of FME transformers or a custom category of your own.
Notice also the “Use Extended Description” parameter. This allows you to enter extra information about the custom transformer,
such as requirements for use, development history, and legal terms and conditions; in fields that support the use of either rich text
or Markdown.

These fields are particularly important when you intend to share the custom transformer with work colleagues or clients.

The New Custom Transformer
A newly created custom transformer then looks like this:

Notice that it appears under a new tab on the Workbench canvas and consists of the original transformers with additional input and
output objects.
When you click on the Main tab, to return to the main canvas view, the original transformers have now been replaced by a custom
transformer object that is automatically connected to the existing workspace:
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This custom transformer looks and behaves in the same way as any standard FME transformer; with input and output ports (that
match the input/output objects in the custom transformer tab), plus a parameters dialog.

Editing a Custom Transformer
To edit the contents of a custom transformer, simply click on the tab for that transformer. This opens the transformer definition
and you may edit the content in the same way that you would in the main canvas.
In the Navigator window, where a workspace would have a section labeled Workspace Parameters, a custom transformer has
Transformer Parameters:

This is where the information – name, category, description, etc. – that was entered earlier can be edited.

FME Lizard says…
If a custom transformer has been created from scratch, without any original transformers selected, it
would start out empty and look like this:

Then you can start building or editing the transformer from scratch. There is not a lot of difference
between creating content in the main canvas and turning it into a custom transformer, and creating an
empty custom transformer and creating the content in there.
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Using Custom Transformers
Once a custom transformer is created, it is placed into the main canvas and - apart from a different color - looks just like a normal
FME transformer would.
However, the resemblance to a normal transformer is not just in appearance. In the same way that multiple instances of a
transformer can be used in a workspace, a custom transformer can be used any number of times too. This makes Custom
Transformers not just a way to tidy a workspace, but also as a way of re-using content.
To place extra copies of a custom transformer you use - again like a normal transformer - the Transformer Gallery (look under a
section labeled “Embedded Transformers):

...or you can use Quick Add:

FME Lizard says…
The transformer name, category, and description all appear in the Quick Add tool - as well as appearing
in the help window - so it is definitely worthwhile setting these parameters.

Editing a Re-used Custom Transformer
Multiple instances of a custom transformer all use the same core definition; i.e. there may be multiple instances on the Main
canvas, but only a single definition exists for all of them
A key benefit of this approach is that every instance is updated or edited when the custom transformer definition is changed.
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For example, if a parameter is changed for the Aggregator inside this custom transformer:

...then the parameter automatically changes for ALL instances of the transformer that have been placed.
Editing is simpler because changes only need to be made once, no matter how many times that custom transformer has been used.
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Exercise 1

Creating a Custom Transformer

Data

Neighborhoods (Google KML)

Overall Goal

Create a custom transformer out of a workspace

Demonstrates

Basic custom transformer creation

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex1-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex1-Complete.fmw

A colleague - new to FME - has created a workspace that calculates the population density for neighborhoods in the city of
Vancouver, and comments that this technique could be reused for other projects.
You mention custom transformers as a way of doing this and will now demonstrate to her how to turn this workspace into a
general solution that calculates the average density of items in a known space.

1) Start Workbench
Start by opening your colleague's workspace: C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex1Begin.fmw
You may wish to run the workspace and examine the output to see what it does and how it works. Basically, it calculates the
population density (persons per square kilometer) for the years 2001 and 2011:

2) Create Custom Transformer
The key components for the custom transformer are the AreaCalculator and ExpressionEvaluator transformers. If you examine the
workspace you’ll see two ExpressionEvaluators (one for the year 2001, one for 2011) but we don’t need to include both in the
custom transformer.
So select the AreaCalculator transformer and ExpressionEvaluator_2001 (the first ExpressionEvaluator), right-click on them, and
choose the context menu option Create Custom Transformer (or just press Ctrl+T).
In the Create Custom Transformer dialog enter a name, category, and description for the new custom transformer. A good name
for the transformer will be the DensityEvaluator.

FME Lizard says…
You can’t call it the DensityCalculator; FME already has one of those!

Be sure the Attribute References parameter is set to “Handle with Published Parameters” (more on that later) and click OK:
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The custom transformer will now be created.

3) Inspect Custom Transformer
Flip back and forth between the DensityEvaluator tab and the Main tab to see how the custom transformer is constructed, and how
it is placed in the workspace itself:

Back in the Main tab, inspect the parameters for the custom transformer.
The main parameter is one created automatically by FME to accept the attribute to be processed. You'll see it is automatically
preset to the TotalPopulation2001 attribute:

4) Run Workspace
Save the workspace and then run the workspace, to ensure the output has not changed. However, note that this is just the start of
this custom transformer, and we should tidy it up (make it more generic) before trying to reuse it in other scenarios.
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CONGRATULATIONS
By completing this exercise you have learned how to:
Create custom transformers from a sequence of existing transformers
Handle attribute references automatically in a custom transformer

266

Input and Output Ports

Custom Transformer Input/Output Ports
Again, like a normal FME transformer, a custom transformer has a number of input and output ports:

These input and output ports are defined by input/output objects in the custom transformer definition itself:

Renaming Ports
The first thing to know is that these input/output objects can be renamed, in order that the transformer ports get named
appropriately. You can either double-click the object, choose Rename from the context menu, or press F2, in order to rename the
object.
For example, here the user pressed F2 and renames the input port from StringConcatenator_Input to simply Input:

Renaming the input and output ports is useful for making the custom transformer intentions more explicit; for instance, helping
the user to understand what data type is required as input.
For example, after editing the transformer might look like this:

FME Lizard says...
Here the user simply renamed the input port to Input. Renaming it to "Strings", "Lines", or "Raster" (for
example) would help guide other users of the transformer as to what data is required.
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However, they did rename the output port to illustrate the type of data that will emerge.

Adding or Removing Ports
Besides renaming ports, it is also possible to add new ports to a custom transformer.
To do so simply select Transformer Input (or Output) from either the menubar or the canvas context (right-click) menu:

For example, here a user has ports to handle two streams of input data and two streams of output (one port for the required output,
another that handles rejected features:

This means that each instance of the custom transformer has two input and two output ports:

268

Input and Output Ports

FME Lizard asks...
Q) Which of these is NOT a reason to use Custom Transformers?
To make my content available in Quick Add
To use advanced functionality like looping
To reuse chunks of content in a simple way
To tidy and declutter the main workspace canvas
A) Making content available in Quick Add is not a good reason to use a Custom Transformer. Admittedly
your content does become available in Quick Add, but that's not a specific reason to create a custom
transformer. The reason you want it in Quick Add is so that you can reuse the content.

Q) Consider this section of workspace:

If I select the three transformers highlighted with arrows, and create a custom transformer, how many
input and output ports will it have by default?
One Input and One Output port
One Input and Two Output ports
Two Input and Two Output ports
Two Input and Three Output ports
A) It will have two input and two output ports, proving that FME will automatically create multiple ports
where required. There are two inputs because there are two connections entering the set of transformers,
and two outputs because there are two connections exiting the set of transformers (although there are
three output ports on the StatisticsCalculator, only two are connected)
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Exercise 2

Editing a Custom Transformer

Data

Neighborhoods (Google KML)

Overall Goal

Make use of a custom transformer created out of a workspace

Demonstrates

Basic custom transformer re-use and editing

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex2-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex2-Complete.fmw

A colleague - new to FME - has created a workspace that calculates the population density for neighborhoods in the city of
Vancouver, and comments that this technique could be reused for other projects.
We've turned her workspace into a custom transformer as a way of doing this and now need to show how to use it multiple times
and apply edits to its definition.

1) Start Workbench
Continue with the workspace from exercise 1, or open the workspace:
C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex2-Begin.fmw

2) Duplicate Custom Transformer
Notice that we started with two ExpressionEvaluators and now have one ExpressionEvaluator and one custom transformer. Let's
place another instance of the custom transformer in place of the ExpressionEvaluator.
Click on the ExpressionEvaluator_2011 and press the delete key to delete it.
Click on the DensityEvaluator custom transformer and press Ctrl+D (or right-click > duplicate) to create a duplicate copy of it.
This is the same effect as placing a new instance, but quicker. You could do the same task through Quick Add or the Transformer
Gallery if you desired.
Connect the second DensityEvaluator into the workflow, in parallel and not in series:

3) Set Custom Transformer Parameters
By creating a second instance of the custom transformer we've started to re-use our content, which is great. However, the second
instance is currently processing the wrong data.
Inspect the parameters for the second DensityEvaluator and set the population parameter to TotalPopulation2011 (not 2001):
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4) Run Workspace
Run the workspace and inspect the output to ensure the data is being processed correctly.
One obvious problem with the output from the transformer is that the result is put into an attribute called PopulationDensity2001,
regardless of what data is being processed.
This is not useful; for example, the 2011 results also get the same name, as would any other scenario where we used this
transformer. We should improve this by making the output name more generic.

5) Edit Custom Transformer
Click on the tab labeled DensityEvaluator to switch the canvas to the custom transformer definition. Inspect the
ExpressionEvaluator_2001 parameters. Change the Transformer name to ExpressionEvaluator since we are processing more than
just 2001 data. Then change the name of the New Attribute parameter to DensityResult:

If you run the workspace again (run it from at least the custom transformer onwards) you’ll notice that DensityResult is the
attribute output by both instances of the custom transformer; i.e. one edit has fixed both of them!

6) Rename Ports
One other edit we ought to make is to the port names of the custom transformer. At the moment they are not very elegant.
Back within the DensityEvaluator tab, click the cogwheel icon of the input port object (currently labeled AreaCalculator_Input).
Inspect its parameters and change the name to Input.
Now repeat the process for the output port object, renaming it to Output:
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Click the Main tab to check back on the main canvas and confirm the changes have been made:

You'll need to manually resize the transformers to fit their new naming style, as in the above image.

CONGRATULATIONS
By completing this exercise you have learned how to:
Use multiple instances of a custom transformer
Make a custom transformer generic for use anywhere
Rename input and output ports in a custom transformer
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Custom Transformers and Parameter Input
FME transformers all have parameters whose value can be supplied by attributes or by user input. The same is still true of
transformers inside a custom transformer definition. However, because a custom transformer can be reused in multiple places, it's
important for these inputs to be flexible.

Parameter Input by Attributes
Many transformer parameters can be set up to accept values from attributes.
Take this custom transformer that creates custom map labels:

Inside that custom transformer is a LabelPointReplacer transformer. It uses AddressID as the value for the label:

As created, the custom transformer works fine. However, consider if that transformer is used elsewhere, where AddressID does
not exist:

This transformer is flagged as "incomplete". It is used in a scenario where AddressID is not available.
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Parameter Input by User Parameters
Besides attributes, most FME parameters can be set up to accept values from User Parameters.
In a similar setup to above, here a custom transformer contains a LabelPointReplacer transformer whose label value is selected by
user input:

Here the issue is not where the custom transformer is used, but its duplication. If each instance of the custom transformer uses the
same user parameter, then they will all get the same input.
We need a mechanism for the user to enter different values per transformer instance.

FME Lizard says...
As an analogy, consider a mobile device such as a cell phone. On my phone I can change the default
language from English to (for example) Swedish. The manufacturer implemented this because they have
no way to tell where the phone might be used, or by who, or what language might be used for input.
In much the same way, an FME custom transformer could be used outside of its expected area. The author
must, therefore, implement the transformer to be adaptable to different inputs. This can be done either
automatically or manually...
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Automatic Parameter Handling
Let's look at how we can handle the complications that might arise if a custom transformer is reused.

Automatic Handling of User Parameters
To take the handling of user parameters first, when a transformer with a published parameter is incorporated into a custom
transformer, the published parameter is automatically moved from the Navigator window of the main canvas to the Navigator
window of the custom transformer:

This means that the user is no longer prompted for these when the workspace is run! But... those parameters instead become
available on the Custom Transformer itself:

That way the parameters can be set differently for each instance of the custom transformer. If user input is required at run-time,
then these new parameters can be published themselves - and shared if you want them all to have the same value.

Automatic Handling of User Attributes
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Now let's look at how attributes are handled. When a custom transformer is created, one of the parameters in the Create Custom
Transformer dialog is labeled Attribute References:

"Handle with Published Parameters" is the automatic way of handling attribute references in the custom transformer. It makes sure
that every attribute referenced within the custom transformer is supported outside of the transformer definition.
It does that by creating a new user parameter for each attribute:

The transformer inside the Custom Transformer still references the attribute name, but FME maps the user parameter to that
attribute.
When the custom transformer is used in a place without the required attribute, it is still flagged as "incomplete". However, the user
parameter allows the workspace author to select an attribute that is available:

So (in the above) AddressID is not available, but the author can select a different attribute instead.
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This illustrates how FME has automatically solved the attribute reference problem using user parameters. To make the custom
transformer more generic, the workspace author can change the prompts on these parameters; for example, change the prompt
from "AddressID" to "Select an ID Attribute to Process".

FME Lizard asks...
Q) What do you think would happen if you changed the parameter from "Handle with Published
Parameters" to its other possible value, "Fix Manually (Advanced)"? Pick as many of these answers as
you think are correct:
The workspace won't run by default because no attributes are available in the custom transformer
There will be no way to pick attributes to use from the main canvas
The author will need to manually fix the custom transformer by exposing attributes in its definition
The custom transformer won't work on a different schema unless the exposed attributes are also published
A) Yes, when the parameter is set to manual, it really means manual! All four of these are true, meaning
you'll have your work cut out if you don't let FME take care of attribute references for you.
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Post-Creation Parameter Handling
As we know, custom transformers can be edited after creation.
The "Handle with Published Parameters" setting handles attributes used in a custom transformer only when it is created. There
also needs to be a mechanism for handling future edits to a custom transformer (or where the custom transformer is simply created
from scratch).

Handling Incoming Attributes
Attributes entering a custom transformer are handled using a setting inside the transformer definition.
As an example, an author puts a StringConcatenator inside a newly created custom transformer. The author wishes to concatenate
AddressID and PostalCode.

AddressID is available in the custom transformer because it was being used when the custom transformer was created (and Handle
With Published Parameters was set).
However, PostalCode is not available. It was not being used when the custom transformer was created.
Therefore the author must expose that attribute. They do so by inspecting the parameters for the Input port, where they are able to
specify other incoming attributes to expose:
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Now PostalCode becomes available to the StringConcatenator and, additionally, made into a user parameter so that back on the
main canvas the custom transformer can accept a different attribute selection should PostalCode not be available.

Handling Outgoing Attributes
Besides incoming attributes, there is also the question of what attributes should emerge from the output of a custom transformer.
Best Practice suggests that we shouldn't output more attributes than are expected by the user. We should hide or remove any
attributes that are part of a calculation, or any attributes that are otherwise generated inside the custom transformer but aren’t
necessary to the output.
Here a custom transformer is calculating the average area of a number of polygon features. It has renamed ports and a specific
output port to deal with bad features, but it is outputting more attributes than are useful:

The workspace author should clean up this output. They can do this by visiting the custom transformer definition, viewing the
output port object, and there choosing which attributes are to be output:
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The Attributes to Output setting gives the option of outputting all attributes, or only those that have a checkmark next to them, as
above.
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Exercise 3

Custom Transformers and Published Parameters

Data

Neighborhoods (Google KML)

Overall Goal

Edit a custom transformer to use published parameters

Demonstrates

Published parameters and custom transformers

Start
Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-Complete.fmw
C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-CompleteAdvanced.fmw

A colleague - with our help - has created a custom transformer that calculates density for a particular area. However, we need to
work on it further to make it more generic - and to expand its capabilities.
This transformer was created using the automatic schema handling parameter and the workspace will already be handling schema
properly. So, to an extent we don't have to worry - but there are improvements we can make.

1) Start Workbench
Continue with the workspace from exercise 2, or open the workspace:
C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-Begin.fmw
Notice that, currently there are two instances of the custom transformer. Both produce an attribute with the same name
(DensityResult). It would be helpful if the user of the custom transformer could define what the name of that attribute should be.
Let's set up the transformer to allow that.

FME Lizard says...
This is why - so far - we've had the two transformers in parallel streams. If we had them in series in the
same stream then the results of the second custom transformer would overwrite the results of the first.

Click on the tab labeled DensityEvaluator to switch the canvas to the custom transformer definition. Inspect the parameters for the
ExpressionEvaluator. Next, to New Attribute (DensityResult) click the down-arrow and choose User Parameter > Create User
Parameter:

When prompted, click OK to accept the default settings. Return to the main tab and check the parameters for each
DensityEvaluator instance. There should be the option to set the name of the attribute to output:
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You can now move the instances so they are joined in sequence (rather than parallel) and change the two output attribute names
from DensityResult to something more specific for this scenario (PopulationDensity2001 and PopulationDensity2011):

FME Lizard says…
At first glance it might appear that we've simply reverted the custom transformer right back to where we
started from. To an extent, that's true. However, the point is that we've now got a solution that can work in
other scenarios (i.e. where something other than population density is being calculated).

2) Set Parameter Prompts
Looking at the custom transformer parameters we can also see that the prompt for the attribute to analyze is called
"TotalPopulation2001". Obviously, this is not very generic.
Return to the DensityEvaluator tab and browse the Navigator window to find the related published parameter. Right-click on the
parameter and choose Edit Definition.
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In the dialog that opens set the parameter Name to DensityAttribute and the Prompt to Attribute to Analyze. Reset the Default
Value to be an empty field:

Click OK to close the dialog. Return to the Main tab and check the custom transformer parameters to prove the label change
worked. Notice, however, that there is now no attribute selected. So select the correct attributes:

...and then run the workspace to show that the output is still correct.

FME Lizard says…
It's because we chose to handle schema automatically that we can simply change this user parameter
name and not worry about where it is used. FME will handle the name change wherever is necessary.
But you might be wondering why we set the Default Value to empty, causing each instance of the
transformer to need its parameters set once more. That's because each transformer would have been
changed anyway; if we left the default as TotalPopulation2001, then both transformers would have been
reset to that. At least by emptying the default, we have a visual cue that the parameters need to be reset.
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3) Implement Units Selection
At the moment this workspace is calculating the number of items (in this exercise, persons) per square kilometer of land. This
works for the original scenario, however, other uses of this transformer might find different units to be more useful.
Therefore we’ll implement a parameter for users to be able to select their units of choice.
In the DensityEvaluator tab, browse the Navigator window and right-click on the entry labeled User Parameters. Select the Create
User Parameter option.
In the Add/Edit User Parameter dialog, set the following parameters:
Type

Choice with Alias

Name

DensityUnits

Prompt

Density Units:

Uncheck the checkbox parameter labeled Optional because the user has to select a value.

Now click the [...] button to the right of the Configuration parameter. This opens a dialog in which to define choices for the user to
select from. Make two entries into this dialog
Display Name

Value

Sq Meters

1

Sq Kilometers

0.000001

To save you counting, that's five zeros after the decimal place:
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Click OK to close that dialog.
Back in the Add/Edit User Parameter dialog set:
Attribute Assignment

Off

Default Value

Sq Kilometers

Then click OK to close this dialog and add the published parameter.

FME Lizard says…
Feel free to add any other units that you want. The units for this coordinate system are in metres, which is
why that has a value of 1. So other units would need to be a fraction of that; for example, square miles
would be 0.0000003861.

4) Implement Parameter
Now we’ve defined a published parameter that the user can set the units with, but we still have to apply it in the custom
transformer.
Staying in the DensityEvaluator tab, inspect the parameters for the AreaCalculator transformer. For the Multiplier field, click the
drop-down arrow and select the newly defined user parameter, DensityUnits:

Back in the main canvas the custom transformer now has a parameter for the end user to select the output density units:
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Experiment by running the workspace using different units, to prove that the changes were implemented properly. Notice that,
because Attribute Assignment was set to "Off" that the end-user isn't able to select an attribute.

Advanced Exercise
Although it’s not needed for this population density calculation, another useful function for this
transformer would be the ability to apply a weighting to the density calculations. If you have time, carry
out the following steps to set it up.
The weighting will come from an incoming attribute, which means we need to be able to handle this in the
custom transformer’s schema.

5) Add RandomNumberGenerator
Our source data doesn't have any fields we could reasonably use for weighting the output. Therefore return to the Main canvas tab
and add a RandomNumberGenerator transformer in order to generate a test attribute:

Inspect the parameters dialog for the RandomNumberGenerator and, for the purposes of this exercise, set:
Minimum Value

0.1

Maximum Value

1

Decimal Places

1

Result Attribute

WeightedAttribute
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6) Expose Attribute in Custom Transformer
Now we have an attribute we need to expose it in the custom transformer, in order to use it.
Return to the DensityEvaluator tab where the transformer is defined. Inspect the parameters for the Input port object. Put a
checkmark against the WeightingAttribute attribute:

This will cause the attribute to be exposed in the custom transformer definition.
It will also cause a user parameter to be created. Locate the parameter in the Navigator window (it should be called
WEIGHTEDATTRIBUTE) right-click on it and choose Edit Definition.
Put a checkmark in the Optional field, as this should not be compulsory (the user might not have an attribute to weight the results
by):

7) Duplicate ExpressionEvaluator
Now we can use the attribute inside the custom transformer.
Make a duplicate copy of the existing ExpressionEvaluator and connect it in parallel to the current one. Then put a Tester in
beforehand where the Passed port goes to one ExpressionEvaluator and the Failed port goes to the other:
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8) Set up Tester
Inspect the Tester parameters and make a test for where WeightedAttribute > 0

9) Adjust Equation
Now that the attribute is exposed in the custom transformer, we can use it in the equation for calculating density. Inspect the
parameters for the ExpressionEvaluator transformer connected to the Tester:Passed port.
Change the equation to:
@Value(TotalPopulation2001)/(@Value(NeighborhoodArea)*@Value(WeightedAttribute))

To clarify, multiply the existing NeighborhoodArea attribute by the WeightedAttribute and place parentheses around that part of
the expression.
Save the parameter changes and run the workspace to check the result. Remember – the results will be different every time
because we’re generating the weighted attribute randomly at runtime!
Experiment selecting the weighted attribute in the main canvas, and not selecting it. When no attribute is selected then the features
should pass through the Failed port and no weighting is used in the calculation:

FME Lizard says…
It may seem odd – especially to experienced users – that we would use the attribute in the expression, and
not the published parameter. But this is all part of how FME handles this behavior automatically. It avoids
the author needing to know about published parameters and how to use them, and uses hidden
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functionality to replace the attribute with the published parameter wherever necessary.

CONGRATULATIONS
By completing this exercise you have learned how to:
Publish an FME parameter inside a custom transformer
Create a new user parameter inside a custom transformer
Expose attributes inside a custom transformer
Use an exposed attribute inside a custom transformer
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Custom Transformer Types
There are two types of custom transformers.
An embedded transformer is one whose definition is stored in the workspace itself. Each instance of the custom transformer
refers to that embedded definition. Only the workspace in which the definition is embedded has access to that custom transformer.
A linked transformer is one whose definition is stored outside of the workspace, in its own file. Each instance of the custom
transformer is linked to that definition. Any workspace can have access to that custom transformer.
On a workspace canvas, embedded transformers are identified by their green color, while linked transformers are colored cyan:

Linked vs. Embedded Transformers
Both types of transformers can be used in an FME workspace, and there are various advantages and disadvantages to each type.
Embedded Transformers
Embedded transformers are easier to manage, need no external files, and their definition is embedded into the workspace. They
are particularly useful for tidying a workspace but also work for employing advanced functionality like parallel processing.
However, sharing and re-use of content are not as simple with an embedded transformer. The custom transformer cannot easily be
shared with other users, unless they are given a copy of the same workspace, and it is not easy to maintain a consistent definition
among several users.
Linked Transformers
Linked transformers are perhaps a little harder to manage. They exist as a file (.fmx) outside of the workspace, which is less
convenient, and when used to employ advanced functionality such as loops they can be more complex.
However, a linked custom transformer is a little easier to edit (you open the .fmx file rather than the .fmw file) and is much easier
to share among users. Not only can the file be given to any FME author to use, but any number of authors can actually point their
FME to the same custom transformer file.
Sharing the same file is useful because any changes made to the definition are automatically propagated to all workspaces that use
it.

FME Lizard says…
Like embedded transformers, linked transformers also show up in the transformer gallery and Quick Add
dialog. Also notice that they have a special icon to signify that you are about to use a linked version,
rather than the embedded:
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Creating a Linked Custom Transformer
All custom transformers start out with an embedded definition. To create an external definition, the custom transformer is
exported using the Export as Custom Transformer option on the menubar:

At this point a dialog opens in which you can confirm the transformer name and category, plus some other parameters including
the save location:

Name and category are fairly obvious, so let's look at some of the other different options...

Insert Mode
We know that the definition of a custom transformer can be stored either in a workspace (embedded) or in a separate file (linked).
Therefore each instance of a custom transformer points to either an embedded or linked definition.
But it's important to know that each instance can change their definition source. For example, an instance of a custom transformer
linked to a file definition, can be switched to embedded (in which case the external definition gets embedded into the workspace).
Likewise, an instance that points to an embedded definition, can be switched to point to an external file.
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When I am the author of a custom transformer I might want to control the initial state when an instance is placed for the first time.
This is what the Insert Mode parameter does.
There are four different modes:

Let's say I export my custom transformer with Insert Mode set to one of the Embedded choices. The definition is now stored
inside an fmx file and FME will recognize it as an available transformer. But when a user places a new instance to their workspace
(say with Quick Add or the Transformer Gallery), the definition of the custom transformer is copied from the fmx file and
embedded into the workspace.
If I choose Embedded By Default, it means that although each instance of the transformer starts as Embedded, the user can switch
the instance to "Linked" at any point.
If I choose Embedded Always it means that each instance of the transformer starts as embedded, and must stay that way. It cannot
be switched to Linked at a later point.
Similarly, I could export my custom transformer in Linked mode. When a user places a new instance the definition of the
transformer remains in my fmx file, with the instance linked to it.
If I choose Linked By Default, each instance of the transformer starts as Linked, but can be switched to Embedded at any time.
If I choose Linked Always, each instance starts as Linked, and stays that way. To cannot be switched to Embedded at a later point.

FME Lizard says…
Insert Mode is an important parameter when I am the author of a custom transformer, who has created it
for other workspace authors to use. It gives me control over how they will use that transformer.

Which Mode to Use
Embedded Always is a good choice when the person using the transformer is less experienced with FME; it's easier for them to
manage and if they make changes they won't affect other people. Embedded is also a good choice where the custom transformer is
intended for use by individuals (i.e. not sharing it as a group).
Linked Always is a good choice when the custom transformer is intended to be shared among a group of users. Because it is
linked, the users will always receive updates if the transformer definition is changed, and because the definition is shared, it
becomes a standard that is applied to all users.
Only when the end-user is experienced in FME and can understand the consequences, is it advisable to use a “By Default” setting
and allow type switching.

Password
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The password field allows you to password-protect the custom transformer. This makes it impervious to edits from unauthorized
persons. Additionally, the file contents are (very mildly) encrypted so that they cannot be copied by opening the source file in a
text editor.
This allows authors to make transformers available for purchase without any fear that their work will be copied or edited. Of
course, it’s important not to forget or lose the password yourself, in case you wish to make edits!

Save Location
FME has a specific installation folder in which custom transformer files can be saved. If a custom transformer is saved in this
folder, then it becomes available in Workbench and can be used the same as any other transformer. If it is saved elsewhere then
FME won't be able to find it unless that path is set under Tools > FME Options > Default Paths.

Editing a Linked Custom Transformer
When you click the OK button on the Export as Custom Transformer dialog, the transformer is exported to a separate (.fmx) file.
That file is immediately opened inside a new instance of FME Workbench, for you to make edits.
In essence editing a custom transformer works the same way as editing a workspace: you open the file in FME Workbench and
make edits as required.
The important part to remember is that each instance of the Custom Transformer that is linked to this file, will be affected by any
changes that you make.

FME Lizard says…
It’s best to hunt for bugs in a custom transformer when its definition is embedded, before exporting it.
That's because tools such as Feature Caching and Run with Breakpoints do not work inside exported
transformers.

FME Lizard asks...
Q) Here is a question for you to investigate: Can you nest custom transformers? That is, can you put one
custom transformer inside another?
Yes, with no restrictions
Yes, but you can only nest transformers of the same type (Linked or Embedded)
Yes, but you cannot nest Linked Custom Transformers
Yes, but only a single level of nesting
A) You can embed any type of custom transformer inside any other type of custom transformer, to multiple
levels of nesting.
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Switching Custom Transformer Types
When the Insert Mode of a custom transformer allows type switching, the action is very straightforward. Simply right-click on the
instance and choose the required type:

In the above screenshot, the user is switching from Embedded to Linked. Of course, switching to Linked requires the custom
transformer to be exported already. If not, there is no option to link the transformer because there is no file to link to!
When you switch from embedded to linked, then the embedded definition is closed. The transformer instance then points to the
linked definition.
When you switch from linked to embedded, the contents of the fmx file are copied and embedded in the workspace. The
transformer instance then points to the embedded definition.
If there is more than one instance of the Custom Transformer, you are asked whether you want to switch all of them:

The usual answer to this is yes because having the same transformer both embedded and linked could be quite confusing! If you
answer no, then be aware that the transformer you clicked on will be linked (but none of the other instances will).

FME Lizard says…
Switching from Embedded to Linked only works as long as the two versions are the same.
In other words, if you embed a linked transformer and then make changes to the embedded definition, you
won’t be able to revert to the linked version.
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Custom Transformer Versioning
FME allows external file definitions of a custom transformer to exist as a number of versions. Each time a custom transformer
definition is edited, a new version can be saved.
In that way, a single fmx file can contain multiple versions of the same custom transformer.
Versioning allows the author of a custom transformer to revert to a previous definition, should the need arise. It also allows a
separate definition to be created for each version of FME. The custom transformer remains backwards-compatible with older FME
versions, but takes advantage of enhanced functionality in newer versions.

Creating a Versioned Custom Transformer
After editing an unversioned custom transformer, clicking the save button issues the following prompt:

The two versioning options are to Overwrite the existing version or to create a New Version.
Essentially, the prompt asks whether to activate versioning. Clicking New Version versions the transformer and saves the edits as
version 2. Note that creating a new version does not create a separate fmx file; instead, it creates a separate version of the
transformer within the same fmx file.
The title bar in Workbench illustrates the version number of a custom transformer file:

If you choose Overwrite in the Save Transformer dialog, then the transformer remains unversioned.

Editing a Specific Transformer Version
Opening a versioned custom transformer in Workbench issues the following prompt:
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This prompt asks which version you wish to edit, or whether you want to just start with a new version. This way you can:
Create a new version to make edits to
Continue making edits to the existing version
Make edits on an older version (particularly useful when that version is tied to a particular FME release)
It's important to be aware that this dialog is the only way to create a new version. Clicking the save button merely saves updates to
the currently open version. To forcibly create a new version you need to close and reopen the file, causing the Select Transformer
Version dialog to appear.

Transformer and FME Versions
Each version of a custom transformer is associated with a particular FME version. You can choose to make edits to a transformer
that was last edited in an older version of FME, but you will receive a warning message:

Here version 1 was created with FME 2018, and the author is attempting to edit it in FME 2019. Should they go ahead and do so,
version 1 of the transformer will no longer be valid for use in FME 2018.

FME Lizard says…
Sometimes you can get confused about these dialogs (well, I can) so let me set you straight:
When a custom transformer is first exported, you don't get the Select Version dialog (because the
transformer is still unversioned) and you don't get the Save Version dialog (because why create a new
version when this transformer was just exported?)
When you open the definition (fmx file) the next time, you again don't get the Select Version dialog
(because it is still unversioned), but you will get the Save Version dialog when you save the changes,
allowing you to make the transformer versioned.
From that point on, you'll always get the Select Version dialog when you open the fmx file (because the
transformer is now versioned) but for the same reason, you'll never get the Save Version dialog when you
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save edits.

Updating a Transformer Version
If the option to display the transformer version is turned on (Tools > FME Options > Transformers > Display transformer version)
then each linked custom transformer displays its version number in summary annotation:

When FME detects that a new version is available (i.e., the author has made edits and saved them as a new version) and that this
version is compatible with the FME version being used, then an option appears on the context menu to allow an update:

Choosing to upgrade means the transformer becomes linked to the latest version, and the summary annotation updated to reflect
this.

FME Lizard says…
FME checks for new versions only when Workbench is first started. If Workbench is already open and you
wish to check for a new custom transformer version, you can force FME to check by clicking the refresh
button on the Transformer Gallery window:
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FME Lizard asks...
Q) You have a workspace with a linked custom transformer (version 1). The author of that transformer
makes a series of edits and updates it to version 4. What do you think the upgrade option does to the
custom transformer in your workspace?
Upgrade it to version 2
Upgrade it to version 3
Upgrade it to version 4
It depends on what version of FME you and the author are using
A) It will upgrade the custom transformer to the latest version that is compatible with the FME version
you are using. If you are using the same version of FME, then it would upgrade the custom transformer to
version 4. But if you are using different versions of FME then it could be version 2 or 3 instead (or maybe
there would be no available updates at all!)
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Exercise 4

Custom Transformer Modes

Data

Bicycle Routes (Esri Shapefile)

Overall Goal

Create a custom transformer to calculate the average length of a number of linear features

Demonstrates

Custom Transformer Modes

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex4-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex4-Complete.fmw
C:\FMEData2019\Workspaces\DesktopAdvanced\AverageLengthCalculator.fmx

You arrive early at the office for a meeting, but it is canceled at the last minute. Typical! Still, it gives you time to carry out an
FME project that has been on your mind: a transformer to calculate the average length of linear features.

1) Open Workspace
Open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex4-Begin.fmw
You’ll see that the workspace is reading a set of bicycle path data, and then doing some minor processing to get it into a
reasonable state for use in the custom transformer.
You may want to run the workspace to examine the output and see what data we are dealing with, but remember the custom
transformer we will create is to be designed to work on any linear data.

2) Add LengthCalculator
The contents of the transformer will be fairly straightforward and we’ll start out with just two transformers. So, simply add a
LengthCalculator and a StatisticsCalculator transformer to the workspace.

3) Create Custom Transformer
Select the two newly placed transformers and turn them into a Custom Transformer called AverageLengthCalculator. Make sure
the attribute references are handled automatically, although at the moment there aren’t any references to handle.
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4) Edit Custom Transformer
Now we have a new custom transformer, let’s tidy it up and make it functional.
Firstly rename the input port object to Lines (thus identifying what geometry is expected), then add an output port object (if you
don’t have one already) and rename it to Output. It should be connected to the StatisticsCalculator:Complete port:

Inspect the StatisticsCalculator parameters. Set Attributes to Analyze to _length. Rename the Mean Attribute result to
AverageLength
Finally, inspect the parameters for the Output port object. Change Attributes to Output to ‘Specified Attributes Only’ and ensure
that AverageLength is output, but _length and any other StatisticsCalculator attributes are not:
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5) Run Workspace
Run the workspace and inspect the output (for Visual Preview you must return to the Main tab to do this) to ensure everything is
working as expected.

6) Export Custom Transformer
Now let's experiment with different transformer modes.
Return to the AverageLengthCalculator tab and select File > Export as Custom Transformer from the menubar. In the Export as
Custom Transformer dialog make sure the Insert Mode option is set to Linked by Default. Make sure the Save Location is the
default for storing custom transformers (<user>\FME\Transformers):

Click OK to close the dialog. The custom transformer is saved (as AverageLengthCalculator.fmx) and this file opened up in a new
instance of FME Workbench.

7) Examine Workspace
Go back to the instance of FME Workbench where the original workspace is open. The custom transformer is now a cyan color to
denote that it is now a linked transformer (it's linked because we chose "Linked By Default"):
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Notice that you can right-click and choose to embed the transformer, and then switch back to the linked version. In a real-life
scenario, the choice of mode usually depends on whether you are planning to share the transformer.
In embed mode, right-click the transformer and choose Edit. You’ll find that you can no longer change back to Linked mode
because the two definitions are now considered different!
Delete the embedded transformer. You’ll be prompted whether you wish to delete the definition too. Click Yes.

FME Lizard says…
It’s important to realize that the definition of an embedded custom transformer can remain in the
workspace, even if it’s not used. If you clicked "No" above, that's what would have happened. You’ll be
able to tell if such a definition remains by looking in the Embedded Transformers section of the
transformer gallery.
You'd usually click No (and keep the definition) if you wanted to make use of it later. You'd usually click
Yes (and remove the definition) if you decide that the custom transformer is no longer required.

8) Examine Custom Transformer
Select Tools > FME Options on the menubar. Click the Workbench section and locate the Transformer Options. Turn on the option
to Display Transformer Version:

Using the Quick Add menu or the Transformer Gallery, place a new instance of the AverageLengthCalculator custom transformer
in the workspace (it will be linked by default, which is fine). If you hover the mouse cursor over the transformer the pop-up text
will show that it is version 1.
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Return to the instance of Workbench where the fmx file is open. Move one of the objects about to activate the save button. Then
save the file. Notice that you aren’t prompted to save a new version. That’s because versioning has not been applied yet. There is
only one version of the transformer to make edits to.
So, leaving Workbench open, close the fmx file. Next visit the start tab and select the fmx file from the Recent Files list, in order
to reopen it. Now the transformer definition is in a new editing session, and we will be prompted to apply versioning when we
save the transformer.

9) Update Custom Transformer
Rather than just jiggling objects about to prove a point, let’s make a real update to this transformer. One thing we could do is filter
data by geometry, so we aren’t trying to measure the length of a point feature, or similar.
So, add a GeometryFilter transformer, in front of the LengthCalculator. Inspect the parameters and select Line and Arc as the
geometries to filter by:

Adjust the feature mapping so that the Line and Arc ports are directed into the LengthCalculator. Add a second output port object
by right-clicking on the canvas and selecting Insert Transformer Output. Call the newly placed port <Rejected> and connect the
<Unfiltered> data to it, like so:

Now click the save button to save the custom transformer. You’ll be prompted whether you want to create a new version. Click the
button labeled New Version to do so:
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You can tell a new version is created by the information at the very top of the Workbench window.

TIP
If you when you saved you weren't prompted with the Save Transformer dialog box, this is because you
forgot to close the first edit session. Undo your changes back to how the original custom transformer was
(without the GeometryFilter and Rejected output port) and save again. This time close the .fmx file and reopen it. Now when you make your changes you will be prompted to create a new version.

10) Update Workspace
Go back to the instance of FME Workbench where the original workspace is open. Click the refresh button on the Transformer
Gallery in order for FME to scan all custom transformers and discover the new version we’ve just created:

Now right-click on the AverageLengthCalculator custom transformer and there should be an option to upgrade to the latest
version. Choose this option:

The transformer will be refreshed and updated, which you can tell by the presence of a Rejected port.
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FME Lizard says…
Now you have this custom transformer you have various options to share it.
- You can put the transformer into a shared folder and then have other users use Tools > FME Options >
Default Paths to link their FME to that shared folder.
- You can send (email) the fmx file to other users and have them install it in their FME. They can install it
either by double-clicking the file or saving it to their default FME resource folder.
- You can publish the transformer to FME Server for you (and others) to use there.

CONGRATULATIONS
By completing this exercise you have learned how to:
Export a custom transformer
Switch the mode of a custom transformer instance
Delete an embedded custom transformer
Edit and create a new version of a linked custom transformer
Update a linked custom transformer instance to the latest version
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Parallel Processing
Parallel Processing is a way to improve performance on high-end machines, by running multiple actions at once as a set of
separate processes. A system architecture of multiple processors with multiple cores is useful because each process can be
assigned to a different core. With multiple processes running on multiple cores, the whole translation can run several times
quicker than it used to.

Parallel Processing and FME
Parallel processing in FME covers not an entire workspace, but just a specific subsection of workspace. This is defined using a
custom transformer, which is a natural method to subdivide a large translation.
Parallel processing is achieved by forming groups of features on the basis of attribute values, in a similar way to a Group-Based
transformer. Each group is assigned to a separate process.

FME Lizard says…
To process multiple workspaces in parallel, you would use multiple engines on FME Server.

Activating Parallel Processing
Each custom transformer has a set of parameters - located in the Navigator window - that relates explicitly to parallel processing.
Here you can determine the level of parallel processing, and an attribute that defines groups of data that will be transformed as a
separate process:

Parallel Processing Levels
The parameter that controls parallel processing allows different levels of effort to be applied. Each level specifies the number of
processes to run simultaneously, in relation to the number of cores available:
Examples
Parameter

Processes
2 Cores

4 Cores

8 Cores
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No parallelism

1 Process

1 Process

1 Process

1 Process

Minimal

Cores / 2

1 Process

2 Processes

4 Process

Moderate

Cores x 1

2 Processes

4 Processes

8 Process

Aggressive

Cores x 1.5

3 Processes

6 Processes

12 Process

Extreme

Cores x 2

4 Processes

8 Processes

16 Process

As in the above example, on a quad-core machine, minimal parallelism results in two simultaneous FME processes. Extreme
parallelism would result in eight (assuming there are eight tasks that can be processed simultaneously).
There is also a hard cap for each FME license level:
Examples
FME Edition

Process Cap
2 Cores

4 Cores

8 Cores

Base Edition

4 processes

Maximum 4 processes

Max 4 processes

Max 4 processes

Professional Edition

8 processes

Maximum 4 processes

Max 8 processes

Max 8 processes

All Other Editions

16 processes

Maximum 4 processes

Max 8 processes

Max 16 processes

So, if you have a Base Edition license, you are never going to get more than four processes at one time, regardless of machine
type and the parallelism parameter. The quad-core machine in the above example can never have more than eight processes since
that is the maximum that "extreme" parallel processing allows.

FME Lizard says…
These numbers - we should note - are the maximum number of processes at any one time. It's possible to
divide data into many more groups and process them separately, but they won't all occur simultaneously.
For example, given a quad-core machine, moderate processing, and 20 groups of features; there will be a
total of 20 processes, but only four will run at any one time. When one of the four finishes, a new one is
started.

Parallel Processing Groups
The Parallel Process By parameter requires the author to select an attribute, and - as already covered - selecting attributes for a
custom transformer parameter requires some consideration.
In particular, this parameter is designed so that you cannot simply pick an attribute to use:

Instead, this parameter (and one for Group By Mode) is published to make it available as one of the custom transformer
parameters:
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FME Lizard says…
Parallel Processing is most effective in two specific scenarios. The first scenario is a small number of
groups, each with a large amount of processing to do. Parallel processing is less effective where there are
a large number of small groups. Having said that, the second scenario is a large number of small tasks
being offloaded elsewhere. For example, when features are being passed to a web service HTTPFetcher
transformer, then it's most efficient to have FME fire off as many requests as it can, as quickly as possible.

Parallel Processing and Custom Transformer Design
The keys to parallel processing are designing a custom transformer to be a standalone subsection, and the definition of groups to
be processed.
In essence, features are split into groups on reaching the custom transformer, processed as a separate action, then combined back
into a single group on exiting the custom transformer.
It's important to be aware that because each group is processed independently, there can be no relationship between features in
different groups. If features are related, and their results depend on each other, then they must be in the same group.
The easiest way to think of this is that the Custom Transformer itself is a Group-Based transformer. Because it is a wrapper for all
the individual FME transformers in the definition, it allows those transformers to operate in groups, even if they are FeatureBased.

Creating Artificial Groups
Sometimes none of the incoming data is related to each other, and can be split into arbitrary groups for processing. In these cases,
where there is no identifier to define groups, one can be created manually by generating attributes with the ModuloCounter or
RandomNumberGenerator transformers.
For example, here the workspace author has a large number of address features from which to create labels. To speed the process
they activate parallel processing:
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They could group by PostalCode, but choose not to because all addresses fall inside only one of two postal codes. Therefore they
create an artificial group using the ModuloCounter. Note the Group By parameter in the custom transformer is set to the
_modulo_count attribute.
In such a scenario, it's best to create only one group per intended FME process. For example, on a quad-core (four core) computer,
with an FME Professional license and Extreme parallel processing, a maximum of eight processes at a time are permitted.
Therefore - as shown here - the optimum number of groups to use is also eight.

FME Lizard says…
See this blog article for more information about - and some special techniques for - generating parallel
processing groups. It's particularly useful for a custom transformer with multiple input ports.
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Exercise 5

Custom Transformers and Parallel Processing

Data

Building Polygons (OpenStreetMap)
Address Points (Geodatabase)
Zoning Polygons (MapInfo TAB)

Overall Goal

Create a custom transformer to parallel process data

Demonstrates

Custom Transformers and Parallel Processing

Start Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex5-Begin.fmw

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex5-Complete.fmw

The city is investigating the incorporation of OpenStreetMap data into their own spatial datasets and open data portals. The first
dataset under consideration is buildings. A workspace has been generated to validate the OpenStreetMap data and compare it to
other, existing city datasets.
You see this workspace and wonder if parallel processing might make it more efficient. Let's check that out...

1) Open Workspace
Open the workspace C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex5-Begin.fmw.
As you’ll see, this workspace reads OpenStreetMap building data and then carries out a number of validation tasks. Firstly, it
overlays it with the city address database, to confirm whether it has a matching address. Secondly, it tests the building geometry
with a GeometryValidator transformer. Finally, it overlays the buildings against the city zoning data, to see if it properly falls
inside a single zone:

Turn on Feature Caching and run the workspace. Inspect the data at each step to become familiar with what it is doing.
Specifically take note of the feature counts, so that we can be sure that any changes we make do not affect the results:

Although the workspace does not take long to run, consider how it might be set up as a custom transformer with parallel
processing.
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2) Create Custom Transformer
The first thing to consider is how data might be managed as separate groups for parallel processing. Because OSM is
crowdsourced data, there's no guarantee that any particular attribute will have values. In fact, if you check the source OSM data,
you'll notice that it has very few values for any attribute.
However, one of the early steps in the workspace copies address records onto each building. Because the address data is a city
dataset, we can take that as the definitive data and trust its contents. One of the attributes that it copies is POSTALCODE:

Postcodes - or at least the first three characters of a postcode - are a good way to divide data into groups.
So, select all of the objects after the PointOnAreaOverlayer (where POSTALCODE is obtained) but before the final writer feature
type. Notice this includes the feature type for the MapInfo TAB reader:
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Press Ctrl+T to turn the selected objects into a custom transformer. Give the transformer a name like BuildingValidator and
ensure that Attribute References are Handle(d) with Published Parameters.
Click OK to create the custom transformer.

2) Define Parallel Processing Group
Inspect the custom transformer to see if its contents are what you are expecting. Interestingly the reader feature type does not
appear in the definition, but is piped in through a separate input port:

This shows that readers are not permitted inside a custom transformer. We'll leave it for now, but it might be important to reconsider this later, when we start parallel processing.
Speaking of which, we need an attribute to group data by. Postcode (for example V3E1J4) is too precise. It would be a building by
building level of precision. However, the first three characters (V3E) would be much more suitable.
So, back in the main workspace canvas, place a SubstringExtractor transformer between the PointOnAreaOverlayer and the newly
created BuildingValidator. Use it to extract the first three characters of the POSTALCODE attribute into a new attribute:

Notice that characters are counted from zero, so we need characters from 0 (zero) to 2 (two). Also note that the author is writing
the result to an attribute called PostcodePrefix.

3) Turn on Parallel Processing
Return to the custom transformer definition (the BuildingValidator tab). Look in the Navigator window for the Parallel Processing
parameter. Double-click it and set the level of processing to Moderate:
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Now return to the main canvas window. Open the parameters for the BuildingValidator custom transformer. For the Group By
parameter select the attribute PostcodePrefix:

If you don't have a PostcodePrefix attribute, then it will be the attribute created by the SubstringExtractor (_substring is the
default).

4) Run Workspace
Now it's time to run the workspace. However, before you do, turn off Feature Caching. Also turn off Stop at Breakpoints if it is
somehow set.

WARNING
Absolutely do NOT run this with either Feature Caching or Stop at Breakpoints turned on. If you do,
parallel processing won't work!

The log window will now show several processes being started and stopped. You can open the task or process manager for your
system to look for multiple FME processes running (note that some processes related to FME Server may exist, if you have it
installed and active).
Once complete, check the results. You won't have feature counts in the custom transformer because it is running in parallel
processing mode. You can instead inspect the output dataset. Check if the number of features with a _ValidationZones attribute set
to "Unzoned Building" matches the number of features (it might be easier to look for this sort of thing in the full Data Inspector,
rather than Visual Preview).
Here the author is using the Filter tool to test for unzoned buildings:
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It appears there are quite a lot of unzoned buildings (4,712). This is a lot more than when the workspace was originally run (250)
so what is going on? Can you guess?
OK, the problem is related to the MapInfo TAB reader, which is reading the zoning data. We are parallel processing in groups of
postal codes, but the zoning data does not have the same postcode prefix attribute. So one solution is to assign a postcode to each
zone feature.
However, another solution is to ensure that each parallel process gets its own set of zoning data. We can do that by replacing the
MapInfo reader with a FeatureReader transformer, and moving it inside the custom transformer.

5) Fix Reader
Firstly, in the main tab, delete the Zones feature type. This will cause FME to prompt you to remove the MapInfo reader, which
you should agree to.
Now switch to the BuildingValidator definition tab. Add a Creator transformer and a FeatureReader transformer, and connect them
together. Open the FeatureReader parameters and set it up to read the MapInfo TAB dataset Zones.tab:

Now connect the Zones output from the FeatureReader, into the SpatialRelator:Supplier port (in place of the
SpatialRelator_Support Input object, which can now be deleted):
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Now re-run the workspace and check the output. This time only 250 features should have a value of Unzoned building for the
_ValidationZones attribute; and 219 features should have a value of Overlapping zones building.
The workspace is now producing the correct results and in a set of parallel processes. But was it worth making these changes?

6) Assess Parallel Processing
Since the initial workspace ran in a fairly quick time anyway, the need for parallel processing was already low. The choice of the
first three characters of the postcode gave us 17 groups. That's not unreasonable, but it does mean FME had to start 17 different
processes, which takes time.
We also chose Moderate processing, giving only one process per core. Perhaps our machines can handle more?
Plus, because the FeatureReader appears inside the transformer definition, we are reading the zoning data in every separate
process. Is that overhead too great? If not, could/should we do the same with the Geodatabase reader?
So, if you have time, re-run the workspace with a different processing level, say Aggressive. Does it run any quicker than the
Moderate processing level? If not, why might that be? Does adjusting the number of tiles make it better or worse?
Also try using just the first two characters of a postal code for our group (simply change the SubstringExtractor to fetch only
characters 0-1). That produces fewer groups (only 4), but is it faster?
In summary, we've seen that parallel processing can require some careful thought and consideration when setting up. However, the
rewards can be very great.

CONGRATULATIONS
By completing this exercise you have learned how to:
Assess a workspace's potential for parallel processing
Select an attribute (or substring) suitable for grouping data by
Create and use parallel processing in a custom transformer
Read data inside a parallel process
Confirm with the task manager that FME is launching worker processes
Experiment with different settings to produce a more efficient result
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Custom Transformers and Loops
A loop is a programming structure that allows an action to be implemented repeatedly. In most cases, a loop is linked to a
condition; i.e., the action continues until a certain condition is met.

FME Lizard says…
As a broad example, an aircraft coming in to land often gets into a loop. It has to circle the airport again
and again (the action) until it has clearance to land (the condition). Users who have flown into a busy
airport will understand what I mean!
An aircraft circles the airport as a delaying action. However, rarely in computing do we wish to slow processing. Instead, each
iteration carries out a different action, or produces a slightly different result. Often each loop provides a closer and closer
approximation of a solution, halting when it is within a set tolerance.

Loops and FME
In FME, loops are a way to repeat a section of transformers multiple times, without having to duplicate that section. For technical
reasons, loops are only permitted inside a custom transformer.
As you know, FME processes one feature at a time. Therefore, when you create a loop, each feature is being sent around the loop
individually.
So, to be worthwhile, each iteration of the loop must do something different. Often each iteration processes a different component
of a feature (for example, reads records from a list) or repeats the same process using the results of the previous loop.

FME Lizard says…
It's stating the obvious I know, but you use a loop to repeat only actions that need repeating. One-off
actions should take place outside of a loop. For example, here is an aircraft landing sequence:

The "wheels down" part comes outside the circling loop because we don't want to raise/lower the wheels
every time we circle the airport. That would be very inefficient.

Setting up a Custom Transformer Loop
A loop in a custom transformer requires various components. The required components are:
The start point of the loop
The end point of the loop
Other components relate to the conditions for ending the loop. At least one of these is required:
An absolute condition by which to test for the end of processing ("Circle the airport until I tell you")
The number of times to carry out the loop ("Circle the airport five times, then land")
A running count of the number of iterations ("I've circled the airport three times and have two more times to go")
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Loop Start Points
The start of the loop is identified by an Input port object. Although it can be the same input port as used for features to enter by,
this does not have to be the case. For example, here there is an input port for features to arrive into, and another one for the start of
the loop:

This allows the loop point to be other than the beginning of the custom transformer.
By default, this second input port also appears on the transformer itself, like this:

If you don't require this, then you simply have to 'unpublish' it in the input port's parameters:

Loop End Points
The end of a loop is identified by a Loop object. You can insert one by selecting it from the canvas context menu in a custom
transformer:
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When a loop object is placed you are asked which Input object it is to be looped to:

And then the loop is complete:

Of course, this example is an infinite loop. The action is repeated, but there is no condition being tested to stop it. FME won't let
an infinite loop run forever - it will recognize the problem and stop it - but we should set up something to force an ending.

Loop Conditions
There are two general types of condition for which we can test. Firstly we can loop a set number of times. Secondly, we can loop
until a specific condition is met.
Here is a custom transformer that loops a set number of times:
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Notice that we have an attribute that is a counter for the number of times we have looped (LoopCounter), and an attribute that tells
us the maximum number of loops to carry out (MaxLoops).
In each loop, the counter attribute is incremented by 1. When LoopCounter < MaxLoops, then we loop back and process the data
again. When LoopCounter = MaxLoops, then we exit the transformer.
Instead of a simple count of iterations, another method is to test a specific measure of data quality. For example, here an ellipse
representing a park is adjusted (resized smaller and smaller) until it's size is less than a certain quantity:

FME Lizard says…
For an excellent, real-world example of looping in an FME workspace, check out this customer story.
In that example, the user uses a loop to place trees (the action) until a specific density is reached (the
condition). Notice that the loop is not tied to a specific counter - it continues until the data quality
required is met.

Loops and Transformer Types
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As you should already know, transformers that operate on one feature at a time are called Feature-Based, and transformers that
operate on multiple features at a time are called Group-Based.
We can also call a loop "Feature-Based" because it only processes one feature at a time. Unfortunately, that means that using a
group-based transformer inside a (feature-based) custom transformer loop is not a simple task.
If you attempt to create a loop inside an embedded custom transformer, when it includes a group-based FME transformer, then
you receive an error message. Group-based transformers are only permitted inside a loop in a linked custom transformer. There
are technical reasons for this that we won't go into right now.
This is the error message you get:

So, inside a linked custom transformer definition, you'll see a particular parameter (in the Navigator window) called Enable
Blocked Looping:

When set to Yes then other parameters allow you to set the number of iterations, and to set an attribute that will hold that value.
Parallel processing is turned off (the parameters are removed) for custom transformers that are being looped, and the Insert Mode
is automatically changed to "Linked Only".

FME Lizard asks...
Q) Which of these statements about loops are true?
Loops are only permitted inside a custom transformer
A loop without a condition will continue processing until manually stopped
Test conditions are built into the loop end point parameters
Nested loops (a loop within a loop) are permitted
A) Yes, loops only work in a custom transformer. An endless loop will not continue forever (FME will stop
it after a time). Conditions need to be checked with transformers (like the Tester). And Nested Loops are
permitted; there are usually two count attributes (one for each loop). The first (inner) loop counter is reset
to zero every time the second (outer) loop counter is incremented.
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Exercise 6

Looping in a Custom Transformer

Data

Tree List

Overall Goal

Examine a custom transformer that breaks a list into pieces

Demonstrates

Custom Transformers and Loops

Start Workspace

None

End Workspace

C:\FMEData2019\Workspaces\DesktopAdvanced\CustomTransformers-Ex6-Complete.fmw

In this exercise, we'll examine a custom transformer that includes a loop inside it, to see how it works.

1) Open and Run Workspace
Start FME Workbench and open the workspace CustomTransformers-Ex6-Complete.fmw.

The workspace generates a set of test data and then processes it with a custom transformer called the ListBreaker. Run the
workspace, being sure to use Run > Rerun Entire Workspace from either the menubar or toolbar.
Inspect the output of the test data bookmark, and the ListBreaker transformer. Notice that the test data starts out with a list of tree
types and species:

After processing, the list has been broken down into a set of attributes instead:

So now we know what the custom transformer does, let's see how it works...
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2) Examine Custom Transformer
Click on the ListBreaker tab (or right-click on the ListBreaker transformer and choose the option to Edit). The custom transformer
definition looks like this:

We know the input of the transformer is a list. The transformer processes each element of that list, one at a time, looping around to
fetch the next element once the previous one is processed.
Given that, there are various components that we can associate with different parts of a loop:
1. The input port where the feature with list attribute originally arrives.
2. The loop setup. Makes a count of the number of list elements (y) and creates a loop counter (x) attribute.
3. Carries out the actual processing. The ListIndexer fetches the xth element in the list.
4. The actual loop part. Increments the loop counter and checks if it is now the same as the number of elements (x=y).
5. The end loop component that returns to the start-of-loop component.
6. The start-of-loop component. Notice it is not published so it won't appear on the custom transformer on the canvas.
7. This section is an error trap, to catch features with an empty list.
Notice the feature counts for each connection. Notice how The transformer counts beyond the actual number of features by
counting each pass for each loop. Here a single feature enters the transformer, and is twice passed back through the loop:

If three identical features entered the transformer, then the counts would be increased accordingly:
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3) Inspect ListIndex Transformer
Inspect the feature caches for the custom transformer. If, for example, you inspect the ListIndexer caches, notice how it's a little
different to a standard cache. That's because we are inspecting the same feature within different loops (the loop counter attribute
will show this):

Inspect the parameters of the ListIndexer transformer:
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Notice how it is using the loop count attribute both for the list element to fetch and for the name of the attribute into which it is
fetched. This is one of the unique capabilities of a looping transformer that make it so special.

4) Experiment with Input
If time permits, experiment with the input to the transformer. You can do this by editing the contents of the Generate Test Data
bookmark:

To increase the number of features, edit the Number to Create parameter of the Creator transformer (note the Aggregator is set up
to Group-By the Creator ID number in order to keep the features separate).
To adjust the list contents, change the values in the AttributeCreator transformers. To create more list elements, add extra
AttributeCreator transformers (this is not necessarily the best way to handle data, but it is fine for this limited test scenario).

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a loop and initialize a loop counter
Increment a loop counter
Set up and test a loop condition
Create a loop object in a custom transformer
Analyze the feature counts inside a loop
Use a loop counter attribute as a value in transformers inside the loop
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Module Review
This chapter investigated Custom Transformers and how they can be used to improve your FME workspaces
What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
A custom transformer is a sequence of standard FME transformers, condensed into a single unit.
A custom transformer lets you tidy your workspace, re-use sequences of transformers, and apply advanced functionality.
Handling parameters in a custom transformer is very important, and can be done either automatically or manually.
Custom transformer instances point to a definition that is either embedded or linked.
Custom transformers are used to implement parallel processing.
Custom transformers are used to implement loops.
FME Skills
The ability to create, edit and reuse a custom transformer.
The ability to handle parameters in a custom transformer.
The ability to export a custom transformer definition.
The ability to switch types from embedded to linked (or vice versa).
The ability to use parallel processing.
The ability to use loops.

Further Reading
For further reading why not browse articles relating to Custom Transformers on our blog?
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Course Wrap-Up
Although your FME training is now at an end, there is a good supply of expert information available for future assistance.
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Product Information and Resources
Safe Software Web Site
The Safe Software web site is the official information source for all things FME. It includes information on FME products, Safe
Software services, FME solutions, FME support and Safe Software itself.

Safe Support Team
Behind FME are passionate, fun, and knowledgeable experts, ready to help you succeed, with a support team philosophy built on
the principle of knowledge transfer.
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Your Local Partner
Safe Software has partners and resellers around the world to provide expertise and services in your region and your language.
You can find a list of official partners on the Safe Software web site.

FME Manuals and Documentation
Use the Help function in FME Workbench to access help and other documentation for FME Desktop. Alternatively, look on our
website under the Support section.
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Free Trial
Safe Software offers a free 30-day trial of FME Desktop so you can learn at your own pace and develop new skills. Click on the
Download Free Trial button to get started.
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Community Information and Resources
Safe Software actively promotes users of FME to become part of the FME Community.

The FME Community
The FME Community is a one-stop shop for all community resources, plus tools for browsing documentation and downloads.

Knowledge Base
The FME Knowledge Base contains a wealth of information; including tips, tricks, examples, and FAQs. There are sections on
both FME Desktop and FME Server, with articles on topics from installation and licensing to the most advanced translation and
transformation tasks.

Forums
FME community members post FME-related messages, ask questions, and share in answering other users’ questions. Members
earn "reputation" and "badges," and there is a leaderboard of the top-participating users. Join the conversation to see how the
community helps each other with their FME projects!

Ideas Exchange
FME development is very much user-driven. The Ideas Exchange gives users the chance to post their ideas for new FME
functionality, or improvements to existing functionality, and allows everyone to vote on the proposed ideas. The more votes an
idea gets, the more likely it is to be implemented!

Safe Software Webinars
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Community Information and Resources

Learn new ideas for transforming your data via over a hundred upcoming and recorded webinars.

Safe Software Blog
The Safe Software blog provides technical information about FME, articles about customers' use cases, and general thoughts on
spatial data interoperability.
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Community Information and Resources

The FME Channel
This FME YouTube channel is for those demos that can only be properly appreciated through a screencast or movie. Besides
this, there are a host of explanatory and helpful movies, including recordings of most training and tutorials.
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Feedback and Certificates

Feedback and Certificates
The format of this training course undergoes regular changes prompted by comments and feedback from previous courses.

Course Feedback
FME Lizard says...
There's one final set of questions – and this time you'll be telling me if the answers are correct or not!

Safe Software values feedback from training course attendees, and our feedback form is your chance to tell us what you think
about how well we’re meeting your training goals.
You can fill in the feedback form now, but you'll also be reminded by email shortly after your course. Safe Software's partners
who carry out training may ask that you fill in a separate form, but you can also use the official Safe Software form if you wish.

Certificates
FME Lizard says...
In order to prove you have taken this training course, a certificate will be emailed automatically to anyone
who was logged on for the duration of Safe Software hosted courses.
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More Courses

Continue Your Education
Your FME education doesn't stop here! Sign up for another course or follow along with a recorded version. Check our website
often for new live online courses

FME Server Authoring
FME Server Authoring is a key course for FME users intending to author workspaces for use on FME Server. Through hands on
exercises, learn the advanced skills, knowledge and terminology that users need to know in order to produce workspaces
optimized for FME Server. The training will introduce basic concepts and terminology, help you become an efficient FME Server
user, and direct you to resources to help apply the product to your own needs. Requires basic experience with FME Desktop.

FME Server REST API
FME Server REST API is a brand new course that teaches FME users how to master the FME Server REST API and build their
own web applications to solve data challenges. This course will teach users what the REST API is, how to use it, and how to build
custom web applications that leverage the power of FME. Requires basic experience with FME Desktop and FME Server, HTML
and Javascript knowledge an asset but not required.

FME Server Administration
FME Server Administration involves managing important tasks like optimization, security, and installation. Learn what
administration options are available in FME Server and how to modify them to design the most effective deployment for your
needs. You'll learn how to monitor the health of FME Server and its components, plus how to troubleshoot problems. Requires
advanced FME Server experience.

339

Thank You

Thank You
Thank you for attending this FME training course.
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